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About This Document

IBM(R) WebSphere(R) Business Integration Adapter portfolio supplies integration
connectivity for leading e-business technologies and enterprise applications. This
document describes the installation, configuration, and business object
development for the adapter for web services.

Audience

This document is for IBM WebSphere customers, consultants, developers, and
anyone who is implementing the WebSphere Business Integration Adapter for SAP
Exchange Infrastructure (SI).

Prerequisites for This Document

A variety of prerequisites are cited throughout this book. Many of these consist of
references to Web sites that contain information about, or resources for, web
services. You should also be familiar with implementing the WebSphere business
integration system. A good place to start is the Technical Introduction to IBM
WebSphere InterChange Server, which contains cross-references to more detailed
documentation.

Related Documents

The complete set of documentation available with this product describes the
features and components common to all WebSphere adapter installations, and
includes reference material on specific components.

You can install related documentation from the following sites:
* For general adapter information:
— http://www.ibm.com/websphere/integration/wbiadapters/infocenter
* For using adapters with InterChange Server:
- http://www.ibm.com/websphere/integration/wicserver/infocenter
— http://www.ibm.com/websphere/integration/wbicollaborations/infocenter

These sites contain simple directions for downloading, installing, and viewing the
documentation.

Note: Important information about this product may be available in Technical
Support Technotes and Flashes issued after this document was published.
These can be found on the WebSphere Business Integration Support Web
site, http:/ /www.ibm.com/software/integration/websphere/support/.
Select the component area of interest and browse the Technotes and Flashes
sections. Additional information might also be available in IBM Redbooks at
http:/ /www.redbooks.ibm.com/.
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Typographic Conventions

vi

This document uses the following conventions :

courier font

bold
italic, italic
blue outline

{1
[]

/,\

%text% and $text

ProductDir

Indicates a literal value, such as a command name, filename,
information that you type, or information that the system
prints on the screen.

Indicates a new term the first time that it appears.

Indicates a variable name or a cross-reference.

A blue outline, which is visible only when you view the
manual online, indicates a cross-reference hyperlink. Click
inside the outline to jump to the object of the reference.

In a syntax line, curly braces surround a set of options from
which you must choose one and only one.

In a syntax line, square brackets surround an optional
parameter.

In a syntax line, ellipses indicate a repetition of the previous
parameter. For example, option[,...] means that you can
enter multiple, comma-separated options.

In a naming convention, angle brackets surround individual
elements of a name to distinguish them from each other, as
in <server_name><connector_name>tmp.1og.

In this document, backslashes (\) are used as the convention
for directory paths. For UNIX installations, substitute slashes
(/) for backslashes. All IBM product pathnames are relative
to the directory where the product is installed on your
system.

Text within percent (%) signs indicates the value of the
Windows text system variable or user variable. The
equivalent notation in a UNIX environment is $text,
indicating the value of the text UNIX environment variable.
Represents the directory where the IBM WebSphere Business
Integration Adapters product is installed. The
CROSSWORLDS environment variable contains the
ProductDir directory path, which is IBM\WebSphereAdapters
by default.

Indicates a choice from a menu such as: Choose File ”
Update ” SGML References
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New in this release

New in release 2.0.x

This release includes the following enchancements:

* The adapter no longer uses a JMS transport. Instead, the adapter uses an
HTTP(S) transport and a SOAP data handler.

* You use a WSDL transformer utility—BIA_XIWSDLUtil— to convert SAP XI
WSDL files prior to running an SAP XI Object Discovery Agent (ODA) to
generate business object definitions.

The adapter is no longer supported on Solaris 7.0 platforms.

© Copyright IBM Corp. 2003, 2004
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Chapter 1. Overview of the adapter
* [“Adapter for SAP XI environment”|

¢ |“Terminology” on page 3

+ [“Components of connector for SAP XI” on page 5|

* |“Architecture of connector for SAP XI” on page 8

* [“Install, configure, and design checklist” on page 9|

The connector is a runtime component of the WebSphere Business Integration
Adapter for SAP Exchange Infrastructure (XI). The connector allows businesses to
aggregate, publish, and consume SAP XI messages for use either within their
organization or by trading partners. The connector and other components
described in this document provide the functionality needed to exchange business
object information in the body of a message that can be conveyed via the HTTP
and HTTPS protocols.

This chapter describes the scope, components, design tools, and architecture used
to implement the WebSphere Business Integration Adapter for SAP XI. It also
provides an overview of tasks you must complete to install and configure the SAP
XI components described in this document. For information about installing and
configuring the components, see [“Install, configure, and design checklist” on page|

Note: The adapter for SAP XI implements the standard Adapter Framework APL
For this reason, the adapter can operate with any integration broker that the
Framework supports. However, the functionality provided by the adapter
has been designed specifically to support the IBM WebSphere InterChange
Server (ICS) integration broker.

Adapter for SAP Xl environment

Before installing, configuring, and using the adapter, you must understand its
environmental requirements:

e |“Broker compatibility”|
p y

* [“Software prerequisites” on page 2|

* |“Adapter platforms” on page 2|
« |“Standards and APIs” on page 2|
* [“Locale-dependent data” on page 2|

Broker compatibility

The adapter framework that an adapter uses must be compatible with the version
of the integration broker (or brokers) with which the adapter is communicating.
The 2.0 version of the adapter for SAP XI is supported on the following adapter
framework and integration broker:

* Adapter framework: WebSphere Business Integration Adapter Framework,
versions:

- 220
- 230
- 231
- 240

© Copyright IBM Corp. 2003, 2004 1



* WebSphere InterChange Server only, versions:
- 42
- 421
- 422

See the Release Notes for any exceptions.

Software prerequisites

Review the following assumptions and software requirements before you install
the connector for SAP XI:

* If you are using HTTPS/SSL, you need your own third-party software for
creating keystore and truststore.

* The connector is designed for use with the SAP Exchange Infrastructure 2.0 SR1
and with the SAPDB 7.3

* You must have the following third-party applications:
— Java WebStart 1.0
— Microsoft Internet Explorer 5.01, service pack 1 or higher

Adapter platforms
The adapter runs on the following platforms (operating systems):
* Microsoft Windows 2000
e Solaris 8 or AIX 5.1, 5.2 or HP-UX 11i

Standards and APIs

A variety of standards and technologies give access to their functionality over a
network.

The standards used by the adapter are as follows:
* HTTP 1.0

The APIs used by the adapter are as follows:
+ IBM JSSE 1.0.2

Depending on your configuration, you may need to install additional software. The
sections below discuss these contingencies.

SSL

If you plan to use SSL, you must use third-party software for managing your
keystores, certificates, and key generation. No tooling is provided to set up
keystores, certificates, or for key generation. You may choose to use keytool
(shipped with IBM JRE) to create self-signed certificates and to manage keystores.
For further information, see [“SSL” on page 59

Locale-dependent data

The connector has been globalized so that it can support double-byte character
sets. When the connector transfers data from a location that uses one character
code to a location that uses a different code set, it performs character conversion to
preserve the meaning of the data.

The Java runtime environment within the Java Virtual Machine (JVM) represents
data in the Unicode character code set. Unicode contains encodings for characters
in most known character code sets (both single-byte and multibyte). Most
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components in the WebSphere business integration system are written in Java.
Therefore, when data is transferred between most integration components, there is
no need for character conversion.

Note: The connector has not been internationalized. This means that the trace and
log messages are not translated.

SAP XI connector
This section discusses globalization and the connector.

Event notification: The connector uses pluggable protocol listeners for event
notification. The protocol listeners extract the message from the transport and
invoke the data handler specified in the message meta-data. For further
information on listener processing, see["HTTP and HTTPS protocol listener|
[processing” on page 48.

Request processing: The connector uses a pluggable HTTP-HTTPS protocol
handler framework for request processing. The protocol handlers invoke the data
handler. For further information, see ["HTTP-HTTPS protocol handler processing”|

Data handler
You configure the SAP XI adapter to use the SOAP data handler. For an overview
of data handler configuration, see [“Configuring the SOAP data handler” on page]

Terminology

The following terms are used in this Guide:

* ASI (Application-Specific Information) is code tailored to a particular
application or technology. ASI exists at both the attribute level and business
object level of a business object definition.

* ASBO (Application-Specific Business Object) A business object that can have
ASI.

¢ BIA_XIWSDL transformer utility A tool that converts an SAP XI-generated
WSDL document to one that is standards-compliant. You use this tool before
running the SAP XI ODA.

* BO (Business Object) A set of attributes that represent a business entity (such as
Customer) and an action on the data (such as a create or update operation).
Components of the IBM WebSphere system use business objects to exchange
information and trigger actions.

* Content-Type The HTTP protocol header that includes the type/subtype and
optional parameters. For example, in the Content-Type
value text/xml;charset=1S0-8859-1, text/xml is the type/subtype and
charset=I150-8859-1 is the optional Charset parameter.

* ContentType refers to the type/subtype portion of the Content-Type header value
only. For example, in the Content-Type valuetext/xml;charset=1S0-8859-1,
text/xml is referred to in this document as the ContentType.

* GBO (Generic Business Object) A business object with no ASI and not tied to
any application.

* MO_DataHandler_Default Data handler meta-object used by the connector
agent to determine which data handler to instantiate. This is specified in the
DataHandlerMetaObjectName configuration property of the connector.

Chapter 1. Overview of the adapter 3



* MO_DataHandler_DefaultSOAPConfig Child data handler meta-object
specifically for the SOAP data handler.

* Protocol Config MO During request processing, the HTTP-HTTPS protocol
handlers use a Protocol Config MO to determine the destination. If during event
processing you are exposing collaborations, the connector uses the Protocol
Config MO to convey message header information from the HTTP or HTTPS
protocol listener to the collaboration.

* SAP XI ODA (Object Discovery Agent) An automated tool for generating
business objects. For further information, see|“Starting the SAP XI ODA” on|

* SOAP Business Object A SOAP business object is a child of a TLO and can be a
SOAP Request, a SOAP Response or a SOAP Fault business object. SOAP
business objects contain information necessary for processing by the SOAP data
handler, including SOAP ConfigMOs, which are children of SOAP business
objects, and also contain SOAP header container business objects.

¢ SOAP Config MO (Configuration Meta Object) The data handler requires an
object that contains configuration information about a single transformation, for
example, from a SOAP message to a SOAP business object. This information is
stored as meta-data in the child of a SOAP business object. This child object is
the SOAP Config MO

* SOAP Header Child Business Object A business object that represents a single
header element in a SOAP message. The header element is an immediate child
of the SOAP-Env:Header element of the SOAP message. All attributes of a
header container business object must be of this type. These business objects
may have an actor and a mustUnderstand attribute. These attributes correspond
to the actor and mustUnderstand attributes of the SOAP header element.

* SOAP Header Container Business Object A business object that contains
information about the headers in a SOAP message. This business object contains
one or more child business objects. Each child business object represents a
header entry in the SOAP message. The SOAP data handler business object may
have an attribute, which is of type SOAP header container business object. This
attribute is also referred to as the SOAP header attribute. Such an attribute has
special application-specific information requirements as described in
[“SOAP data handler,” on page 73] This attribute must be an immediate child of
a SOAP business object.

* Top-Level Business Object A top-level business object contains a Request, a
Response (optional) and one or more Fault (optional) business objects. A TLO is
used by the connector for both event processing and request processing.

* UDDI (Universal Description, Discovery and Integration) is a specification that
defines a way to publish and discover information about web services. UDDI
specification provides for XML-based interfaces (APIs) that allow programmatic
access to the UDDI registry information. SOAP is the underlying RPC
mechanism for these APIs.

* WSDL (Web Services Description Language) is an XML vocabulary that defines
the software interfaces for web services. It organizes all of the web service
technical details required for automatic integration at the programming level,
and is used to publish IBM WebSphere collaborations as web services. WSDL is
to web services as IDL is to CORBA objects.

For more information on WSDL, go to:
[http:/ /www.w3.org /TR /wsdl|
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Components of connector for SAP XI

illustrates the connector for SAP X, including its protocol handler and
listener frameworks.

Connector for SAP Xl
Protocol handler Protocol listener

framework framework
HTTP-HTTPS HTTP HTTPS

protocol protocol protocol

handler listener listener

SOAP
data
handler

Figure 1. The connector for SAP XI

The following components interact to enable data exchanges across the Internet:

¢ SAP XI connector, including the SOAP data handler and protocol listeners and
handlers

* SAP Xl-enabled collaborations
* Business objects and HTTP(S) messages
* WebSphere Business Integration InterChange Server

Connector for SAP Xl

During request processing, the connector responds to collaboration service calls by
converting business objects to request messages and conveying them to specified
destinations. Optionally (for synchronous request processing) the connector
converts response messages to response business objects and returns these to the
collaboration.

During event processing, the connector processes request messages from clients by
converting them into request business objects and passing them on to
collaborations for processing. The connector optionally receives response business
objects from the collaboration, which are converted to response messages and then
returned to clients.

For further information, see [Chapter 4, “SAP XI connector,” on page 45|

Note: In this document, any mention of a connector is a reference to the SAP XI
connector, unless specified otherwise.

Chapter 1. Overview of the adapter 5



Protocol listeners and handlers
The connector includes the following protocol listeners and handler:

* HTTP protocol listener
e HTTPS protocol listener
e HTTP-HTTPS protocol handler

Protocol listeners detect events from SAP XI clients in HTTP, or HTTPS formats.
They notify the connector of events that require processing by a collaboration.
Protocol listeners then read the business-object-level and attribute-level ASI,
connector properties, and transformation rules embedded in protocol configuration
objects to determine the collaboration, data handler, processing mode
(synchronous/asynchronous) and transport-specific aspects of the transaction. For
a_detailed account of protocol listener processing, see [“Protocol listeners” on page|

Protocol handlers invoke SAP XI services in HTTP or HTTPS formats on behalf of
a collaboration. The HTTP(S) protocol handler reads TLO ASI and transformation
rules embedded in protocol configuration objects to determine how to process the
request (synchronously or asynchronously), which data handler to use to convert
messages to business objects and vice versa, and to determine the destination
(from the Destination attribute of the request business object Protocol Config MO).
For synchronous transactions, the protocol handler processes response messages,
converting them into response business objects and passing them back to the
collaboration.

For further information on protocol handlers, see [“Protocol handling” on page 54,

SOAP data handler

The SOAP data handler converts SOAP business objects to SOAP messages and
vice versa. For further information on the SOAP data handler, see
[‘SOAP data handler,” on page 73

For further details, see [Chapter 5, “SOAP data handler,” on page 73/

Configuration tools

You can deploy the SAP XI adatper with collaborations that invoke SAP XI, or are
exposed as destinations for SAP XI.

When you enable a collaboration for request processing, you use the
BIA_XIWSDLUtil transformer utility and he SAP XI Object Discovery Agent (ODA)
to generate TLOs. For further information on request processing and the SAP XI
ODA, see |Chapter 6, “Enabling collaborations for request processing,” on page 107 |

When you expose a collaboration as a web service, you use the WSDL
Configuration Wizard, which helps you generate a WSDL document for the
collaboration that you then publish, for example, via a UDDI registry. The
connector provides no tools for publishing this information. For information on
exposing collaborations as targers for SAP XI messages, see [Chapter 7, “Exposing]
lcollaborations as web services,” on page 109

Deploying the connector

The SAP XI connector does not include a gateway or front-end for managing
incoming or outgoing messages from or to external clients. You must configure and
deploy your own gateway. The connector must be deployed within the enterprise

6 Adapter for SAP XI User Guide



only, not in the DMZ or outside of the firewall.
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Architecture of connector for SAP Xl

To illustrate the architecture of the components at a high level, this section
describes two data flows. illustrates the two scenarios. These two

scenarios are described below.

SAP XI
service
S1

©)
Connector for SAP XI

y
| = =]

SAP XI
client

S2
&©

ICS

S1 Enterprise web server S2

o]

Internet
]
SAP XI SAP XI
SOAP SOAP
adapter SAP Exchange adapter
(s1) Infrastructure (XI) (S2)

v\\A &

SAP Xl Server

Figure 2. Flow of an SAP X| message
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Request processing illustrates the sequence of events that occurs when a
collaboration makes a service call request to the connector. In this scenario, the
collaboration plays the role of a client, sending a request to a server.

A

The collaboration sends a service call request to the connector, which calls
the SOAP data handler to convert the business object to a request message.

The connector invokes the URL of the enterprise web server by sending the
request message.

The enterprise web server invokes the URL of the SAP XI SOAP adapter,
which routes it to the SAP XI server. (52).

The SAP XI server S2 processes the request and returns the response. The
response is returned as part of the same connection.

The enterprise web server returns the response message to the adapter.

The connector receives the response (or fault) message, calls the SOAP data
handler to convert the message to a business object, and returns it to the
collabortion.

Event processing illustrates the sequence of events that occurs when a
collaboration is invoked by an SAP XI client. In this scenario, the collaboration
plays the role of the server, accepting a request from a client, external or internal,
and responding as required.

1

The SAP XI SOAP adapter (Client) (S1) sends a request message to the
destination—the collaboration.

The gateway receives and routes the message to the connector.

The connector sends the message to the SOAP data handler for conversion
to a business object. The connector invokes the collaboration.

The collaboration returns a response (or fault) business object.

The connector calls the SOAP data handler to convert the response (or
fault) business object to a response message. The connector returns the
response to the gateway.

The gateway routes the response message to the SAP XI SOAP adapter
(S1).

Install, configure, and design checklist

This section summarizes the tasks you must perform to install, configure, and
design the SAP XI adapter. Each section briefly describes the tasks and then
provides links to sections in this document (and cross references to related
documents) that describe how to perform the task or provide background
information.

Installing the adapter

See |Chapter 2, “Installation and startup,” on page 11| for a description of what and
where you must install.

Configuring connector properties

Connectors have two types of configuration properties: standard configuration
properties and connector-specific configuration properties. Some of these properties
have default values that you do not need to change. You may need to set the

Chapter 1. Overview of the adapter 9



values of some of these properties before running the connector. For more
information, see [Chapter 4, “SAP XI connector,” on page 45.|

Configuring protocol handlers and listeners

You configure protocol handlers and listeners when you assign values to connector
configuration properties that govern the behavior of these components. For more
information, see [Chapter 4, “SAP XI connector,” on page 45.|

Enabling collaborations for SAP Xl services

When you enable collaborations for SAP XI services, you create collaborations that
can invoke, or be exposed as, SAP XI services. You also create or adapt business
objects. For an overview of the tasks involved, see ['Configuration tools” on page 6.|

Exposing collaborations as SAP Xl services
For a step-by-step description see [Chapter 7, “Exposing collaborations as web]
services,” on page 109,

Enabling collaborations to invoke SAP Xl services
For a step-by-step description, see|Chapter 6, “Enabling collaborations for request
[processing,” on page 107

Configuring the SOAP data handler

You configure information in data handler meta-objects after you install the
product files, but before startup. Unless you are adding a custom name handler,
you can use the default SOAP data handler configuration to save time. You must,
however, configure specific meta-object information for each data handler
transformation. This information is contained in SOAP Config MOs. You specify
SOAP Config MOs when you create business objects. Much of this work is
automated when you are developing collaborations that invoke SAP XI services
(request processing): when you use the BIA_XIWSDLUtil and the SAPXI ODA to
generate business objects for SOAP messages, the SOAP Config MOs are
automatically generated for you.

For further information on configuring the data handler, see [Chapter 5, “SOAD|
[data handler,” on page 73
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Chapter 2. Installation and startup

* [“Overview of Installation Tasks”]

+ [“Installing the connector and related files”]

+ |“Overview of configuration tasks” on page 13

* [“Running multiple instances of the adapter” on page 14|

+ [“Starting and stopping the connector” on page 15|

This chapter describes how to install components for implementing the connector
for web services. For information regarding installation of an ICS system generally,
see the System Installation Guide appropriate for your platform.

Overview of Installation Tasks

For information on broker compatibility, adapter framework, software
prerequisites, dependencies, and standards and APIs, see [“Adapter for SAP X]|
fenvironment” on page 1)

To install the connector for web services, you must perform the following tasks:

Install ICS

This task, which includes installing the system and starting ICS, is described in the
System Installation Guide. You must install ICS, version 4.2.

To load files into the repository, consult the Implementation Guide for WebSphere
InterChange Server.

Install the connector and related files

This task includes installing the files for the connector (and related components)
from the software package onto your system. See [‘Installing the connector and|

related files.”

Installing the connector and related files

For information on installing WebSphere Business Integration adapter products,
refer to the Installation Guide for WebSphere Business Integration Adapters, located in
the WebSphere Business Integration Adapters Infocenter at the following site:

http:/ /www.ibm.com /websphere/integration/wbiadapters/infocenter

Installed file structure

The tables in this section show the installed file structure.

Windows connector file structure

The Installer copies the standard files associated with the connector into your
system.

The utility installs the connector and adds a shortcut for the connector agent to the
Start menu.

© Copyright IBM Corp. 2003, 2004 11



describes the Windows file structure used by the connector, and shows the

files that are automatically installed when you choose to install the connector

through Installer.

Table 1. Installed Windows file structure for the adapter

Subdirectory of ProductDir

\connectors\SAPXI\start_SAPXI.bat
\ODA\SAPXI\start_SAPXIODA.bat
connectors\SAPXI\CWSAPXI.jar
bin\Data\App\SAPXIConnectorTemplate
connectors\SAPXI\dependencies\soap.jar

connectors\messages\SAPXIConnector.txt
ODA\SAPXI\SAPXIODA.jar
ODA\messages\SAPXIODAAgent.txt
DataHandlers\CwSAPXIDataHandler.jar
repository\DataHandlers\MO_DataHandler_SOAP.txt
connectors\SAPXI\dependencies\LICENSE
connectors\SAPXI\dependencies\mail.jar
connectors\SAPXI\dependencies\activation.jar
connectors\SAPXI\dependencies\ibmjsse.jar
connectors\SAPXI\dependencies\jms.jar
connectors\SAPXI\dependencies\uddi4j-wsdl.jar
connectors\SAPXI\dependencies\uddi4jv2.jar
connectors\SAPXI\dependencies\IPL10.txt
connectors\SAPXI\dependencies\wsd14j.jar
connectors\SAPXI\dependencies\CPL10.txt
connectors\SAPXI\dependencies\gname.jar
connectors\SAPXI\dependencies\j2ee.jar
connectors\SAPXI\dependencies\wswb2.1.1\common.jar
connectors\SAPXI\dependencies\wswb2.1.1\ecore. jar
connectors\SAPXI\dependencies\wswb2.1.1\xercesImpl.jar

.1\xm1ParserAPIs.jar

1
1
connectors\SAPXI\dependencies\wswb2.1
1

connectors\SAPXI\dependencies\wswb2.1.1\xsd.jar
connectors/SAPXI/dependencies/wswb2.1.1\xsd.resources.jar
connectors/SAPXI/dependencies/IBMReadme. txt
connectors/SAPXI/dependencies/Notices.txt
connectors/SAPXI/dependencies/wswb2.1.3/ AL20.txt
connectors\SAPXI\BIA_XIWSDLTransformer.jar
connectors\SAPXI\BIA_XIWSDLUtil.bat

ODA\SAPXI\SAPHeader.xsd
ODA\SAPXI\SAPXISystemError.xsd
ODA\SAPXI\SAPXIRFCHeaders.xsd

Description

Connector startup file

ODA startup file

The SAP XI connector

The SAP XI connector template

Apache SOAP API required by the SAP XI
connector, SOAP data handler, WSDL
Configuration Wizard, and SAP XI ODA.

Connector message file

SAP XI and SAP XI ODA-related files
Message file for SAPXI ODA

The SOAP data handler

SOAP data handler-related files
Apache license file

The JavaMail API

The Java Activation Framework

JSSE (Java Secure Socket Extension) API from IBM

The Java Messaging Service
Required by SAP XI ODA

Required by SAP XI ODA

License file required by SAP XI ODA
Required by SAP XI ODA

License file required by SAP XI ODA
Required by SAP XI ODA

Required by SAP XI ODA

Required by SAP XI ODA

Required by SAP XI ODA

Required by SAP XI ODA

Required by SAP XI ODA

Required by SAP XI ODA

Required by SAP XI ODA

License

Third party license

Third party license

The BIA_XIWSDL transformer tool

The startup script for the BIA_XIWSDL
transformer tool

SAP XI ODA header schema
SAP XI ODA error messages
SAP XI RFC header schema

Note: All product pathnames are relative to the directory where the product is

installed on your system.

UNIX connector file structure

The Installer copies the standard files associated with the connector into your

system.

describes the UNIX file structure used by the connector, and shows the files

that are automatically installed when you choose to install the connector through

Installer.
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Table 2. Installed UNIX file structure for the adapter

Subdirectory of ProductDir

/connectors/SAPXI/start_SAPXI.sh
/ODA/SAPXI/start_SAPXIODA.bat
connectors/SAPXI/CWSAPXI. jar
bin/Data/App/SAPXIConnectorTemplate
connectors/SAPXI/dependencies/soap.jar

connectors/messages/SAPXIConnector. txt
ODA/SAPXI/SAPXIODA. jar
O0DA/messages/SAPXIODAAgent.txt
DataHandlers/CwSAPXIDataHandler.jar
repository/DataHandlers/M0_DataHandler_SOAP.txt
connectors/SAPXI/dependencies/LICENSE
connectors/SAPXI/dependencies/mail.jar
connectors/SAPXI/dependencies/activation.jar
connectors/SAPXI/dependencies/ibmjsse.jar

connectors/SAPXI/dependencies/jms.jar
connectors/SAPXI/dependencies/uddi4j-wsdl.jar
connectors/SAPXI/dependencies/uddi4jv2.jar
connectors/SAPXI/dependencies/IPL10.txt
connectors/SAPXI/dependencies/wsd14j.jar
connectors/SAPXI/dependencies/CPL10.txt
connectors/SAPXI/dependencies/gname.jar
connectors/SAPXI/dependencies/j2ee. jar
connectors/SAPXI/dependencies/wswb2.1.1/common. jar

connectors/SAPXI/dependencies/wswb2.1.1/ecore. jar
connectors/SAPXI/dependencies/wswb2.1.1/xercesImpl.jar
connectors/SAPXI/dependencies/wswb2.1.1/xmlParserAPIs. jar
connectors/SAPXI/dependencies/wswbh2.1.1/xsd.jar

connectors/SAPXI/dependencies/wswb2.1.1/xsd.resources.jar
connectors/SAPXI/dependencies/IBMReadme. txt
connectors/SAPXI/dependencies/Notices.txt
connectors/SAPXI/dependencies/wswb2.1.3/ AL20.txt
connectors/SAPXI/BIA_XIWSDLTransformer.jar
connectors/SAPXI/BIA_XIWSDLUti1.sh

ODA/SAPXI/SAPHeader.xsd
ODA/SAPXI/SAPXISystemError.xsd
ODA/SAPXI/SAPXIRFCHeaders.xsd

Description

Connector startup file

ODA startup file

The SAP XI connector

The SAP XI connector template

Apache SOAP API required by the SAP XI
connector, SOAP data handler, WSDL
Configuration Wizard, and SAP XI ODA.

Connector message file

SAP XI and SAP XI ODA-related files
Message file for SAPXI ODA

The SOAP data handler

SOAP data handler-related files
Apache license file

The JavaMail APT

The Java Activation Framework

JSSE (Java Secure Socket Extension) API from
IBM

The Java Messaging Service
Required by SAP XI ODA

Required by SAP XI ODA

License file required by SAP XI ODA
Required by SAP XI ODA

License file required by SAP XI ODA
Required by SAP XI ODA

Required by SAP XI ODA

Required by SAP XI ODA

Required by SAP XI ODA

Required by SAP XI ODA

Required by SAP XI ODA

Required by SAP XI ODA

Required by SAP XI ODA

License

Third party license

Third party license

The BIA_XIWSDL transformer tool

The startup script for the BIA_XIWSDL
transformer tool

SAP XI ODA header schema
SAP XI ODA error messages
SAP XI RFC header schema

Note: All product pathnames are relative to the directory where the product is
installed on your system.

Overview of configuration tasks

After installation and before startup, you must configure components as follows:

Configure the connector

This task includes setting up and configuring the connector. See [“Configuring the]
fconnector” on page 61.

Configure business objects

The steps for configuring business objects depend on how you elect to implement
the product suite:

* Request Processing You must create the business objects that correspond to:
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— The request messages to be sent to each SAP XI web service
— Each possible response, including faults

For further information, review [Chapter 3, “Business object requirements,” on|
page 17]and then see [Chapter 6, “Enabling collaborations for request|
processing,” on page 107

* Event Processing You can use TLO or non-TLO business objects.

For further information, review [Chapter 3, “Business object requirements,” onl|
age 17|and then see [Chapter 7, “Exposing collaborations as web services,” on|
age 109.

Configure the data handler

The SOAP data handler meta-object must be configured after installation. In
addition, SOAP Config MOs must be configured for each SOAP business object. To
configure the data handler, see|Chapter 5, “SOAP data handler,” on page 73]

Configure collaborations

* Request processing For collaborations that invoke web services as part of their
processing, you generate business objects using the SAP XI ODA and then bind
collaboration object ports to the connector. For further information including a
step-by-step procedure, see [Chapter 6, “Enabling collaborations for request|
[processing,” on page 107

* Event processing For a collaboration that is exposed as a destination for an SAP
XI client, you must generate a WSDL document using the WSDL Configuration
Wizard, make the document available to potential clients, and then configure the
ports of the collaboration object so that clients can invoke the collaboration. For
further information including a step-by-step procedure, see [Chapter 7, “Exposing]
[collaborations as web services,” on page 109.

Running multiple instances of the adapter

Creating multiple instances of a connector is in many ways the same as creating a
custom connector. You can set your system up to create and run multiple instances
of a connector by following the steps below. You must:

* Create a new directory for the connector instance

* Make sure you have the requisite business object definitions
* Create a new connector definition file

* Create a new start-up script

Create a new directory

You must create a connector directory for each connector instance. This connector
directory should be named:

ProductDir\connectors\connectorInstance
where connectorInstance uniquely identifies the connector instance.
If the connector has any connector-specific meta-objects, you must create a

meta-object for the connector instance. If you save the meta-object as a file, create
this directory and store the file here:

ProductDir\repository\connectorInstance
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Create business object definitions
If the business object definitions for each connector instance do not already exist
within the project, you must create them.

1. If you need to modify business object definitions that are associated with the
initial connector, copy the appropriate files and use Business Object Designer to
import them. You can copy any of the files for the initial connector. Just rename
them if you make changes to them.

2. Files for the initial connector should reside in the following directory:
ProductDir\repository\initialConnectorInstance

Any additional files you create should be in the appropriate connectorInstance
subdirectory of ProductDir\repository.

Create a connector definition
You create a configuration file (connector definition) for the connector instance in
Connector Configurator. To do so:

1. Copy the initial connector’s configuration file (connector definition) and rename
it.

2. Make sure each connector instance correctly lists its supported business objects
(and any associated meta-objects).

3. Customize any connector properties as appropriate.

Create a start-up script
To create a startup script:

1. Copy the initial connector’s startup script and name it to include the name of
the connector directory:

dirname

2. DPut this startup script in the connector directory you created in

[directory” on page 14.|

3. Create a startup script shortcut (Windows only).

4. Copy the initial connector’s shortcut text and change the name of the initial
connector (in the command line) to match the name of the new connector
instance.

You can now run both instances of the connector on your integration server at the
same time.

For more information on creating custom connectors, refer to the Connector
Development Guide for C++ or for Java.

Starting and stopping the connector

Important: As noted earlier in this chapter, the connector, business objects, the
SOAP data handler meta-objects, and collaborations must be
configured after installation and before starting the connector to assure
proper operation. For a summary of these tasks, see
[configuration tasks” on page 13]In addition, connector polling should
not be disabled (connector polling is enabled by default).

A connector must be explicitly started using its connector start-up script. The
startup script should reside in the connector’s runtime directory:

ProductDir\connectors\connName
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where connName identifies the connector. The name of the startup script depends

on the operating-system platform, as shows.

Table 3. Startup scripts for a connector

Operating system Startup script
UNIX-based systems connector_manager_connName
Windows start_connName .bat

You can invoke the connector startup script in any of the following ways:
* On Windows systems, from the Start menu

Select Programs>IBM WebSphere Business Integration
Adapters>Adapters>Connectors. By default, the program name is “IBM
WebSphere Business Integration Adapters”. However, it can be customized.
Alternatively, you can create a desktop shortcut to your connector.

* From the command line
— On Windows systems:
start_connName connName brokerName [-cconfigFile ]
— On UNIX-based systems:
connector_manager_connName -start

where connName is the name of the connector and brokerName identifies your
integration broker, as follows:

— For WebSphere InterChange Server, specify for brokerName the name of the
ICS instance.

— For WebSphere message brokers (WebSphere MQ Integrator, WebSphere MQ
Integrator Broker, or WebSphere Business Integration Message Broker) or
WebSphere Application Server, specify for brokerName a string that identifies
the broker.

Note: For a WebSphere message broker or WebSphere Application Server on a
Windows system, you must include the -c option followed by the name of
the connector configuration file. For ICS, the -c is optional.

* From Adapter Monitor (WebSphere Business Integration Adapters product only),
which is launched when you start System Manager

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

* From System Monitor (WebSphere InterChange Server product only)

You can load, activate, deactivate, pause, shutdown or delete a connector using
this tool.

* On Windows systems, you can configure the connector to start as a Windows
service. In this case, the connector starts when the Windows system boots (for an
Auto service) or when you start the service through the Windows Services
window (for a Manual service).

For more information on how to start a connector, including the command-line
startup options, refer to one of the following documents:

* For WebSphere InterChange Server, refer to the System Administration Guide.

* For WebSphere message brokers, refer to Implementing Adapters with WebSphere
Message Brokers.

* For WebSphere Application Server, refer to Implementing Adapters with WebSphere
Application Server.
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Chapter 3. Business object requirements

« |“Business object meta-data”|

+ [“Connector business object structure’]

+ |“Synchronous event processing TLOs” on page 18|

» [“Asynchronous event processing TLOs” on page 27|

* |“Event processing non-TLOs” on page 30

* |“Synchronous request processing TLOs” on page 30

* [“Synchronous request processing TLOs” on page 30

* |“Asynchronous request processing TLOs” on page 46|

» [“Developing business objects” on page 43|

This chapter describes the structure, requirements, and attributes of connector
business objects.

Business object meta-data

The connector for SAP XI is a meta-data-driven connector. In business objects,
meta-data is data about the application, which is stored in a business object
definition and which helps the connector interact with an application. A
meta-data-driven connector handles each business object that it supports based on
meta-data encoded in the business object definition rather than on instructions
hard-coded in the connector.

Business object meta-data includes the structure of a business object, the settings of
its attribute properties, and the content of its application-specific information.
Because the connector is meta-data-driven, it can handle new or modified business
objects without requiring modifications to the connector code. However, the
connector’s configured data handler makes assumptions about the structure of its
business objects, object cardinality, the format of the application-specific text, and
the database representation of the business object. Therefore, when you create or
modify a business object for web services, your modifications must conform to the
rules the connector is designed to follow, or the connector cannot process new or
modified business objects correctly.

For more information on meta-data, meta-objects, and their configuration and
interaction with business objects and SOAP messages, see |[Chapter 5, “SOAP data|
lhandler,” on page 73]

Connector business object structure

The connector processes two kinds of business objects:

¢ TLOs A SOAP XI top-level business object (TLO) contains a Request business
object and, optionally, Response and Fault business objects. These child objects
contain content data as well as SOAP Config MOs, and, optionally, Protocol
Config MOs. The TLO, Request, Response, and Fault objects as well as
application-specific information, attributes, and requirements with regard to
request versus event processing are described and illustrated in the sections
below.

Note: TLOs are used for request processing and event processing.
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* Non-TLOs These are generic business objects (GBOs) and application-specific
business objects (ASBOs) that are not TLOs, but which have been used by the
WSDL Configuration Wizard in WSDL generation. The connector can process
non-TLOs during event processing. These objects are discussed below in[“Even{]
processing non-TLOs” on page 30.| For further information, see |”WSD! ]
Configuration Wizard” on page 112.|

Note: Non-TLOs are used for event processing only.

Note: SOAP header container and header business objects, which are included in
Request, Response, and Fault business objects, are not discussed in this
chapter. For_information on SOAP header container and header business
objects, see [Chapter 5, “SOAP data handler,” on page 73|

Synchronous event processing TLOs

For event processing the connector allows two kinds of TLOs—synchronous and
asynchronous. This section discusses synchronous event processing TLOs.

[Figure 3 on page 19 shows the business object hierarchy for synchronous event
processing. Request and Response objects are required, Fault objects are optional.
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[ SAP XI TLO ]

_[ Request BO Required ]

_[ Header Container ]
—[ Header BO ]
—‘ Header BO ]

—[ SOAP Config MO ]

—( Protocol Config MO Optional ]

_[ Response BO Required ]

_[ Header Container ]
—[ Header BO ]
—[ Header BO ]

—[ SOAP Config MO ]

—[ Fault BO Optional ]

—{ soApconfigMo |

_[ HeaderFault Container ]

_[ HeaderFault BO ]
_[ HeaderFault BO ]

—[ Fault BO Opftional ]

Figure 3. Business object hierarchy for synchronous event processing

The TLO contains object-level ASI as well as attributes with attribute-level ASL
Both kinds of ASI are discussed below.

Object-level ASI for synchronous event processing TLOs
Object-level ASI provides fundamental information about the nature of a TLO and
the objects it contains. shows the object-level ASI for
SERVICE_SYNCH_OrderStatus, a sample TLO for synchronous event processing.
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&l Business Dbject Designer - [SER¥ICE_SYNCH_TLD_OrderStatus:Local Project]
& File Edit Wiew Tools Window Help

[Pes@x|smm|s¢ (&=
GeneraIIAﬂributesI

Business Object Level Application-specific information;

|ws_mode=synch; ws_collab=SERVICE_SYMNCH_OrderStatus_Collab; ws_verb=R etieve; ws_eventtlo=tue;

Supported Yerbs:

Marme T Application-specific information
1 |create
2 |Delete
3 |Retrieve h
4 |Update
5

Figure 4. Top-level business object for synchronous event processing

below describes the object-level ASI for a synchronous event processing

TLO.

Table 4. Synchronous event processing TLO object AS/

Object-level ASI Description

ws_eventtlo=true If this ASI property is set to true, the connector

treats this object as a TLO for event processing only.

Note that the WSDL Configuration Wizard uses this
ASI to determine whether a business object is a
TLO. For more on this see [*WSDL Configuration|
[Wizard” on page 112.|

ws_collab=collabname This ASI tells the connector which collaboration to
invoke. Its value is the name of the collaboration.
(This ASI is also used during WSDL generation to
determine the TLO for a collaboration. For more on
this see ["'WSDL Configuration Wizard” on page|

In the sample shown infFigure 4} the
collaboration name is
SERVICE_SYNCH_OrderStatus_Collab)

ws_verb=verb Before delivering the TLO to the collaboration, the
connector uses this ASI to set the verb on the TLO.

In the sample shown i the verb is

Retrieve.

ws_mode=synch During event notification, the connector uses this
ASI property to determine whether to invoke the
collaboration synchronously (synch) or
asynchronously (asynch). For synchronous
processing, this ASI must be set to synch.

The default is asynch.

Attribute-level ASI for synchronous event processing TLOs

Each synchronous event processing TLO has attributes and attribute-level ASL
shows the attributes of SERVICE_SYNCH_OrderStatus, a sample TLO. It
also shows the attribute-level ASI in the App Spec Info column.
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& Business Dbject Designer - [SERYICE_SYNCH_TLD_OrderStatus:Local Project]
B File Edit Wiew Tools Window Help

jpes@x(smr|s ||z

General l Adtributes ]

Pos Matme: Type KeQ{ Fareign R:;;ui Card App Spec Info
1 1 H Reguest SERWICE_SYMCH_OrderStatus_Reguest Ird I -r 1 wes_hatype=regquest
2 |z M Response SERYICE_SYMCH_OrderStatus_Response| [ - - 1 we_botypesresponse
3 |z M Fautt SERWICE _SYMCH_OrderStatus_Fault - - - 1 we_botype=tault
4 |4 |OhjectEvertld String
5 s r r r

Figure 5. TLO attributes for synchronous event processing

summarizes the attribute-level ASI for the Request, Response, Fault,
MimeType, and Charset attributes of an synchronous event processing TLO.

Table 5. Synchronous event processing TLO attribute ASI

TLO attribute

Attribute-level ASI

Description

MimeType

Optional attribute; if
specified, its value is used as
the mime type of the data
handler to invoke for the
synchronous response. The
type is String and the default
is xm1/soap.

Charset

This optional parameter of
type String specifies the
charset to be set on the data
handler when transforming
an outgoing business object
to the message. NOTE: the
charset value specified in this
attribute will not be
propagated in the
Content-Type protocol
header of the response
message.

Request

ws_botype=request

This attribute corresponds to
a request. The connector uses
its ASI to determine whether
this TLO attribute is of type
SOAP Request BO. This ASI,
not the attribute name,
determines the attribute type.
If there is more than one
request attribute, the
connector uses the ASI of the
first one.

This attribute is required for
synchronous event
processing TLOs.
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Table 5. Synchronous event processing TLO attribute ASI (continued)

TLO attribute

Attribute-level ASI

Description

Response

ws_botype=response

This attribute corresponds to
the response returned by a
web service. The connector
uses this ASI to determine
whether this TLO attribute is
of type SOAP Response BO.
This ASI, not the attribute
name, determines the
attribute type. If there is
more than one response
attribute, the connector uses
the ASI of the first one.

This attribute is required for
synchronous event
processing TLOs.

Fault

ws_botype=fault
ws_botype=defaultfault

This attribute, optional for
synchronous event
processing, corresponds to a
fault message returned by a
collaboration when it cannot
successfully populate a
response. The connector uses
this ASI, not the attribute
name, to determine if the
attribute is of type SOAP
Fault BO.If
ws_botype=defaultfault,then
the WSDL Configuration
Wizard uses this Fault
business object for header
processing. For further
information, see m
[fault processing” on page 84.

Request business object for synchronous event processing
A Request business object is a child of a TLO and is required for synchronous
event processing. A Request business object has object-level ASI. For example, if

you open SERVICE_SYNCH_OrderStatus_Request in Business Object Designer and
click the General tab, the object level ASI is displayed as shown in

22 Adapter for SAP XI User Guide




=i SERYICE_SYMNCH_OrderStatus_Request:WebServicesSample *

General ] Aftributes ]

Businesz Dbject Level Application-specific information:

|cw_mo_soap=SDAPCngD; cw_mo_jms=50APJMSCigMO; ws_tloname=SERVICE_SYNCH_TLO_OrderStat.

Supported Werbs:

Mame \_ Application-specific information

Create

Delete

Retrieve Default’/erb=true;

Upcdate

| =] w| o] =

Figure 6. Object-level ASI for synchronous event processing request object

The object-level ASI for a Request business object for synchronous event processing
is described in As shown in you can specify a default verb for the
Request business object. You do so by specifying;:

DefaultVerb=true;

in the ASI field for the verb in the Supported Verbs list at the top-level of the
Request business object. If DefaultVerb ASI is not specified and the data handler
processes a business object with no verb set, the business object is returned

without a verb.

Table 6. Synchronous event processing: object-level ASI for Request business objects

Object-level ASI

Description

cw_mo_soap=SO0APCfgMo

The value of this ASI must match the name of the
attribute that corresponds to the SOAP Config
MO. This is the meta-object that defines the data
handler transformation for the Request business

object. For further information, see ["'SOAP Config]
[MO” on page 24

cw_mo_http=SOAPHTTPCfgMO

The value of this ASI must match the name of the
attribute that corresponds to the Protocol Config
MO. The ASI designates the SOAP/HTTP or
SOAP/HTTPS protocol listener. Both the ASI and
the Protocol Config MO are optional. For further
information, see [“Protocol Config MO” on page]

ws_tloname=tloname

This ASI specifies the name of the SAP XI TLO
that this object belongs to. During event
processing, the connector uses this ASI to
determine whether the Request business object
delivered by the data handler is a child of the
TLO. If so, the connector creates the specified
TLO, sets the Request business object as its child,
and uses the TLOs object-level ASI to deliver it to
the subscribing collaboration.

Response business object for synchronous event processing
A Response business object is a child of a TLO and is required for synchronous
event processing. The object-level ASI for a Response business object for
synchronous event processing is described in
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Table 7. Synchronous event processing: object-level ASI for Response business objects

Object-level ASI Description

cw_mo_soap=SO0APCfgMO The value of this AST must match the name of the
attribute that corresponds to the SOAP Config
MO. This is the SOAP Config MO that defines the
data handler transformation for the Response
business object. For further information, see
[“'SOAP Config MO.”|

Note: You can optionally include a Protocol Config MO object-level ASI for the
Response BO.

Fault business object for synchronous event processing
A Fault business object is a child of a TLO and is optional for synchronous event
processing. The object-level ASI for a Fault business object for synchronous event

processing is described in

Table 8. Synchronous event processing: object-level ASI for Fault business objects

Object-level ASI Description

cw_mo_soap=SOAPCfgMO The value of this ASI must match the name of the
attribute that corresponds to the SOAP Config

MO. This is the SOAP Config MO that defines the
data handler transformation for the Fault business

object. For further information, see ["SOAP Config]

Note: You can optionally include a Protocol Config MO object-level ASI for the
Fault BO.

SOAP Config MO

The SOAP Config MO defines the formatting behavior for one data handler
transformation — either a SOAP-message-to-business-object or
business-object-to-SOAP-message transformation. Each Request, Response, and
Fault attribute has a SOAP Config MO. Its attributes, BodyName, BodyNS, Style,
Use, Typelnfo, TypeCheck and BOVerb, are always of type String. They
correspond to SOAP message elements and their values determine how messages
and objects are read and validated by the SOAP data handler. For more
information on SOAP Config MOs and attributes, see ["'SOAP configuration|
fmeta-object: child of every SOAP business object” on page 75, All SOAP Config
MOs, whether for a request, response, or fault object, must have unique entries for
default values of BodyName and BodyNS.

Protocol Config MO

This MO is optionally included as a child of the request, response, or fault business
objects for event processing. Typically you specify it when you need to read (from
request messages) or propagate (to response or fault messages) the protocol
headers and custom properties. As noted above, the request business object
optionally declares the name of the Protocol Config MO as business-object-level
ASI: cw_mo_http=HTTPProtocolListenerConfigMOAttribute

During event processing, the connector uses protocol listeners (SOAP/HTTD,
SOAP/HTTPS) to retrieve events from the transport. These events are messages
from internal or external web service clients requesting service from collaborations
that have been exposed as SAP XI services. Each transport has its own header
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requirements. The connector uses the Protocol Config MO to convey the
protocol-specific header information from the protocol listener to the collaboration.

For SOAP/HTTP(S) protocol, the Protocol Config MO attributes are as follows:
Table 9. HTTP/HTTPS Protocol Config MO Attributes for Event Processing

Attribute Required Type Description

Content-Type No String The value of this attribute
defines the Content-Type
header of the outgoing message
(which includes message
ContentType and 0 or more
parameters --the charset-- for
the outgoing message). The
syntax is the same as that for
the Content-Type header in the
HTTP Protocol, for example:
text/html;
charset=150-8859-4. If there is
no Content-Type attribute
defined, the connector uses the
ContentType of the request as
the ContentType of the
response/fault message.

UserDefinedProperties No Business object | This attribute holds the
user-defined protocol properties
business object.

One or more HTTP No String This attribute allows the
headers handler to pass or retrieve the
value for the specified HTTP
header.

Authorization_UserID No String This attribute corresponds to
the userID of the HTTP basic
authentication.

Authorization_Password |No String This attribute corresponds to
the password of the HTTP basic
authentication

These attributes are described in:

* [“User-defined properties for event processing”|

 |“HTTP credential propagation for event processing” on page 26|

For further information on protocol listeners, see [“Protocol listeners” on page]
U8 [For information describing the Protocol Config MO for request processing, see
“Synchronous request processing TLOs” on page 30)).

User-defined properties for event processing: You can optionally specify custom
properties in the HTTP(S) Protocol Config MO. You do so by including the
UserDefinedProperties attribute. This attribute corresponds to a business object that
has one or more child attributes with property values. Every attribute in this
business object must define a single property to be read (or, for synchronous
responses, written) in the variable portion of the message header as follows:

* The type of the attribute should always be String regardless of the protocol
property type. The application-specific information of the attribute can contain
two name-value pairs defining the name and format of the protocol message
property to which the attribute maps.
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able 10summarizes the application-specific information for these attributes.

Table 10. Application-specific information for user-defined protocol property attributes:
name=value pair content

Name Value Description
Ws_prop_name Any valid protocol property | This is the name of the
(case-insensitive; if not name protocol property. Some
specified the attribute name vendors reserve certain
will be used as the property properties to provide
name extended functionality.
ws_prop_type String The type of the protocol
property.

If the given custom property ASI (either the ws_prop_name or ws_prop_type) is
invalid and there is no logical way to process this header (such as ignoring the
property type for HTTP processing), the connector logs a warning and ignores this
property. If the value of the custom property can neither be set nor retrieved after
the necessary check against ws_prop_name or ws_prop_type has been performed,
the connector logs the error and fails the event.

If the UserDefinedProperties attribute is specified, the connector will create an
instance of a UserDefinedProperties business object. The connector then attempts
to extract property values from the message and store them in the business object.
If at least one property value is successfully retrieved, the connector will set a
modified UserDefinedProperties attribute in the Protocol Config MO.

For synchronous event processing, if a UserDefinedProperties attribute is specified
and its business object is instantiated, the connector will process each attribute of
this child business object and set the message property value accordingly.

HTTP credential propagation for event processing: For the purpose of credential
propagation, the connector supports the Authorization_UserID and
Authorization_Password attributes in the HTTP Protocol Config MO. The support
is limited to the propagation of these credentials as part of the HTTP Basic
authentication scheme.

If a SOAP/HTTP or SOAP/HTTPS protocol listener processes a SOAP/HTTP web
service request that includes an authorization header, the listener will parse the
header to determine whether it conforms to HTTP Basic authentication. If so, the
listener extracts and decodes (using Base64) the username and password. This
decoded string consists of a username and password separated by a colon. If the
protocol listener finds the Authorization_UserID and Authorization_Password
attributes in the Protocol Config MO, the listener sets these values with those
extracted from the event authorization header.

Header container business objects

The header container attribute, also known as the SOAP header attribute,
corresponds to a business object that contains only child business objects. Each
child represents a header entry in the SOAP message. SOAP header attributes have
application-specific information (ASI) required by the SOAP data handler. For
example, a header container business object is identified by its ASI:
soap_location=SO0APHeader. For information on header processing, see
lhandler processing” on page 79
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All SOAP business objects, whether a Request, Response, or Fault object, have one
and only one header container.

Header child business objects

Each header child business object represents a single header element in a SOAP
message. The header element is an immediate child of the SOAP-Env:Header
element of the SOAP message. The header child business objects may have an
actor and a mustUnderstand attribute. These attributes correspond to the actor and
mustUnderstand attributes of the SOAP header element. For information on header
processing, see ['SOAP data handler processing” on page 79,

There may be as many header child objects as are needed to represent the SOAP
header message elements.

Asynchronous event processing TLOs

shows the business object hierarchy for asynchronous event processing. A
request object only is required.

[ SAP XI TLO ]

_[ Request BO required ]

—( Header container optional ]

—[ Header BO ]

[ Header BO ]

—[ SOAP Config MO ]

[ Protocol Config MO optional J

Figure 7. Business object hierarchy for asynchronous event processing

The TLO contains object-level ASI as well as attributes with attribute-level ASI.
Both kinds of ASI are discussed below. For information on the header container
ﬁd header child business objects, see [‘Header container business objects” on page|
6|

Object-level ASI for asynchronous event processing TLOs
Object-level ASI provides fundamental information about the nature of a TLO and
the objects it contains. shows the object-level ASI for
SERVICE_ASYNCH_TLO_Order, a sample TLO for asynchronous event processing.
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&l Business Object Designer - SERYICE_ASYNCH_TLO_Order:Local Project

File Edit Yiew Tools Window Help

[pes @x|saad|s ¢ |8

=i SER¥ICE_ASYNCH_TLO_Order:Local Project

General I Attributes I

Business Object Level Application-specific information:

Supported Yerbs:

st_mude=asynch, ws_verb=Create; ws_eventtlio=true;

Maime Application-specific infarmstion

Create

Delete

Retrieve

Update

| & w] ] =

Figure 8. Top-level business object for asynchronous event processing

below describes the object-level ASI for an asynchronous event processing

TLO.

Table 11. Asynchronous event processing TLO object ASI

Object-level ASI

Description

ws_eventtlo=true

If this ASI property is set to true, the connector
treats this object as a TLO for event processing.

Note that the WSDL Configuration Wizard uses this
ASI to determine whether a business object is a
TLO. For more on this see [“WSDL Configuration|
[Wizard” on page 112.|

ws_verb=verb

Before delivering the TLO to the collaboration, the
connector uses this ASI to set the verb on the TLO.

In the sample shown the verb is Create.

ws_mode=asynch

During event notification, the connector uses this
ASI property to determine whether to invoke the
collaboration synchronously (synch) or
asynchronously (asynch). For asynchronous
processing, this ASI must be set to asynch.

The default is asynch.

Note: Unlike synchronous event processing, no collaboration name ASI is required
at the TLO level for asynchronous event processing. Instead the integration
broker assures that application events reach all subscribing collaborations.

Attribute-level ASI for asynchronous event processing TLOs

Each asynchronous event |

a Request business object.

processing TLO has a single attribute that corresponds to

shows the request attribute of

SERVICE_ASYNCH_TLO_Order, a sample TLO, and the attribute’s ASL
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&l Business Object Designer - SERYICE_ASYNCH_TLO_Order:Local Project
File Edit Yiew Tools ‘Window Help
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Figure 9. TLO attribute for asynchronous event processing

summarizes the attribute-level ASI for the request attribute of an
asynchronous event processing TLO.

Table 12. Asynchronous event processing TLO attribute ASI
TLO attribute Attribute-level ASI Description

Request ws_botype=request This attribute corresponds to
a web service request. The
connector uses its ASI to
determine whether this TLO
attribute is of type SOAP
Request BO. This ASI, not
the attribute name,
determines the attribute type.
If there is more than one
request attribute, the
connector uses the ASI of the
first one.

This attribute is required for
synchronous event
processing TLOs.

Request business object for asynchronous event processing
A Request business object is a child of a TLO and is required for asynchronous
event processing. You can specify a default verb for the Request business object.
You do so by specifying:

DefaultVerb=true;

in the ASI field for the verb in the Supported Verbs list at the top-level of the
Request business object. If DefaultVerb ASI is not specified and the data handler
processes a business object with no verb set, the business object is returned
without a verb. The object-level ASI for a Request business object for asynchronous
event processing is described in

Table 13. Asynchronous event processing: object-level ASI for Request business objects

Object-level ASI Description

cw_mo_soap=SO0APCfgMO The value of this ASI must match the name of the
attribute that corresponds to the SOAP Config
MO. This is the SOAP Config MO that defines the
data handler transformation for the Request
business object. For further information, see
[“SOAP Config MO” on page 24
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Table 13. Asynchronous event processing: object-level ASI for Request business
objects (continued)

Object-level ASI Description

cw_mo_http=SOAPHTTPCfgMO The value of this ASI must match the name of the
attribute that corresponds to the Protocol Config
MO. The ASI shown designates the SOAP/HTTP
or SOAP/HTTPS protocol listener. Both the ASI
and the Protocol Config MO are optional. For
further information, see[Protocol Config MO” on|

ws_tToname=tloname This ASI specifies the name of the web services
TLO that this object belongs to. During event
processing, the connector uses this ASI to
determine whether the Request business object
delivered by the data handler is a child of the
TLO. If so, the connector creates the specified
TLO, sets the Request business object as its child,
and uses the TLOs object-level ASI to deliver it to
the subscribing collaboration.

The requirements and characteristics of the SOAP Config MO, Protocol Config MO,
SOAP header container, and header child business objects are the same for
asynchronous event processing as they are for synchronous event processing. For
further information, see these topics above in [“Synchronous event processing|
[TLOs” on page 18

Event processing non-TLOs

If the object-level ASI ws_eventtlo=true is not present in a business object, the
connector concludes that the object is not a TLO. During event processing, the
connector can process non-TLOs—generic business objects and application specific
business objects. With non-TLOs, the same business object represents the Request
and Response business object.

Non-TLOs do not have SOAP Config MOs. When you expose a collaboration as a
SAP XI service, the WSDL Configuration Wizard configures the WSCollaborations
property of the connector. The connector uses the WSCollaborations property to
determine the BodyName and BodyNS of the request message. Note that for
non-TLOs, the WSCollaborations property is used for business object resolution.

The advantage to using non-TLOs is that you need not develop new,
TLO-structured business objects for use with your SAP XI solution. TLOs, however,
allow a more precise and economical exposure of data—customer, company, or
otherwise. TLO business objects also lend themselves to more customization than
do non-TLOs.

For further information on requirements when using non-TLOs as input to the
WSDL Configuration Wizard, see|“Identifying or Developing Business Objects” on|
page 110

Synchronous request processing TLOs

For request processing the connector allows two kinds of TLOs—synchronous and
asynchronous. This section discusses synchronous request processing TLOs.
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shows the TLO business object hierarchy for synchronous request
processing. Request and Response objects are required, Fault objects are optional.
Unlike event processing, a Protocol Config MO is required for the Request objects,

and optional for the Response and Fault objects. For information on the header

container and header child business objects, see ["Header container business

lobjects” on page 26.|

[

SAP XI TLO ]

_[ Request BO required ]

_( Header container optional ]

Header BO ]

Header BO ]

—[ SOAP Config MO

)

—[ HTTP Protocol Config MO]

required ]

—( Header container optional J

Header BO ]

Header BO ]

—[ SOAP Config MO

)

—[HTTP Protocol Config MO optt'onal]

_[ Fault BO optional ]

—[ HeaderFault container optional ]

Header BO ]

Header BO ]

—[ SOAP Config MO

]

—[HTTP Protocol Config MO optianalJ

—[ MimeType optional ]

—[ Charset optional ]

—[ BOPrefix optional ]

Figure 10. Business object hierarchy for synchronous request processing
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Object-level ASI for synchronous request processing TLOs
Object-level ASI provides important information about the nature of a TLO and the
objects it contains. shows CLIENT_SYNCH_TLO_OrderStatus, a sample
TLO for synchronous request processing.

describes the object-level ASI for a synchronous request processing TLO.

& Business Object Designer - CLIENT_S¥NCH_TLO_OrderStatus:Local Project

File Edit Wiew Tools Window Help
[pas@x|re=als ¢ |a|= 5]

General ] Attributes I

Business Object Level Application-zpecific information:

st_mode=sync:h;

Supported Yerbs:

Marme Application-specific information
1 |creste
2 |Delete
3 |Retrieve
4
5

Updlate

Figure 11. Top-level business object for synchronous request processing

Unlike the ASI for synchronous event processing TLOs, no ws_collab, ws_verb or
ws_eventtlo ASI is required at this level for request processing.

Table 14. Synchronous request processing TLO object ASI

Object-level ASI Description

ws_mode=synch During request processing, the connector uses this
ASI property to determine whether to invoke the
web service synchronously (synch) or
asynchronously (asynch). If synch is indicated, then
the connector expects a response, and the TLO
must include request and response business objects
and, optionally, one or more fault objects.

The default is asynch.

Attribute-level ASI for synchronous request processing TLOs

shows the attributes of the CLIENT_SYNCH_TLO_OrderStatus TLO as
well as attribute-level ASI.
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&l Business Dbject Designer - CLIENT_SYNCH_TLO_OrderStatus:Local Project

File Edit Wiew Tools ‘Window Help
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3 |3 |BOPrefix String r 255
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B H Fault Status,_Fault r 1 wz_hotype=tault
G CLIEMT_SYMCH_Crdler _
4 H Request Status_Request Il 1 wz_botype=request
7 CLIEMT_SYMCH_Crdler -
2 H Responze Status Response I 1 wz_hotype=response

Figure 12. TLO attributes for synchronous request processing

describes the attributes and ASI shown in

Table 15. Request processing TLO attributes

TLO attribute

Attribute-level ASI

Description

MimeType

None

This attribute specifies the mime
type of the data handler that the
connector invokes for transforming
a Request business object into a
request message. This value may be
used for transforming synchronous
response/fault messages into
business objects, depending on the
Message Transformation Rules
configuration.

BOPrefix

None

This attribute of type String is
passed to the data handler.

Handler

None

This attribute specifies the protocol
handler to use to process the web
service request and is for request
processing only. It takes the
following value:soap/http The
connector uses the SOAP/HTTP,
SOAP/HTTPS protocol handler to
process this request. The default is
soap/http

Charset

This optional parameter of type
String specifies the charset to be set
on the data handler when
transforming the Request business
object to a message. NOTE: the
charset value specified in this
attribute will not be propagated in
the Content-Type protocol header of
the request message.
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Table 15. Request processing TLO attributes (continued)

TLO attribute | Attribute-level ASI Description

Request ws_botype=request This attribute corresponds to a web
service request business object. The
connector uses this attribute ASI to
determine whether this TLO
attribute is of type SOAP Request
BO. This ASI, not the attribute
name, determines the attribute type.
If there is more than one request
attribute, the connector uses the ASI
of the first populated attribute.

Response ws_botype=response This attribute corresponds to the
response returned to a collaboration
and is required for synchronous
request processing. The connector
uses this attribute ASI to determine
whether this TLO attribute is of type
SOAP Response BO. This ASI, not
the attribute name, determines the
attribute type.

Fault ws_botype=fault This attribute, optional for
or synchronous request processing,
ws_botype=defaultfault corresponds to a fault message

returned by a web service when it
cannot successfully populate a
response.

The connector uses this ASI to
determine if the attribute of TLO is
of type SOAP Fault BO. This ASI,
not the attribute name, determines
the attribute type. A defaultfault
business object is returned if the
fault message is a detail element.
defaultfault is used in default
business object resolution. For
further information, see |Chapter 5,|
['SOAP data handler,” on page 73]

Request business object for synchronous request processing
A Request business object is a child of a TLO and is required for synchronous
request processing. A Request business object has object-level ASI.

describes the object-level ASI for a Request business object for
synchronous request processing.

Table 16. Synchronous request processing: object-level ASI for Request business objects

Object-level ASI Description

cw_mo_soap=SO0APCfgMO The value of this AST must match the name of the
attribute that corresponds to the SOAP Config
MO. This is the SOAP Config MO that defines the
data handler transformation for the Request
business object. For further information, see
[“SOAP Config MO” on page 24|
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Table 16. Synchronous request processing: object-level ASI for Request business
objects (continued)

Object-level ASI Description

cw_mo_http=SOAPHTTPCfgMO The value of this optional ASI must match the
name of the attribute that corresponds to the
Protocol Config MO. This is a separate Protocol
Config MO that specifies the destination for the
SOAP/HTTP-HTTPS protocol handler. This ASI is
used by the SOAP/HTTP and SOAP/HTTPS
Protocol Handler. Note that the TLO request
attribute must have an HTTP Protocol Config MO
for request processing. For further information,
see ["HTTP Protocol Config MO for request|
[processing” on page 36.|

SO0APAction=SOAPActionURI The connector uses this ASI to determine whether
to set a SOAPAction header on the request
message. Specify this ASI only if the target web
service requires a SOAPAction header. Note that
this ASI is used for request processing but not for
event notification.

Response business object for synchronous request processing
A Response business object is a child of a TLO and is required for synchronous

request processing. The object-level ASI for a Response business object for
synchronous request processing is described in [Table 1

Table 17. Synchronous request processing: object-level ASI for response business objects

Object-level ASI Description

cw_mo_soap=SOAPCfgM0 The value of this ASI must match the name of the
attribute that corresponds to the SOAP Protocol
Config MO. This is the SOAP Config MO that
defines the data handler transformation for the
Response business object. For further information,
see ['SOAP Confic MO” on page 24

cw_mo_http=SOAPHTTPCfgMO The value of this ASI must match the name of the
attribute that corresponds to the Protocol Config
MO. This is the Protocol Config MO, optional for
a Response business object, that specifies the
headers in the response SOAP message for the
HTTP(s) protocol handler. For further
information, see[“Protocol Confie MO” on pagel

You can specify a default verb for the Response business object. You do so by
specifying:
DefaultVerb=true;

in the ASI field for the verb in the Supported Verbs list at the top-level of the
Response business object. If DefaultVerb ASI is not specified and the data handler
processes a business object with no verb set, the Response business object is
returned without a verb.

Fault business object for synchronous request processing
A Fault business object is a child of a TLO and is optional for synchronous request
processing. The object-level ASI for a Fault business object for synchronous request
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processing is described in

Table 18. Synchronous request processing: object-level ASI for Fault business objects

Object-level ASI Description

cw_mo_soap=SOAPCfgMO The value of this AST must match the name of the
attribute that corresponds to the SOAP Protocol
Config MO. This is the SOAP Config MO that
defines the data handler transformation for the
Fault business object. For further information, see
[‘'SOAP Config MO” on page 24/

cw_mo_http=SOAPHTTPCfgMO The value of this AST must match the name of the
attribute that corresponds to the Protocol Config
MO. This is the Protocol Config MO, optional for
a Fault business object, that specifies the headers
in the response SOAP message for the protocol
handler. For further information, see

[Config MO” on page 24

SOAP Config MO

The SOAP Config MO (SOAPCfgMO) has the same attributes as those for the
event processing SOAP Config MO. For further information, see[’SOAP Config]
IMO” on page 24 hs well as[“SOAP configuration meta-object: child of every SOAN
business object” on page 75)

HTTP Protocol Config MO for request processing

During request processing, the SOAP/HTTP-HTTPS protocol handlers use the
HTTP Protocol Config MO to determine the destination of the target SAP XI
service. This Protocol Config MO is required for a Request business object. The
SOAP/HTTP-HTTPS protocol handlers support HTTP 1.0 POST request only. As
shown in the sole required attribute (Destination) is the full URL of the
target web service. The optional authorization attributes are described in the
sections below.

Table 19. HTTP Protocol Config MO Attributes for Request Processing

Attribute

Required Type Description

Destination

Yes String The destination URL of the target SAP XI
service. The SOAP/HTTP-HTTPS protocol
handler uses this attribute to determine the
destination of the SAP XI service.

Content-Type

Required for String The value of this attribute defines the

the Request Content-Type header of the outgoing message
business object, (which includes message ContentType and
otherwise optionally charset for the outgoing message).
optional. The syntax is the same as that for the

Content-Type header in the HTTP Protocol, for
example: text/html; charset=1S0-8859-4. If
there is no Content-Type attribute defined, the
connector uses text/xml as the ContentType of
the message.

Authorization_UserID

No String This attribute corresponds to the userID of the
HTTP basic authentication. For further
information, see[“HTTP credential propagation|
[for request processing” on page 39
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Table 19. HTTP Protocol Config MO Attributes for Request Processing (continued)

Attribute

Required Type Description

Authorization_Password

No String This attribute corresponds to the password of
the HTTP basic authentication. For further
information, see[“HTTP credential propagation|
[for request processing” on page 39

One or more HTTP headers | No String This attribute allows the handler to pass or
retrieve the value for the specified HTTP
header.

UserDefinedProperties No Business object This attribute holds the user-defined protocol

properties business object. For further
information, see [“User-defined properties for]
[request processing.”]

MessageTransformationMap | No Single cardinality This is the attribute that points to business

business object object holding 0 or more message
transformation rules. The rules hold
information regarding the mime type and
charset to apply to the incoming message that
is specified in the rule. For further information,
see [‘Message transformation maps” on page 38/

shows some of the HTTP Protocol Config MO attributes in Business
Object Designer.
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Figure 13. HTTP Protocol Config MO attributes for request processing

The HTTP Protocol Config MO attributes are described in:
* [“User-defined properties for request processing”|

+ |“Message transformation maps” on page 38|
* ["HTTP credential propagation for request processing” on page 39|

User-defined properties for request processing: You can optionally specify
custom properties in the HTTP Protocol Config MO. You do so by including the
UserDefinedProperties attribute. This attribute corresponds to a business object that
has one or more child attributes with property values. Every attribute in this
business object must define a single property to be read (or, for synchronous
responses, written) in the variable portion of the message header as follows:
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* The type of the attribute should always be String regardless of the protocol
property type. The application-specific information of the attribute can contain
two name-value pairs defining the name and format of the protocol message
property to which the attribute maps.

able 20summarizes the application-specific information for these attributes.

Table 20. Application-specific information for user-defined protocol property attributes:
name=value pair content

Name Value Description
WSs_prop_name Any valid protocol property | This is the name of the
(case-insensitive; if not name protocol property. Some
specified the attribute name vendors reserve certain
will be used as the property properties to provide
name extended functionality.
ws_prop_type String The type of the protocol
property.

If the given custom property ASI (either the ws_prop_name or ws_prop_type) is
invalid and there is no logical way to process this header (such as ignoring the
property type for HTTP processing), the connector logs a warning and ignores this
property. If the value of the custom property can neither be set nor retrieved after
the necessary check against ws_prop_name or ws_prop_type has been performed,
the connector logs the error and fails the event.

If the UserDefinedProperties attribute is specified and its business object is
instantiated, the connector processes each attribute of this child business object and
sets the message properties values accordingly.

For synchronous request processing, upon receipt of a response message from the
web service/url, if the UserDefinedProperties attribute is specified, the connector
creates an instance of a UserDefinedProperties business object and attempts to
extract property values from the message and then stores them in the new business
object. If at least one property value was successfully retrieved, the connector will
set modified UserDefinedProperties business object in the Protocol Config MO.

Message transformation maps: The Message Transformation Map (MTM) feature
is supported for request processing HTTP(S) protocol handlers only.
MessageTransformationMap is an optional attribute in the Protocol Config MO that
points to a business object. The business object contains rules for transforming
messages with mime types and charsets that are specified in the rules. If it finds
the (case-sensitive) attribute name MessageTransformationMap and this attribute is
of the business object type (see , the connector uses the rules in that
object to transform a message.

As shown i the MTM attribute must have one cardinality N child
business object attribute that is named TransformationRule. When trying to find
TransformationRule for a message, the SOAP/HTTP(s) Protocol Handler first
attempts to match the message exactly by the ContentType specified in all
TransFormationRules. If unsuccessful, the connector attempts to find the rule that
applies to multiple types of messages. For further information on protocol handler
processing, see ['HTTP-HTTPS protocol handler processing” on page 55)

Each instance of a TransformationRule business object must have attributes

specified as shown in [Table 21

38 Adapter for SAP XI User Guide



Table 21. TransformationRule attributes for Message TransformationMaps in HTTP Protocol Config MO

Attribute name

Required

Default value Description

Type

TransformationRule

No Business object,

This is the attribute that holds 1
rule for message transformation.
There can be 0 or more instances of
this attribute under the
MessageTranformationMap
attribute.

cardinality N

+ContentType

Yes String * /%

The value of this property specifies
the HTTP ContentType of the
message for which this
transformation rule applies. The
default value */* for this attribute
enables the connector to apply this
rule to any ContentType. For
further information on protocol
handler processing, see
"HTTP-HTTPS protocol handler]|
rocessing” on page 55Note that if
Protocol Handler finds more than
one rule that has the same
ContentType as the other rule,
Protocol Handler will log the
warning and ignore all duplicate
rules, but will use unique rules

+MimeType

No The mime type to use when calling

a data handler while processing
messages of the ContentType
specified in this business object.

+Charset

No The charset to use when

transforming a request of the
ContentType specified in this
business object.

HTTP credential propagation for request processing: For the purpose of
credential propagation, the connector supports the Authorization_UserID and
Authorization_Password attributes in the HTTP Protocol Config MO. The support
is limited to the propagation of these credentials as part of the HTTP Basic
authentication scheme.

If credential propagation is desired during request processing, you must manually
add the Authorization_UserID and Authorization_Password attributes to the
Protocol Config MO generated by the SAP XI ODA. You do this in Business Object
Designer after generating the business object and meta-object definitions. (For
further information on the SAP XI ODA, see|Chapter 6, “Enabling collaborations|
ffor request processing,” on page 107.)

The collaboration sets the values of the Authorization_UserID and
Authorization_Password attributes in the Protocol Config MO. If these attributes
are neither null nor empty, the connector creates an authorization header on the
request its sends to the to the target web service. The SOAP HTTP/HTTPS
protocol handler follows HTTP Authentication: Basic and Digest Access Authentication
(RFC 2617) when creating the authorization header.

Note: The digest authentication scheme is not be supported, nor is the optional
challenge-response mechanism for HTTP authentication defined in Rfc2617.
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If the HTTP(s) protocol handler is invoking a server that requires a
credential, the connector does not wait for the challenge response from the
server. Instead, it sends the credentials continuously.

Asynchronous request processing TLOs

shows the business object hierarchy for asynchronous request processing.
A request object only is required, and this object contains a SOAP Config MO for
the SOAP data handler and a Protocol Config MO for the SOAP/HTTP-HTTPS
protocol handler. These are described in the sections below.

[ SAP XI TLO ]

I_[ Request BO required ]
_[ SOAP Config MO ]

—[ HTTP Protocol Config MO}

—[ Header container optional ]

—[ Header BO ]
—[ Header BO ]

Figure 14. Business object hierarchy for asynchronous request processing

The TLO contains object-level ASI as well as attributes with attribute-level ASI.
Both kinds of ASI are discussed below. For information on the header container
and header child business objects, see ["Header container business objects” on page|

Object-level ASI for asynchronous event processing TLOs
shows CLIENT_ASYNCH_Order_TLO, a sample TLO for asynchronous
request processing.

&l Business Object Designer - CLIENT _ASYNCH_TLO_Order:-WebServicesSample
File Edit Yiew Tools Window Help

[pas@x(s=als ¢|a]a |

=i CLIENT_ASYMNCH_TLO_Order:WebServicesSample

General I Aftributes I

Business Object Level Application-specific information:

|ws_m0de=asynch:

Supported Yerbs:

Marme T Application-specific information

Create
Delete
Retrigve
Update

=] @ ] =

Figure 15. Top-level business object for asynchronous request processing

below describes the object-level ASI for an asynchronous request
processing TLO.
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Table 22. Asynchronous request processing TLO object ASI

Object-level ASI

Description

ws_mode=asynch

During request processing, the connector uses this

ASI property to determine whether to invoke the
collaboration synchronously (synch) or
asynchronously (asynch). For asynchronous request
processing, this ASI must be set to asynch.

The default is asynch.

Attribute-level ASI for asynchronous request processing TLOs

shows the attributes of the CLIENT_ASYNCH_TLO_Order, a sample
request processing TLO.

&l Business Dbject Designer - CLIENT_ASYNCH_TLO_Order:WebServicesSample

File Edit “ew Tools Window Help

Jpes@x|inals ||z

= CLIENT_ASYMNCH_TLO_Drder:WebServicesSample

General l Adtributes I

Recui Mac<imum
Poz Mame Type Key redl Card Lenath Default App Spec Info
1T | Handler String I~ I~ 255 soapittp
2 |2 MimeType String I I 255 wmlizoap
3 |3 |BoOPrefix String r 255
P 4 H Reguest ?dL;ENT—ASYNCH—O I I 1 ws_hotypesreguest
5 |5  |ObjectEventid String

Figure 16. TLO attributes for asynchronous request processing

summarizes the attribute-level ASI for the request attribute of an
asynchronous request processing TLO.

Table 23. Asynchronous request processing TLO attributes
TLO attribute | Attribute-level ASI

Description

MimeType None

This attribute specifies the mime
type of the data handler that the
connector invokes. Note that this
attribute is used only for Request
Processing. (For event processing,
protocol listeners use the
SOAPDHMimeType
connector-specific configuration
property.) The default is xm1/soap.

BOPrefix None This attribute of type String is

reserved for future development and
not required.

Handler None This attribute specifies the protocol

handler to use to process the web
service request and is for request
processing only. It takes one of the
following value:soap/http. The
connector uses the
SOAP/HTTP-HTTPS protocol
handler to process this request. The
default is soap/http
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Table 23. Asynchronous request processing TLO attributes (continued)
TLO attribute | Attribute-level ASI Description

Request ws_botype=request This attribute corresponds to a
request business object. The
connector uses this attribute ASI to
determine whether this TLO
attribute is of type SOAP Request
BO. This ASI, not the attribute
name, determines the attribute type.
If there is more than one request
attribute, the connector uses the ASI
of the first one.

Request business object for asynchronous request processing
A Request business object is a child of a TLO and is required for asynchronous

request processing. The object-level ASI for a Request business object for
asynchronous request processing is described inIable 24

Table 24. Asynchronous request processing: object-level ASI for Request business objects
Object-level ASI Description

cw_mo_soap=SOAPCfgMO The value of this ASI must match the name of the
attribute that corresponds to the SOAP Config
MO. This is the SOAP Config MO that defines the
data handler transformation for the Request
business object. For further information, see
[“'SOAP Config MO” on page 24

cw_mo_http=SOAPHTTPCfgMO The value of this ASI must match the name of the
attribute that corresponds to the Protocol Config
MO. This is a separate Protocol Config MO that
specifies the destination for the
SOAP/HTTP-HTTPS protocol handler. This ASI is
used by the SOAP/HTTP-HTTPS Protocol
Handler. For further information, see |”HTTP|
Protocol Confie MO for request processing” onl|
page 36.|

SOAPAction=SOAPActionURI The connector uses this ASI to determine whether
to set a SOAPAction header on the request
message. Specify this ASI only if the target web
service requires a SOAPAction header. Note that
this ASI is used for request processing but not for
event notification.

The requirements and characteristics of the SOAP Config MO, Protocol Config MO,
SOAP header container, and header child business objects are the same for
asynchronous request processing as they are for synchronous request processing.
For further information, see these topics above in [“Synchronous request processing|
[TLOs” on page 30.}

Config MOs for asynchronous request processing

The SOAP Config MO (SOAPCfgMO) has the same attributes as those for the
event processing SOAP Config MO. For further information, seel”SOAP Conﬁa
IMO” on page 24)as well as [‘SOAP configuration meta-object: child of every SOAP|
business object” on page 75/
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During request processing, the SOAP/HTTP-HTTPS protocol handlers use the
HTTP Protocol Config MO to determine the destination of the target SAP IX
service. This Protocol Config MO is required for a Request business object. For
further information, see ["HTTP Protocol Config MO for request processing” on|

Developing business objects

You use the SAP XI ODA and BIA_XIWSDLUil tools and Business Object Designer
to create business objects. You use Connector Configurator to configure the
connector to support them. For more information on the Business Object Designer
tool, see the Business Object Development Guide and [Chapter 7, “Exposing|
kollaborations as web services,” on page 109 For further information on Connector
Configurator, see |[Appendix B, “Connector Configurator,” on page 149]
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Chapter 4. SAP Xl connector

“Connector processing’|
e |"HTTP(S) services” on page 47
* |“Event processing” on page 48

* [“Request processing” on page 54|
* |“SSL” on page 59
» [“Configuring the connector” on page 61]

+ [“Connector at startup” on page 69

* |"Logging” on page 70|
* [“Tracing” on page 70|

This chapter describes the SAP XI connector and how to configure it.

All WebSphere business integration connectors operate with an integration broker.
The SAP XI connector operates with the IBM WebSphere InterChange Server
integration broker, which is described in the Technical Introduction to IBM WebSphere
InterChange Server.

A connector is a runtime component of an adapter. Connectors consist of an
application-specific component and the connector framework. The
application-specific component contains code tailored to a particular application.
The connector framework, whose code is common to all connectors, acts as an
intermediary between the integration broker and the application-specific
component. The connector framework provides the following services between the
integration broker and the application-specific component:

* Receives and sends business objects
* Manages the exchange of startup and administrative messages

This document contains information about the application-specific component and
connector framework. It refers to both of these components as the connector.

For more information about the relationship of the integration broker to the
connector, see the System Administration Guide.

Connector processing

The connector includes a protocol listener framework for event processing and a
protocol handler framework for request processing. This bi-directional functionality
enables the connector framework to:

* Process calls from SAP XI clients (event processing)

* Process a request by a collaboration that invokes an SAP XI service (request
processing)

Event processing overview

Connector event processing (or event notification) is used to handle a request from
an SAP XI SOAP adapter acting as a client. This event processing capability
encompasses a protocol listener framework, including the following components,
which are discussed in greater detail later in this chapter:

* HTTP protocol listener
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e HTTPS protocol listener

The connector uses these components to listen on the transport for calls from
clients to collaborations.

When requests from clients arrive, the listener converts the request message into a
business object and invokes the collaboration. If it is a synchronous request, the
connector receives a response business object of the same type as the request
business object. The listener converts the response business object into a response
message. The listener then transports the response message to the client. Note that
event sequencing is not a requirement for this connector; the connector may deliver
the events in any order.

The HTTP connector utilizes the configured data handler to convert incoming
request messages into business objects. To aid the data handler in determining
which business object to resolve for the incoming request message, the connector
provides meta information regarding its supported business objects to the data
handler. From its supported business objects, the connector first makes a list of all
business objects that are potential candidates for the conversion. This list is
comprised of supported TLOs only. Supported TLO business objects are those that
have object-level ASI ws_eventtlo=true.

The protocol listener reads the object-level ASI of the TLO as follows:
* ws_collab= This determines which collaboration to invoke

* ws_mode= This determines how to invoke the collaboration, synchronously
(synch) or asynchronously (asynch)

The connector inspects the request business object returned by the data handler. It
uses ws_tloname ASI of this business object to extract the name of the parent TLO.
This TLO will be instantiated and the request business object will be set in the
TLO. Finally, this constructed TLO will be used to invoke the collaboration.

For synchronous collaboration execution, the connector utilizes the data handler to
create a response or fault message to send back to the client. In this case, the
connector simply passes a business object (child of TLO) to the data handler. The
data handler returns a message based on the business object that it is passed to it.

Request processing overview

On behalf of a collaboration, the connector can invoke SAP XI web services over
HTTP(S). This request processing functionality is supported by a protocol handler
framework. The protocol handler framework is a configurable run-time module
that consists of the HTTP-HTTPS protocol handler, which is discussed in detail
later in this chapter.

Upon receipt of a collaboration request business object, which is always set in a
TLO, the protocol handler framework loads the protocol handler. The protocol
handler manages transport-level details required for invoking the SAP XI service
and (optionally) securing a response, performing three main tasks: converting a
collaboration request business object into a request message, invoking the SAP XI
service with the request message, and, if in request/response (synchronous) mode,
converting the response message into a business object and returning that object to
the collaboration.

The SAP XI connector is always called from a collaboration using TLOs. The
connector determines the request business object from the TLO, and invokes the
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data handler with this business object. The data handler returns a request message
which is sent on by the connector to the SAP XI service.

For synchronous execution, the connector utilizes the data handler to convert
response and fault messages into response and fault business objects. To aid the
data handler in determining which business object to resolve for these
response/faults to business object conversions, the connector provides the data
handler with specific meta information. Specifically, the connector makes a list of
all response and fault business objects that are children of the invoking TLO. There
should be only one response business object and, optionally, many fault business
objects. There may also be one and only one defaultfault business object. For the
defaultfault business object, the connector simply notifies the data handler of the
name of the defaultfault business object. The defaultfault business object should be
resolved by the data handler as a last resort if no other fault business objects are
resolved for this transformation.

HTTP(S) services

SAP XI services support the HTTP transport protocol. HTTP embodies a
client-server model in which an HTTP client opens a connection and sends a
request message to an SAP XI server. The client request message is to invoke an
SAP XI service. The SAP XI server dispatches the message containing the
invocation and closes the connection.

The connector’s HTTP and HTTPS protocol listeners make use of the HTTP
client-server and the Request/Response models when handling client requests to a
collaboration. However, the HTTP listener is not intended to function as an HTTP
server— proxy, intermediary, or otherwise. Rather the HTTP listener functions as
an endpoint for use within an enterprise and behind a firewall. Accordingly, a
separate web server or gateway must be deployed in the firewall to route client
requests to the listener. For further information, see [Chapter 1, “Overview of the]
ladapter,” on page 1)

Synchronous HTTP(S) service

From the perspective of connector processing, a synchronous HTTP service is one
that follows a Request/Response path. If the HTTP or HTTPS protocol listener
successfully processes an HTTP request message, the body will contain the
response and an HTTP status code of 200 OK. If a fault is returned, then the body
contains the fault message and a status code of 500.

Asynchronous HTTP(S) service

From the perspective of connector processing, an asynchronous HTTP service is
one that follows a request-only path. If the HTTP or HTTPS protocol listener
successfully receives and processes a request-only operation, an HTTP status code
of 202 Accepted is generated. You can also configure the connector to generate an
HTTP status code of 200 0K —for further information see the
HTTPAsyncResponseCode property i If a fault occurs, an HTTP status
code of 500 is generated. There is no response, although a fault body may be
returned.
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Event processing

During event processing, the connector uses protocol listeners and the configured
data handler(s) to convert request messages from SAP XI service clients to business
objects that can be manipulated by collaborations. Protocol listeners play a crucial
role in event processing.

Protocol listeners

SAP XI requests may come over HTTP or HTTPS transports. The listener monitors
the arrival of such requests on its transport channel. There are two protocol
listeners and corresponding channels:

* HTTP protocol listener
* HTTPS protocol listener

Each of these consists of a thread that listens on its transport. When it receives a
request message from a client, the listener registers the event with the protocol
listener framework.

The protocol listener framework manages the protocol listeners, scheduling
requests as resources are available. You configure the listeners and aspects of the
protocol listener framework when you set values to connector-specific properties.
Among the protocol listener framework properties you can configure are the
following:

*  WorkerThreadCount Total number of threads available to the protocol listener
framework, which is the number of requests that it can process in parallel.

* RequestPoolSize Maximum number of requests that can be registered with the
protocol listener framework. If it receives more than this maximum requests, it
will no longer register new requests.

These two connector-specific properties control memory allocation in a way that
prevents protocol listeners from clogging the connector with infinite events. The
allocation algorithm is as follows: At any time, the connector can receive a total
number of events equal to WorkerThreadCount + RequestPoolSize. It can process
WorkerThreadCount number of requests in parallel.

You can plug additional protocol listeners into the protocol listener framework. For
further information, see [‘Creating multiple protocol listeners” on page 69|
and|’Connector-specific configuration properties” on page 61

HTTP and HTTPS protocol listener processing

The HTTP(S) protocol listener consists of a thread that continuously listens for
HTTP(S) requests from clients. The listener thread binds the host and port that are
specified in the Host and Port connector-specific configuration (listener) properties.
Another configuration property—RequestWaitTimeout—defines the interval during
which the listener waits for a request before checking whether the connector has
shut down.

illustrates HTTP protocol listener processing for a synchronous operation.
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Connector HTTP or HTTPS

Request
| SOAP/HTTP _
protocol 200 OK ( ) R
listener [ >
SOAP data Response
handler %

(single connection)

Figure 17. HTTP protocol listener: synchronous event processing

shows HTTP protocol listener processing for an asynchronous operation.

Connector HTTP or HTTPS
Request
| SOAP/HTTP o
p_rotocol 202 Accepted .
listener i’
SOAP data
handler

(single connection)

Figure 18. HTTP protocol listener: asynchronous event processing

When a client initiates a HTTP or HTTPS request, it posts a request message to the
HTTP or HTTPS listener. The client should use the HTTP POST method to invoke
the protocol listener URL.

When an HTTP(S) request arrives, the listener registers the request with the
protocol listener framework, which schedules the event for processing as resources
become available. The listener then extracts the protocol headers and the payload
from the request.

summarizes the order of precedence of rules used by the listener to
determine the Charset, MmeType, ContentType and Content-Type header for
inbound messages.

Table 25. HTTP(s) protocol listener processing rules for inbound message

Order of Charset MimeType ContentType Content-Type header
Precedence
1 Charset parameter URLsConfiguration Incoming HTTP Incoming HTTP
value from the connector property message type/subtype | message Content-Type
incoming HTTP value for this listener |value from the header
message Content-Type Content-Type header
header value value
2 URLsConfiguration
property value for this
listener
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Table 25. HTTP(s) protocol listener processing rules for inbound message (continued)

3 If the type of the Default to
request message ContentType
ContentType is text
with any subtype (for
example, text/xml,
text/plain, etc.),
default to ISO-8859-1.
Otherwise, charset
will not be used.

As shown [Table 25 on page 49

* The protocol listener determines the Charset of the inbound message according
to the following rules:

1. The listener attempts to extract the Charset from the charset parameter of
HTTP message Content-Type header value.

2. If no Charset value is obtained from the Content-Type header, then the
protocol listener attempts to read the URLsConfiguration property value for
this listener.

3. If a Charset value is not obtained using methods described in the previous
steps, and if type of the message ContentType is text with any subtype (for
example, text/xml, text/plain, etc.), the listener uses a default Charset value
of ISO-8859-1. Otherwise, Charset value is not used.

* The listener determines the MimeType for the response message according to
these rules:

1. if you have configured the TransformationRules for the URL used by the
incoming request message, and if the request ContentType matches the
ContentType of a TransformationRule, then the listener uses the
TransformationRule to extract the MimeType for conversion of the request
message into a request business object. The listener attempts to find the exact
TransformationRule match based on the ContentType value (for example,
text/soap) in the URLsConfiguration property for the requested URL.

2. If that fails, the listener attempts to find a TransformationRule that applies to
more than one ContentType under the request URL (for example */*).

3. If all previous steps fail to determine the MimeType, the value of
ContentType will be used as the MimeType to invoke the data handler and
convert the request message into a request business object.

* The listener determines the ContentType by extracting type/subtype from the
incoming HTTP message Content-Type header.

* The listener determines the Content-Type header from that of the incoming
HTTP message Content-Type header

If the collaboration is invoked asynchronously, the listener delivers the request
business object to the integration broker and responds to the client with the HTTP
status code 202 Accepted. This concludes listener processing.

If it is a synchronous invocation, the listener invokes the collaboration
synchronously. The collaboration responds with a response business object.

summarizes the order of precedence for rules used by the listener when
determining the Charset, MimeType, ContentType, and Content-Type header for
response messages.
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Table 26. HTTP(s) protocol listener processing rules for outbound synchronous response message

Order of Charset MimeType ContentType Content-Type header
Precedence
1 Protocol ConfigMO MimeType property in | Protocol ConfigMO Protocol ConfigMO
Content-Type Header |the TLO Content-Type header |Content-Type header
2 The Charset property | The request message |Request message Construct
value in the TLO MimeType, but only if | ContentType Content-Type Header
the request and using ContentType
response ContentType and Charset
match.
3 The request message | Use ContentType
Charset, but only if value as the
the request and MimeType
response ContentType
match.
4 If the ContentType is

text/*, default to
ISO-8859-1. Otherwise,
charset will not be

used.

As shown in

* The listener determines the Charset for the response message according to these
rules:

1.

2.

If Charset is specified in the response business object Protocol Config MO, its
value is used.

If there is no Charset value specified in the response business object Protocol
Config MO header, the listener checks if Charset is specified in the TLO.

If there is no Charset specified in the TLO, then if the response has the same
ContentType as the request, the Charset of the request will be used for the
response.

If the previous steps fail to determine the response Charset value, and if the

type portion of the message ContentType is text with a subtype of anything
(for example, text/soap, text/plain, etc.), the listener uses a default Charset
value of ISO-8859-1. Otherwise, the Charset value is not used.

* The listener determines the MimeType for the response message according to
these rules:

1.
2.

3.

The TLO’s MimeType attribute

If the TLO MimeType attribute is missing, and if the request and response
ContentType match, the listener uses the request MimeType for the response
message.

Otherwise the listener uses the ContentType value as the MimeType.

* The listener determines the ContentType for the response message according to
these rules:

1.

If the Content-Type header is specified in the response business object
Protocol Config MO, the type/subtype portion of the Content-Type header
will used as the ContentType.

If the Content-Type header is not specified in the response business object
Protocol Config MO, the listener constructs a Content-Type header using the
determined ContentType and Charset (if the Charset was determined for the
response message).
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The listener processes the HTTP Protocol Config MO. It is the responsibility of
collaboration to ensure that the header values passed in the HTTP Protocol Config
MO are correct in the context of the request-response event. The listener populates
standard headers and custom properties according to the following rules:

1. The listener will investigate each item of the HTTP Protocol Config MO in
order to ignore special attributes (such as ObjectEventld).

2. Each non-empty header will be put on the outgoing message and additional
processing (for example, the Content-Type header) may take place.

3. Please note that with the above approach, the listener may set non-standard
headers on the message, but will not check that the message is logically or
semantically correct.

4. If there are one or more custom properties in the HTTP Protocol Config MO
UserDefinedProperties attribute, the listener will add them in the Entity
Headers Section (the last headers section). For more on custom properties, see
[“User-defined properties for event processing” on page 25.|

Note: Specifying any of the following headers in the HTTP Protocol Config MO is
very likely to result in an incorrect HTTP message: Connection, Trailer,
Transfer-Encoding, Content-Encoding, Content-Length, Content-MD5,
Content-Range.

The listener then invokes the data handler to convert the response business object
returned by the collaboration into a response message.

The listener delivers the response message to the client and includes a 200 0K
HTTP status code. If the collaboration returns a fault business object, it is
converted to a fault message. This fault message is delivered to the client with a
500 Internal Server Error HTTP code.

The listener then closes the connection and the thread that processed the event
becomes available.

Unsupported HTTP protocol listener processing features
The HTTP protocol listener does not support the following;:

* Caching: The protocol listener does not perform any caching functions as
defined in HTTP specifications (RFC2616)

* Proxy: The protocol listener does not perform any proxy functions as defined in
HTTP specifications (RFC2616).

* Persistent Connection: The protocol listener does not support persistent
connections as defined in HTTP specifications (RFC2616). Instead, the protocol
listener assumes that the scope of each HTTP connection is a single client
request. and closes the connection when the service request is completed. The
protocol listener does not attempt to reuse the connection across the service
invocations.

* Redirections: The protocol listener does not support redirections.

* Large file transfer: The protocol listener cannot be used for large file transfers.
Alternatively, you may consider passing large files by reference instead.

* State management: The protocol listener does not support the HTTP state
management mechanism described by RFC2965.

* Cookies: The protocol listener does not support cookies.
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HTTPS listener processing using secure sockets

HTTPS protocol listener processing is the same as that described in the HTTP
protocol listener processing section except that HTTPS uses secure sockets. For
further information, see [’SSL” on page 59

Event persistence and delivery
Event persistence is protocol contingent:
e HTTP protocol listener no persistence and therefore no guaranteed delivery

¢ HTTPS protocol listener no persistence and therefore no guaranteed delivery

Event sequencing

The connector may deliver events in any sequence.

Event triggering

The event triggering mechanism depends on how the protocol listener is
configured.

* HTTP protocol listener Listening occurs over a ServerSocket for HTTP
connection requests

* HTTPS protocol listener Listening occurs over a secure ServerSocket layer for
HTTPS connection requests

Note: The connector does not distinguish between Create or Update or Retrieve or
Delete. All such events follow the same approach.

Event detection

Event detection is performed by each protocol listener. The event detection
mechanism depends utterly on the transport and how you configure the
connector-specific properties for each listener. For more on these properties, see
[“Connector-specific configuration properties” on page 61

Event status

Event status is managed by the protocol listener and depends on the transport and
also on how you configure the listener.

* HTTP protocol listener HTTP is inherently non-persistent and synchronous in
nature. Accordingly, event status is not maintained.

* HTTPS protocol listener HTTP is inherently non-persistent and synchronous in
nature. Accordingly, event status is not maintained.

Event retrieval

Event retrieval is managed by the protocol listener and depends on the transport
and also on how you configure the listener.

* HTTP protocol listener Events are retrieved by extracting HTTP requests from
the socket.

* HTTPS protocol listener Events are retrieved by extracting HTTP requests from
the socket.

Event archiving

Event archiving is managed by the protocol listener and depends on the transport
and also on how you configure the listener.
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* HTTP protocol listener Because of the non-persistent and synchronous nature of
the transport, archiving is not performed.

* HTTPS protocol listener Because of the non-persistent and synchronous nature
of the transport, archiving is not performed.

Event recovery

Event recovery is managed by the protocol listener and depends on the transport
and also on how you configure the listener.

e HTTP protocol listener Because of the non-persistent nature of the transport,
event recovery is not performed.

¢ HTTPS protocol listener Because of the non-persistent nature of the transport,
event recovery is not performed.

Request processing

You use the request processing capability of the connector to enable a collaboration
to invoke an HTTP service. You must configure the connector and its request
processing components: the protocol handler framework and protocol handlers.

At run time, the connector receives requests from the collaboration in the form of
business objects. The business objects— request, and optionally response and fault
business objects— are contained by the TLO issued by a collaboration that is
configured to use SAP XI services. The TLO and its child business objects contain
attributes and ASI that specify the processing mode (synchronous or
asynchronous), the data handler mime type, which protocol handler to use, as well
as the address of the target. The protocol handler uses this information to invoke
an instance of the data handler, convert the request business object to a request
message, and invoke the target SAP XI service. If the mode is synchronous, the
protocol handler again invokes the data handler to convert the response message
into a response business object and returns this to the collaboration.

In response to a request message, the connector can receive any of the following
from the remote trading partner:

* A response message that contains data
* A response message that contains fault information

Protocol handlers play a key role in request processing.

Protocol handling

A collaboration can invoke an SAP XI service over HTTP or HTTPS transports. The
connector has one protocol handler and corresponding channel: an HTTP-HTTPS
protocol handler for invoking HTTP and HTTPS services

The protocol handler framework manages the protocol handler, loading it at
startup time. When the connector receives a request business object, the request
thread (note that each collaboration request comes in a thread of its own) invokes
the protocol handler framework to process the request.

The protocol handler framework reads the TLOs Handler attribute ASI to
determine which protocol handler to use. Applying a series of rules (see
[“HTTP-HTTPS protocol handler processing” on page 55), the protocol handler
invokes a data handler to convert the request business object into a request
message. The protocol handler packages the request message into the
transport—HTTP(S)— message.
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The protocol handler then reads the Destination attribute of the request business
object Protocol Config MO to determine the target address. The protocol handler
then invokes the target SAP XI service with the request message.

Reading the ws_mode TLO ASI, the protocol handler determines whether the
processing mode is synchronous or asynchronous. If this ASI is set to asynch, the
protocol handler processing is completed. Otherwise the protocol handler waits for
a response message. If a response message arrives, the protocol handler extracts
the protocol headers and the payload. It then invokes the data handler (indicated
by the MimeType TLO attribute) to convert the message into a response or fault
business object. Again using the Protocol Config MO, the protocol handler sets the
protocol headers in the business object. The protocol handler then returns the
response or fault business object to the collaboration.

Depending on connector configuration, there may be one or more protocol
handlers plugged into the connector. Connector-specific properties allow you to
configure protocol handlers.

HTTP-HTTPS protocol handler processing

The HTTP-HTTPS protocol handler performs as described in [“Protocol handling”|
with exceptions noted in this section. [Figure 19| shows the
HTTP-HTTPS protocol handler for a synchronous operation.

SOAP data

Connector HTTP or HTTPS
Request
| SOAP/HTTP >
protocol ) /9/
handler 200 OK U/ |
4 Response

(single connection)

Figure 19. HTTP-HTTPS protocol handler: synchronous request processing

shows the HTTP-HTTPS protocol handler for an asynchronous request
process

Figure 20. HTTP-HTTPS protocol handler: asynchronous request processing

Connector
Request
| SOAP/HTTP g
S HTTP or HTTPS /8/////
handler 202 Accepted
SOAP data
handler
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Note: This section describes HTTP protocol handling only.

The HTTP-HTTPS protocol handler uses the object-level ASI (cw_mo_http) of the
request business object to determine the Protocol Config MO. The HTTP-HTTPS
protocol handler determines the URL of the target SAP XI service by reading the
Destination attribute in the HTTP Protocol Config MO. If the URL is missing or is
incomplete, the protocol handler fails the service call. For further information on
the HTTP Protocol Config MO and its attributes, see ["HTTP Protocol Config MO

lfor request processing” on page 36.|

The HTTP-HTTPS protocol handler invokes the SAP XI service using the request
message returned by the data handler. If HTTP Proxy connector configuration
properties are specified, the HTTP-HTTPS protocol handler behaves accordingly. If
a response is returned, the HTTP-HTTPS protocol handler reads it.

summarizes the order of precedence of rules used by the HTTP-HTTPS
protocol handler to determine the Charset, MimeType, ContentType, and
Content-Type header for outgoing request messages.

Table 27. HTTP-HTTPS protocol handler processing rules for outbound messages

Order of Charset MimeType ContentType Content-Type header
Precedence
1 Protocol Config MO’s | MimeType property in | Protocol Config MO’s | Protocol Config MO'’s
Content-Type Header TLO attribute Content-Type Header Content-Type Header
2 Charset property in Default to ContentType
TLO attribute
3 If the ContentType is

text/*, default to
1SO-8859-1. Otherwise,
charset will not be
used.

As shown in [Table 27|
e The HTTP-HTTPS protocol handler determines the Charset for the response
message according to these rules:

1. If specified in the request business object Protocol Config MO headers, the
Charset value is used.

2. If Charset is not determined by the previous step, the protocol handler
attempts to extract the Charset from the TLO attribute.

3. If the operation described in the previous step is unsuccessful, the table is
used to determine the Charset:

Table 28. Default request processing Charsets

ContentType Default Charset
text/* 1SO-8859-1
For further information, see RFC2616,
application/* No default
All others No default

4. If Charset was determined by the previous step, the Charset is set on the
data handler.

5. The data Handler is invoked with Stream or Byte array APIs, depending on
the data structure needed for writing out the request.
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e The HTTP-HTTPS protocol handler determines the MimeType for the request
according to these rules:
1. The TLO MimeType attribute.
2. If the TLO MimeType attribute is missing, the protocol handler uses the
ContentType to determine the MimeType.
¢ The HTTP-HTTPS protocol handler determines the ContentType for the request
message according to these rules:
— If the Content-Type header is specified in the request business object Protocol
Config MO, the type/subtype of the header will be used as ContentType.
* The HTTP-HTTPS protocol handler determines the Content-Type header for the
request message according to these rules:

— If the Content-Type header is specified in the request business object Protocol
Config MO, its value is set on the outgoing message.

summarizes the order of precedence for rules used by the handler when
determining the Charset, MimeType, ContentType, and Content-Type header for
response messages.

Table 29. HTTP(s) protocol handler processing rules for inbound synchronous response message

Order of Charset MimeType ContentType Content-Type header
Precedence
1 Charset parameter Message Incoming HTTP Incoming HTTP
value from the TransformationMap message type/subtype | message Content-Type
incoming HTTP child business object in | value from the header
message Content-Type |the Request business Content-Type header
header value object’s Protocol Config |value
MO
2 Message The request message
TransformationMap MimeType, but only if
child business object in | the request and
the Request business response ContentType
object’s Protocol Config | match.
MO
3 The request message MimeType property in
Charset, but only if the | TLO
request and response
ContentType match.
4 Charset property in Default to ContentType
TLO.
5 If the Content-Type is
text/*, default to
ISO-8859-1. Otherwise,
Charset is not used.

As shown in [Table 29

¢ The protocol handler determines the Charset of the synchronous response
message according to the following rules:

1. If the Charset parameter is set in the Content-Type header of the incoming
response message, the protocol handler uses the Charset value to set on the
data handler.

2. If there is no Charset value in the response message header, then the protocol
handler attempts to read the collaboration-defined Charset from the TLO
request Protocol Config MO MessageTranformationMap.
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3. If there is no Charset value specified in the MessageTransformationMap for
the given request, then if the response has the same ContentType as the
request, the Charset of the request will be used for the response.

4. If the previous step fails to yield a Charset value, then the protocol handler
attempts to read the TLO Charset attribute.

5. If a Charset value is not obtained using methods described in the previous
steps, and if type of the message ContentType is text with any subtype (for
example, text/xml, text/plain, etc.),default ISO-8859-1. Otherwise, charset
value is not used.

* The protocol handler determines the MimeType of the synchronous response
message according to the following rules:

1. The protocol handler first attempts to extract the MimeType from the TLO
Request Protocol Config MO’s MessageTransformationMap. Specifically, the
protocol handler tries to find an exact ContentType match in the MTM to
extract MessageTransformationRule and then use the MimeType property
value from it. Otherwise, the protocol handler looks for a
MessageTransformationRule that applies to more than one ContentType
(ContentType is */%).

2. If the MimeType is not determined by using a MessageTransformationMap,
the protocol handler uses the request MimeType for that of the response if
and only if the request and response ContentTypes match.

3. If the MimeType cannot be extracted using the previous steps, the protocol
handler uses the MimeType attribute of the TLO.

4. If all previous steps fail, the protocol handler uses the ContentType to set the
MimeType.

* The handler determines the ContentType by extracting type/subtype from the
incoming HTTP message Content-Type header.

The handler processes the HTTP Protocol Config MO. It is the responsibility of the
collaboration to ensure that the header values passed in the HTTP Protocol Config
MO are correct in the context of the request-response event. The handler populates
standard headers and custom properties according to the following rules:

1. The handler will investigate each item of the HTTP Protocol Config MO in
order to ignore special attributes (such as ObjectEventld).

2. Each non-empty header will be put on the outgoing message and additional
processing (for example, the Content-Type header) may take place.

3. Please note that with the above approach, the handler may set non-standard
headers on the message, but will not guarantee that the message is logically or
semantically correct.

4. If there are one or more custom properties in the HTTP Protocol Config MO
UserDefinedProperties attribute, the handler will add them in the Entity
Headers Section (the last headers section). For more on custom properties, see
[“User-defined properties for request processing” on page 37|

Note: Specifying any of the following headers in the HTTP Protocol Config MO is
very likely to result in incorrect HTTP messages: Connection, Trailer,
Transfer-Encoding, Content-Encoding, Content-Length, Content-MD5,
Content-Range.
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SSL

JSSE

This section discusses the how the connector implements an SSL capability. For
background information, see your SSL documentation. This section assumes a
familiarity with SSL technology.

The connector uses JSSE to provide support for HTTPS and SSL. IBM JSSE is
shipped with the connector. To enable this capability, make sure you have the
following entry in the java.security file that is among the files installed with the
connector:

security.provider.5=com.ibm.jsse.IBMISSEProvider

Note that java.security is located in the $ProductDir\1ib\security directory of
your connector installation. The connector uses the value of the
JavaProtocolHandlerPackages connector property to set the system property
java.protocol.handler.pkgs. Note that for the IBM JSSE that is shipped with the
connector, the value of this property should be set to
com.ibm.net.ssl.internal.www.protocol.

The JavaProtocolHandlerPackages configuration property defaults to this
value.However, if you specify a different value for this system property, the
connector uses that value during initialization. If you have not specified a value for
java.protocol.handler.pkgs, the connector uses the default value during
initialization.

During initialization, the connector disables all anonymous cipher suites supported
by JSSE.

KeyStore and TrustStore

To use SSL with the connector, you must set up keystores and truststores. No tool
is provided to set up keystores, certificates, and key generation. You must use third
party software tools to complete these tasks.

SSL Properties

You can specify the following SSL connector-specific properties:

* SSLVersion

* SSLDebug

* KeyStore

* KeyStoreAlias

* KeyStorePassword

* TrustStore

* TrustStorePassword

Note that these properties apply to a connector instance. The same set of SSL
property values are used by all of the HTTPS protocol listeners plugged into the
connector and by the HTTP-HTTPS protocol handler for each connector instance.

For further information on HTTPS/SSL setup, see [Appendix D, “Configuring]
[HTTPS/SSL,” on page 167]
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SSL and the HTTPS protocol listener

To use the HTTPS protocol listener, you must specify SSL connector-specific
properties. The values you assign to these properties should reflect your SSL
requirements:

* SSLVersion Make sure that the SSLVersion you want to use is supported by
JSSE.

* KeyStore Because the HTTPS protocol listener acts as a server in SSL
communications, you must specify the keystore. The listener uses the keystore
specified in the SSL->KeyStore configuration property. The value of this property
must be the complete path to your keystore file. Make sure that the keystore has
key pair (private key and public key) for the connector. The alias of the private
key should be specified as the SSL->KeyStoreAlias property. You must specify
the password required to access the keystore as the SSL-> KeyStorePassword
property. Also make sure that the password required to access keystore and the
private key (in the keystore) are same. Finally, you must distribute the digital
certificate of the connector to your clients so that they can authenticate the
connector.

* TrustStore If you want the HTTPS protocol listener to authenticate clients, you
must activate client authentication. You do this by setting the SSL
->UseClientAuth property to true. You must also specify:

— the location of your truststore as the value of the SSL->TrustStore
configuration property

— the password required to access the truststore as the value of the SSL->
TrustStorePassword property

Make sure that your truststore contains the digital certificate of your clients.
Digital certificates used by your clients may be self-signed or issued by CA.
Note that if your truststore trusts the root certificate of the CA, JSSE will
authenticate all the digital certificates issued by that CA.

For further information on HTTPS/SSL setup, see[Appendix D, “Configuring]
[HTTPS/SSL,” on page 167.|

SSL and the HTTP-HTTPS protocol handler

If you are using SSL with the HTTP-HTTPS protocol handler, you must specify SSL
connector-specific properties. The values you assign to these properties should
reflect the HTTPS/SSL requirements of your HTTP provider:

* SSLVersion Make sure that the SSLVersion you want to use is supported by
your provider and by JSSE.

* TrustStore Because the HTTP-HTTPS protocol handler acts as a client in SSL
communications, you must set up a truststore. The handler uses the truststore
specified in the SSL -> Truststore configuration property. The value of this
property must be the complete path to your truststore file. You must specify the
password required to access the truststore in the SSL -> TrustStorePassword
property. Make sure that your truststore contains the digital certificate of your
provider. Digital certificates used by your provider may be self-signed or they
may be issued by CA. Note that if your truststore trusts the root certificate of
the CA, JSSE will authenticate all the digital certificates issued by that CA.

* KeyStore If your HTTP service provider requires client authentication, you must
set up a keystore. The HTTP-HTTPS protocol handler uses the keystore specified
in the SSL->KeyStore configuration property. This value must be the complete
path to your keystore file. Make sure that keystore has a key pair (private key
and public key) configured for the connector. The alias of the private key must
be specified in the SSL->KeyStoreAlias property. The password required to
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access the keystore must be specified in the SSL-> KeyStorePassword property.
Finally, make sure that the password required to access the keystore and the
private key (in the keystore) are the same. You must distribute the connector’s
digital certificate to your HTTP service provider for authentication.

For further information on HTTPS/SSL setup, see [Appendix D, “Configuring]
I[HTTPS/SSL,” on page 167/

Configuring the connector

After using the Installer to install the connector files to your system, you must set
the standard and application-specific connector configuration properties.

Setting configuration properties

Connectors have two types of configuration properties: standard configuration
properties and connector-specific configuration properties. You must set the values
of these properties using System Manager (SM) before running the connector.

Standard configuration properties

Standard configuration properties provide information that all connectors use. See
[Appendix A, “Standard configuration properties for connectors,” on page 131| for
documentation of these properties. The table below provides information specific
to this connector about configuration properties in the appendix.

Property Description
CharacterEncoding This connector does not use this property.
Locale Because this connector has not been internationalized, you

cannot change the value of this property. See release notes
for the connector to determine currently supported locales.

Because this connector supports only InterChange Server (ICS) as the integration
broker, the only configuration properties relevant to it are for ICS.

You must set at least the following standard connector configuration properties:
* AgentTraceLevel

* ApplicationName

* ControllerTraceLevel

* DeliveryTransport

Connector-specific configuration properties

Connector-specific configuration properties provide information needed by the
connector agent at runtime. Connector-specific properties also provide a way of
changing static information or logic within the connector agent without having to
recode and rebuild the agent.

able 3() lists the connector-specific configuration properties. See the sections that
follow for explanations of the properties. Note that some of the properties contain
other properties. The + character indicates the entry’s position in the property

hierarchy.
Table 30. Connector-specific configuration properties
Name Possible values Default value Required
[DataHandlerMetaObjectName| Data handler meta-object name MO_DataHandler_ Default Yes
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Table 30. Connector-specific configuration properties (continued)

Name

[lavaProtocolHandlerPackages|

[ProtocolHandlerFramework

HProtocolHandlers|

++Handler]]

[ProtocolListenerFramework]

HWorkerThreadCount|

RequestPoolSize

ProtocolListener

++HListener]
+HProtoco

+4 ListenerSEecific|

+

+

roxyServer

HttpProxyHos
HttpProxyPor
+HttpNonProxyHosts|

#HttpsNonProxyHosts|

SocksProxiHosE
SocksProxyPort
HttpProxyUsername]
HttpProxyPassword|
HttpsProxyUsername]

HttpsProxyPassword|

£+

£+

4+ o+ o+

KeyStorePassword|
KexStoreAlias|
TrustStore]
TrustStorePassword|
UseClientAut

B N B R RS

Possible values

Valid Java protocol handler packages

This is a hierarchical property and has
no value

This is a hierarchical property and has
no value

This is a hierarchical property. For
information on its sub-properties, see
[“Handler1” on page 63)

This is a hierarchical property and has
no value.

An integer of 1 or greater that gives
the number of available listener
threads.

Integer greater than
WorkerThreadCount that gives the
resource pool size.

This is a hierarchical property and has
no value

Uniquely named protocol listener
http or https

Properties unique to or required by the
listener See|“ListenerSpecific” on|
|Eage 64.|

This is a hierarchical property and has
no value

Host name for the HTTP proxy server
Port number for the HTTP proxy
server

HTTP host(s) requiring direct
connection

Host name for the HTTPS proxy
server

Port number for the HTTPS proxy
server

HTTPS host(s) requiring direct
connection

Socks proxy server name

Socks proxy server port

Http proxy server username

Http proxy server password

Https proxy server username

Https proxy server password

This is a hierarchical property and has
no value

SSL, SSLv2, SSLv3, TLS, TLSv1

true, false

Any valid keystore type

Path to KeyStore file.

Password for private key in KeyStore
Alias for key pair in KeyStore

Path to TrustStore file

Password for TrustStore

true false

Default value

com.ibm.net.ssl.
internal.www.protocol
None

10

20

80

443

SSL
false
JKS

false

Required

Yes
Yes
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DataHandlerMetaObjectName: This is the name of the meta-object that the data
handler uses to set configuration properties.

Default = MO_DataHandler Default.

JavaProtocolHandlerPackages: The value of this property gives the Java Protocol
Handler packages. The connector uses the value of this property to set the system
property java.protocol.handler.pkgs.

Default = com.ibm.net.ss1.internal.www.protocol.

ProtocolHandlerFramework: The Protocol Handler Framework uses this property
to load and configure its protocol handlers. This is a hierarchical property and has
no value.

Default = none.

ProtocolHandlers: This hierarchical property has no value. Its first-level children
represent discrete protocol handlers.

Default = none.

Handlerl: The name of an HTTP-HTTPS protocol handler. Note that this is a

hierarchical property. Unlike listeners, protocol handlers may not be duplicated,
and there can be only one handler for each protocol. [Table 31| below shows the
sub-properties for the HTTP-HTTPS protocol handler. The + character indicates the

entry’s position in the property hierarchy.

Table 31. HTTP-HTTPS protocol handler configuration properties

Name

++HTTPHTTPSHandler
+++Protocol

+++HTTPRead Timeout

Default
Possible values value Required
This is a hierarchical property and has no value. Yes
The kind of protocol the handler is implementing. For ~ http Yes

HTTP and HTTPS, the value is http.

Note: If you do not specify a value for this

property, the connector will not initialize this

protocol handler.

An HTTP-specific property that specifies the timeout 0 No
interval (in milliseconds) while reading from the remote

host. If this property is not specified or if set to 0, the

HTTP-HTTPS protocol handler blocks indefinitely

while reading from the remote host.

ProtocolListenerFramework: The protocol listener framework uses this property
to load protocol listeners. This is a hierarchical property and has no value.

WorkerThreadCount: This property, which must be an integer of 1 or greater,
establishes the number of protocol listener worker threads available to the protocol
listener framework. For further information, see [‘Protocol listeners” on page|

efault = 10.

RequestPoolSize: This property, which must be an integer greater than
WorkerThreadCount, sets the resource pool size of the protocol listener framework.
The framework can process a maximum of WorkerThreadCount + RequestPoolSize
requests concurrently.
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Default = 20.

ProtocolListeners: This is a hierarchical property and has no value. Each
first-level child of this property represents a discrete protocol listener.

Listenerl: The name of a protocol listener. There may be multiple protocol
listeners. Note that this is a hierarchical property. You can create multiple instances
of this property and create additional, uniquely named listeners. When doing so,
you can change the listener-specific properties but not the protocol property. The
names of multiple listeners must be unique. Possible names (not values):
HTTPListenerl, HTTPSListenerl.

Protocol: This property specifies the protocol this listener is implementing.
Possible values: http, https.

Note: If you do not specify a value for this property, the connector will not
initialize this protocol listener.

ListenerSpecific: Listener specific properties are unique to, or required by, the
specified protocol listener. For example, the HTTP listener has a listener-specific
property Port, which represents the Port number on which Listener monitors
requests. summarizes the HTTP-HTTPS listener specific properties. The +
character indicates the entry’s position in the property hierarchy.

Table 32. HTTP and HTTPS protocol listener-specific configuration properties

Name Possible values Default value  Required

+++HTTPListenerl Unique name of an HTTP protocol listener. This is a Yes
child of the ProtocolListenerFramework ->
ProtocolListeners hierarchical property. There can be
multiple listeners: you may plug-in additional HTTP
listeners by creating another instance of this property
and its hierarchy.
++++Protocol http if HTTP protocol listener Yes
https if HTTPS protocol listener
Note: If you do not specify a value for this
property, the connector will not initialize this
protocol listener.
++++BOPrefix The value of this property is passed to the data handler. No
++++Host The listener will listen at the IP address specified by Tocalhost No
value of this property. If Host is not specified, it
defaults to localhost. Note that you may either specify a
host name (DNS name) or an IP address for the
machine on which the listener is running. A machine
may have multiple IP addresses or multiple names.
++++Port The port on which the listener listens for requests. If 80 for HTTP No
unspecified, the port defaults to 80 for HTTP and 443  listener
for HTTPS.If you clone the listener within a connector, 443 for HTTPS
then the combination of Host and Port properties is listener
unique or the listener may be unable to bind to the port
to accept requests.
++++SocketQueueLength Length of the queue (socket queue) for incoming 5 No
connection requests. Specifies how many incoming
connections can be stored at one time before the host
refuses connections. The maximum queue length is
operating system dependent.
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Table 32. HTTP and HTTPS protocol listener-specific configuration properties (continued)

Name

++++RequestWaitTimeout

++++HTTPRead Timeout

++++HttpAsyncResponseCode

++++URLsConfiguration

+++++URL1

++++++ContextPath

++++++Enabled

++++++TransformationRules

+++++++TransformationRulel

Possible values

The time interval in milli-seconds that the listener
thread will block on the host and port while waiting for
requests to arrive. If it receives a request before this
interval, the listener will process it. Otherwise the
listener thread checks whether the connector shutdown
flag is set. If it is set, the connector will terminate.
Otherwise it will continue to block for
RequestWaitTimeout interval. If this property is set to
0, it will block for ever. If unspecified, it defaults to
60000ms.

The time interval in milli-seconds that the listener will
be blocked while reading a request from a client. If this
parameter is set to 0, the listener indefinitely blocks
until it receives the entire request message.

The HTTP response code for asynchronous requests to
the listener:

200 (OK)

202 (ACCEPTED)

This is a hierarchical property and has no value. It
contains 1 or more configurations for URLs supported
by this listener and, optionally, mime type and charset
values. Note that this is child property of
ProtocolListenerFramework->ProtocolListeners-
>HTTPListenerl hierarchical property. If this property
is not specified, the listener assumes default values.

This is a hierarchical property and has no value.
Its children provide the name of the URL supported
by this listener. There can be multiple supported URLs.
Note that you can plug in additional URLs by cloning
this property and its hierarchy.

The URI for the HTTP requests received by the listener.
This value must be unique among ContextPath values
under the URLsConfiguration property. Otherwise the
connector will log an error and fail to start.
ContextPath is case sensitive. However it may contain
protocol, host name and port which are case-insensitive.
If protocol is specified in ContextPath, it should be
http. If host is specified, it should be equal to the value
of the Host listener property. If port is specified, it
should be equal to the value of Port listener property.

Default value  Required
60000 (ms) No
0 No
202 No

(ACCEPTED)

ContextPath: /  No
Enabled: true
Data handler
MimeType:
equal to the
ContentType of
the request
Charset:
NONE. For
further
information,

The value of this property determines if the parent URL True No

hierarchical property is enabled for the connector.

This is a hierarchical property and has no value. It
holds one or more transformation rules.

This is a hierarchical property and has no value. It
holds the transformation rule.
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Table 32. HTTP and HTTPS protocol listener-specific configuration properties (continued)

Name

++++++++ContentType

++++++++MimeType

++++++++Charset

Possible values

Default value

The value of this property specifies the ContentType of
the incoming request for which special handling (data
handler mime type or charset) should be applied. If
ContentType is not specified by the
TransformationRuleN hierarchical property, the

connector logs a

warning message and ignores the

TransformationRuleN property.

Specifying the special value */+ for this property
enables the protocol listeners to apply this rule to any
ContentType. Note that if a listener finds more than
one rule for the same context path that shares a
ContentType, the listener logs an error and fails to

initialize.

The mime type to use when calling a data handler to
process requests of the specified ContentType.
Charset to use when transforming the request of the
specified ContentType into a business object.

Required
No

Configurator.
Etonnector Configurator - [ICS - WebServicesConnector : Sample] =] E3

ProxyServer: Configure the values under this property when the network uses a
proxy server. This is a hierarchical property and has no value. The values specified
under this property are used by the HTTP-HTTPS protocol handlers.

shows the ProxyServer properties as displayed in Connector
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Figure 21. ProxyServer properties
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HttpProxyHost: The host name for the HTTP proxy server. Specify this property if
the network uses a proxy server for HTTP protocol.

Default = none

HttpProxyPort: The port number that the connector uses to connect to the HTTP
proxy server.

Default = 80

HttpNonProxyHosts: The value of this property gives one or more hosts (for
HTTP) that must be connected not through the proxy server but directly. The value
can be a list of hosts, each separated by a " |".

Default = none

HttpsProxyHost: The host name for the HTTPS proxy server.

Default = none

HttpsProxyPort: The port number that the connector uses to connect to the
HTTPS proxy server.

Default = 443

HttpsNonProxyHosts: The value of this property gives one or more hosts (for
HTTPS) that must be connected not through the proxy server but directly. The
value can be a list of hosts, each separated by a "1".

Default = none

SocksProxyHost: The host name for the Socks Proxy server. Specify this property
when the network uses a socks proxy.

Note: The underlying JDK must support socks.
Default = none

SocksProxyPort: The port number to connect to the Socks Proxy server. Specify
this property when the network uses a socks proxy.

Default = none

HttpProxyUsername: The username for the HTTP proxy server. If the destination
for the request is an HTTP URL and you specify ProxyServer
->HttpProxyUsername, the HTTP-HTTPS protocol handler creates a
Proxy-Authorization header when authenticating with the proxy. The handler uses
the CONNECT method for authentication.

The proxy-authentication header is base64 encoded and has the following
structure:

Proxy-Authorization: Basic

Base64EncodedString

The handler concatenates the username and the password property values,
separated by a colon (:), to create the base64 encoded string.
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Default = none

HttpProxyPassword: The password for the HTTP proxy server. For more on how
this value is used, see|“HttpProxyUsername” on page 67|

Default = none

HttpsProxyUsername: The username for the HTTPS proxy server. If the
destination for the request is an HTTPS URL and you specify ProxyServer
->HttpsProxyUsername, the HTTP-HTTPS protocol handler creates a
Proxy-Authorization header for authentication with the proxy. The handler
concatenates the HttpsProxyUsername and HttpsProxyPassword configuration
property values, separated by colon (:), to create the base64 encoded string.

Default = none

HttpsProxyPassword: The password for the HTTPS proxy server. For more on
how this value is used, see [“HttpsProxyUsername.”]

Default = none

SSL: Specify values under this property to configure SSL for the connector. This is
a hierarchical property and has no value.

SSLVersion: The SSL version to be used by the connector. For further information,
see IBM JSSE documentation for the supported SSL versions.

Default = SSL

SSLDebug: If value of this property is set to true, the connector sets the value of
thejavax.net.debug system property to true. IBM JSSE uses this property to turn
on the trace facility. For further information, refer to IBM JSSE documentation.

Default = false

KeyStoreType: The value of this property gives the type of the KeyStore and
TrustStore. For further information, see IBM JSSE documentation for valid keystore

types.

Default = JKS

KeyStore: This property gives the complete path to keystore file. If KeyStore
and/or KeyStoreAlias properties are not specified, KeyStorePassword,
KeyStoreAlias, TrustStore, TrustStorePassword properties are ignored. The

connector will fail to startup if it cannot load the keystore using the path specified
in this property. The path must be the complete path to the keystore file.

Default = None

KeyStorePassword: This property gives the password for the private key in the
Keystore.

Default = None

KeyStoreAlias: This property gives the alias for the key pair in the KeyStore.
HTTPS listeners use this private key from the KeyStore. Also, the HTTP-HTTPS
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protocol handler uses this alias from the KeyStore when invoking HTTPS services
that require client authentication. The property must be set to a valid JSSE alias.

Default = None

TrustStore: This property gives the complete path to the TrustStore. TrustStore is
used for storing the certificates that are trusted by the connector. TrustStore must
be of the same type as KeyStore. You must specify the complete path to the
TrustStore file.

Default = None
TrustStorePassword: This property gives the password for the Truststore.
Default = None

UseClientAuth: This property specifies whether SSL client authentication is used.
When it is set to true, HTTPS listeners use client authentication.

Default = false

Creating multiple protocol listeners

You can create multiple instances of protocol listeners. Protocol listeners are
configured as child properties of the ProtocolListenerFramework ->
ProtocolListeners connector property. Each child (of ProtocolListenerFramework ->
ProtocolListeners) identifies a distinct protocol listener for the connector.
Accordingly, you can create additional protocol listeners by configuring new child
properties under the ProtocolListeners property. Make sure that you specify all of
the child properties of the newly created listener property. Each listener must be
uniquely named. However, you do not change the listener Protocol property (http
or https), which remains the same for multiple instances of a listener.

Note: The Protocol property is very important because it serves as a switch. If you
do not want to use a listener or a handler, leave this property empty.

If you are creating multiple instances of a HTTP or HTTPS listener, be sure to
specify different Port and Host properties for each instance.

You cannot create multiple instances of a handler. There can be only one handler
for each protocol.

Connector at startup

When you start the connector, the init() method reads the configuration
properties that were set using System Manager’s Connector Configurator. For
proper functioning, be sure not to disable connector polling (connector polling is
enabled by default). The sections below describe what occurs.

Proxy setup

If you specify the ProxyServer connector-specific property, the connector sets up
the proxy system properties. A proxy server is used with the HTTP-HTTPS
protocol handler for request processing only. The connector also traces each of the
system properties it sets up. For more on the ProxyServer property, see
[“Connector-specific configuration properties” on page 61
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Protocol listener framework initialization

During startup the connector instantiates the protocol listener framework and
initializes it. This framework reads the connector-specific property
ProtocolListenerFramework, The connector then reads the value of WorkerThreads
and RequestPoolSize connector properties. If the ProtocolListenerFramework
property is unspecified or missing, the connector cannot receive requests from
clients and logs a warning.

The connector next reads the ProtocolListenerFramework -> ProtocolListeners
property. All the first-level properties of the ProtocolListeners property represent
protocol listeners. The protocol listener framework attempts to load and initialize
each of the listeners and traces them. If persistent event capable, the listener
attempts an event recovery.

Protocol handler framework initialization

The connector reads the connector-specific property ProtocolHandlerFramework
and instantiates and initializes the protocol handler framework. If this property is
missing or not set properly, the connector cannot perform request processing and
logs a warning. Next the connector reads all the ProtocolHandlerFramework ->
ProtocolHandlers properties, which correspond to protocol handlers, and attempts
to load, initialize, and trace them. Note that the protocol handlers are loaded
during connector initialization and are not instantiated when a collaboration makes
a service request. The protocol handlers are multi-thread safe.

Logging

The connector logs a warning when:

* the ProtocolListenerFramework property is not specified. The connector warns
that it cannot perform event notification.

¢ the ProtocolHandlerFramework property is not specified. The connector warns
that it cannot perform (collaboration) request processing.

Tracing

Tracing is an optional debugging feature you can turn on to closely follow
connector behavior. Trace messages, by default, are written to STDOUT. See the
connector configuration properties for more on configuring trace messages. For
more information on tracing, including how to enable and set it, see the Connector
Development Guide for Java.

Connector trace levels are as follows:

Level 0 This level is used for trace messages that identify the connector
version.
Level 1 Trace each time the pollForEvents method is called. Trace the TLO

name created by listeners for delivery to ICS. Trace the Request
business object name and the corresponding attribute name in the
TLO.

Level 2 Use this level for trace messages that log each time a business
object is posted to InterChange Server, either from gotAppl1Event ()
or executeCollaboration(). Also, trace which protocol handler is
processing the request.

Level 3 Trace the ASI of the business object being processed. Trace
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Level 4

Level 5

attributes of the business object being processed. Trace the TLO of
the request business object during event notification. Trace the
business object returned by the data handler.

Trace the transport headers associated with:

* a request message retrieved by the protocol listener from the
transport

* aresponse message sent to the client by the protocol listener.
Trace the spawning of threads, all ASI that is processed, and all
entries and exits of important functions.

Trace the following:

* the entries and exits for each important method

* all of the configuration-specific properties

* the loading of each of the protocol listeners

* the request message retrieved by the protocol listener from the
transport

* the response message sent on the transport to the client by the
protocol listener

* the loading of each protocol handler

* the messages returned by the data handler

* business object dumps of the TLO sent to the collaboration
* dumps of the business objects returned by the data handler.
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Chapter 5. SOAP data handler
« |"Configuring the SOAP data handler”]
+ [“SOAP data handler processing” on page 79

* |“SOAP style and use guidelines” on page 105

* ["XML limitations” on page 106

The SOAP data handler is a data-conversion module whose primary roles are to
convert business objects into SOAP messages and SOAP messages into business
objects. The SOAP data handler performs the following functions:

* Request Processing
— SOAP request business object to SOAP request message
— SOAP response message to SOAP response business object
— SOAP fault message to SOAP fault business object

¢ Event Processing
— SOAP request message to SOAP request business object
— SOAP response business object to SOAP response message
— SOAP fault business object to SOAP fault message

This chapter describes how to configure the SOAP data handler, how the SOAP
data handler processes messages and objects, and how to customize the data
handler.

Configuring the SOAP data handler

The SOAP data handler is a pivotal component in the connector for SAP XI. The
connector calls the SOAP data handler to transform business objects into SAP
XI-compliant SOAP messages.

When collaborations are exposed as SAP XI services, the connector also calls the
SOAP data handler. The data handler then transforms SOAP messages sent from a
remote trading partner (or internal client) into business objects. The connector
passes the business objects to collaborations that have been configured for SAP XI.

The information in data handler meta-objects plays a crucial role in these
transformations. You configure this information after you install the product files,
but before startup. Unless you are adding a custom name handler, you can use the
default SOAP data handler configuration to save time. You must, however,
configure specific meta-object information for each data handler transformation.
Data handler meta-objects are discussed in the sections below.

Meta-object requirements

Meta-objects are business objects that contain configuration information. The
connector uses meta-objects at runtime to configure the data handler and create
instances of it. The SOAP data handler also uses meta-objects to locate the body of
a SOAP message, to determine the business object and verb that the body
corresponds to, to encode a business object in a SOAP message, and to perform a
number of other tasks discussed in this chapter. This section describes
requirements for these meta-objects.
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Meta-object hierarchy and terminology
shows the meta-object structure for the adapter for SAP XI product. The
meta-objects are named in bold in the illustration and discussed below.

MO_DataHandler_Default

MO_DataHandler_DefaultSOAPConfig

ClassName

SOAPNameHandler

DefaultNameResolution

SOAPVersion

Figure 22. Meta-object structure

The following terminology is used throughout this document when discussing

meta-objects:

* MO_DataHandler_Default Data handler meta-object used by the connector agent
to determine which data handler to instantiate. This is specified in the
DataHandlerMetaObjectName property of the connector.

* MO_DataHandler_DefaultSOAPConfig Child data handler meta-object specifically
for the SOAP data handler.

* SOAP Configuration Meta-Object (SOAP Config MO) A meta-object specified as
child of each SOAP business object and that contains the configuration
information for a single transformation from business object to SOAP message or
vice-versa.

MO_DataHandler_Default

The MO_DataHandler_Default is the top-level meta-object for all data handlers
that are called from connectors. The MIME type contained in these meta-objects
determines which data handler to use. The connector agent uses this meta-object to
create instances of the SOAP data handler. Accordingly, the
MO_DataHandler_Default object must include an attribute named xm1_soap that is
of type MO_DataHandler_DefaultSOAPConfig.

You can configure the MO_DataHandler_Default object after installing it. You must
add xm1_soap of type MO_DataHandler_DefaultSOAPConfig.

MO_DataHandler_DefaultSOAPConfig

The connector agent uses this meta-object to create and configure the SOAP data
handler at runtime. The MO_DataHandler_DefaultSOAPConfig has two attributes
of type string that designate:

* The class name for the SOAP data handler

* The SOAP name handler

e A default name resolution when the custom name handler fails
* The SOAP version (1.1 or 1.2)

These attributes are shown in [Table 33

Unless you wish to implement a custom name handler, which is discussed later in
this chapter, you can use the MO_DataHandler_DefaultSOAPConfig as delivered
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and installed. No configuration is needed.

Table 33. Meta-object attributes for MO_DataHandler_DefaultSOAPConfig

Name Type Default value Description
ClassName String com.ibm.adapters Standard attribute used by the
.dataHandlers.xml. soap data handler base class to find

the class name based on a MIME
type passed into the
createHandler method.

SOAPName String Name of the SOAP name handler

Handler to use.

DefaultName  String false Determines whether default

Resolution name resolution is used if the
custom name handler fails.

SOAPVersion  String 1.1 Determines the SOAP standard

(1.1 or 1.2) that the data handler
uses to read and write SOAP
messages.

SOAP configuration meta-object: child of every SOAP business
object

A SOAP Config MO defines the data formatting behavior for one data handler
transformation — either a SOAP-message-to-business-object or
business-object-to-SOAP-message transformation. A SOAP Config MO is a child of
a SOAP business object. These child SOAP Config MOs are critical for default
business object resolution. When using default business object resolution, all child
SOAP Config MOs, whether for a request, response, or fault object, must have
unique entries for default values of BodyName and BodyNS. shows these
and other attributes of a SOAP Config MO.

Table 34. Attributes for SOAP Config MOs

Name Required Description

BodyNS Yes Namespace to be used for SOAP body.

BodyName Yes Name of the body of the SOAP message. For SOAP fault,
set the default value to soap:fault.

BOVerb Yes Verb of the business object that contains the SOAP Config
MO.

Typelnfo No True or false attribute that dictates whether type

information (xsi:type) is written to and read from a SOAP
element. Default = false

TypeCheck No This property is read only if Typelnfo is set to true.
Possible values are none and strict. If none, type
validation is skipped when reading SOAP messages into
this business object. If strict, the data handler will
strictly validate all SOAP type names and namespaces
against the business object’s application-specific
information. Default = none

Style No This property dictates the SOAP message style and has
implications for other attributes such as BodyName and
BodyNS. The possible values for this attribute are rpc and
document. Default = rpc

Use No This property dictates the SOAP message’s use and affects
how the SOAP body is constructed from a business object.
The possible values are Titeral and encoded. The default
is Titeral.
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|Ei§ure 23: shows the relationship between a SOAP business object and a SOAP
Config MO.

SOAP Business Object

BO Level ASI
cw_mo_soap = SOAPCfgMO
cw_mo_jms = SOAPJMSCfgMO
Orderld string
OrderNum string
SOAPCfgMO  SOAP Config MO

SOAPCfgMO

BodyName
BodyNS
BOVerb
Typelnfo
TypeCheck

Style
Use

Figure 23. SOAP configuration meta-object

shows a SOAP response business object and its child business object. The
child business object, SOAPCfgMO, is a SOAP Config MO that specifies the
behavior for the SOAP data handler for a transformation from a business object
response to a SOAP response message. The attribute indicating the child SOAP
Config MO must use the name-value pair beginning cw_mo_soap.

By convention, when reading business object level application-specific information
beginning with cw_mo_, the data handler recognizes that the child object specified
in the name-value pair contains transformation meta-object information and
therefore does not include this child as content in the body of the message it is
transforming. In the example, the child objects indicated by the name-value pairs
cw_mo_jms and cw_mo_soap are recognized as meta-objects and not written into the
SOAP response message. In addition, the SOAP data handler ignores all business
object level application-specific information beginning with cw_mo_ except for
cw_mo_soap. Accordingly, the SOAP data handler ignores the application-specific
information such as cw_mo_tpi. But the SOAP data handler reads and uses the
SOAP Config MO specified in cw_mo_soap to execute the SOAP response
transformation from business object to SOAP message.

All SOAP business objects must have child SOAP Config MOs and these must be
specified as application-specific information at the business object level. Much of

this is automated: when you use the SAP XI ODA to generate business objects for
SOAP messages, the SOAP Config MOs are automatically generated for you.
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Style and Use impact on SOAP messages

The SOAP Config MO optional properties, Style and Use, affect the way that SOAP
messages are created. The possible values for Style are rpc and document, and for
Use are Titeral and encoded. The sections below discuss how the Style and Use
combinations impact SOAP message creation.

rpc/literal: When the Style property is set to rpc and the Use property to Titeral,
the Body Name and Body Namespace for a SOAP Message are read from the
SOAP ConfigMO'’s BodyName and BodyNS properties, respectively.

The following is an example of an rpc/literal style message where the Body
Name and Body Namespace have been resolved to getOrderStatus and
OrderStatusNS respectively:

<?xml version='1.0' encoding='UTF-8'?>
<SOAP-ENV:Envelope xmlns:SOAP-ENV=Thttp://schemas.xmlsoap.org/soap/envelope/i
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmins:xsd="http://www.w3.0rg/2001/XMLSchema">
<SOAP-ENV:Body>
<nsl:getOrderStatus xmlns:nsl="http://www.ibm.com/">
<Partl>
<ns2:Eleml xmins:ns2="http://www.ibm.com/eleml">
<Child1>1</Childl>
<Child2>2</Child2>
</ns2:Eleml>
<ns3:Eleml xmins:ns3="http://www.ibm.com/eleml">
<Child1>3</Childl>
<Child2>4</Child2>
</ns2:Eleml>
<Elem2>10</ETem2>
</Partl>
</nsl:getOrderStatus>
</SOAP-ENV:Body>
</SOAP-ENV:Envelope>

shows the corresponding business object for this rpc/Titeral message.

Mame Type Key |Card Default App Spec Infa
= Part1 SOAP_Part! Type F |1
5 Eemt soaP_maxType | [P | e
Chile1 String =l
Chile2 String -
ObjectEventld | String
Elemz String |l
ObjectEventid String
H SOAPConfigMO  |SOAP Reg Cig MO | [ |1
BodyMame String = getOrderStatus
BodyM= String I itk Sy ibm.com
BOYerk String || Retrieve
Typelnfo String || false
TypeCheck String || none
Style String | | rpc
Ise String r literal

Figure 24. rpc/literal SOAP Config MO

Note: You must configure these properties and business object attributes
appropriately so that a corresponding SOAP message is created.
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rpc/encoded: When the Style property is set to rpc and Use is set to encoded, the
Body Name and Body Namespace for a SOAP Message are read from the Child
ConfigMO’s BodyName and BodyNS properties respectively. Also, the
SOAP-ENV:encodingStyle="http://schemas.xmlsoap.org/soap/encoding/" attribute
is added to the Body tag.

The following is an example of an rpc/encoded message where the Body Name
and Body Namespace have been resolved to getOrderStatus and OrderStatusNS
respectively.

<?xml version='1.0"' encoding='UTF-8'?>
<SOAP-ENV:Envelope xmlns:SOAP-ENV="http://schemas.xmlsoap.org/soap/envelope/"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmIns:SOAP-ENC="http://schemas.xmlsoap.org/soap/encoding/"
xmIns:xsd="http://www.w3.0rg/2001/XMLSchema">
<SOAP-ENV:Body SOAP-ENV:encodingStyle=
"http://schemas.xmlsoap.org/soap/encoding/">
<nsl:getOrderStatus xmlns:nsl="http://www.ibm.com/">
<Partl xsi:type="ns1:SOAP_PartlType">
<ns2:Eleml SOAP-ENC:arrayType="ns2:SOAP_MaxType[2]"
xsi:type="SOAP-ENC:Array" xmIns:ns2="http://www.ibm.com/eleml">
<item>
<Childl xsi:type="xsd:string">1</Childl>
<Child2 xsi:type="xsd:string">2</Child2>
</item>
<item>
<Childl xsi:type="xsd:string">3</Childl>
<Child2 xsi:type="xsd:string">4</Child2>
</item>
</ns2:Eleml>
<Elem2 xsi:type="xsd:string">10</Elem2>
</Partl>
</nsl:getOrderStatus>
</SOAP-ENV : Body>
</SOAP-ENV:Envelope>

shows the corresponding business object for this rpc/encoded message.

Mame Type K Card Default App Spec Info |
H Part1 SOAP_Part! Type 1
B Elem SOAP_MaxType N I S R (e,
ibm.cotmielem?
Chiled1 String
Chilel2 String
ObjectEventld  String
Elemz2 String

ObjectEventid | String
B S0aPConfighO  |SOAP_Req_Cfg_MO

o | | e 5 o e | et W | 4

BodyMame String getOrderStatus
BodyMNS String hittp: e ibm com
BOVerk String Retrieve

Typelnfo String true

TypeCheck String none

Style String rpc

Use String encoded

Figure 25. rpc/encoded SOAP Config MO

document/literal: When the Style property is set to document and the Use
property is set to Titeral, an all encompassing Body Name tag will not exist. This
is an example of a document style SOAP message based on the above BO:
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<?xml version='1.0' encoding='UTF-8'?>
<SOAP-ENV:Envelope xmlns:SOAP-ENV=
"http://schemas.xmlsoap.org/soap/envelope/"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmins:xsd="http://www.w3.0rg/2001/XMLSchema">
<SOAP-ENV:Body>
<nsl:Eleml xmlns:nsl="http://www.ibm.com/eleml">
<Child1>1</Childl>
<Chi1d2>2</Child2>
</nsl:Eleml>
<ns2:Eleml xmlns:ns2="http://www.ibm.com/eleml">
<Child1>3</Child1l>
<Child2>4</Child2>
</ns2:Eleml>
</SOAP-ENV:Body>
</SOAP-ENV:Envelope>

shows the corresponding business object for this document/1iteral
message.

Matme Type Key |Card Default App Spec Info
5 Elemi SOAP_Flem P 1 maxoccqrs:S;elem_ns:hﬂp
ey im .comielemt
Chilett String Ird
Chilei2 String r
ObjectEverntid String
B SOAPConfigMO  |SOAP_Req_Cfg_ Mo | [T |1
BodyMame String I getOrderstatus
BodyNS String | ttg: S jlam com
BOVerh String - Retrieve
Typelnfao String Il falze
TypeCheck String - none
Style String Il document
Use String |l literal

Figure 26. document/literal SOAP Config MO

Note that the encodingStyle attribute in the XML code fragment has not been set.

document/encoded: This Style/Use combination is not supported. The data
handler fails if it encounters a SOAP ConfigMO with Style set to document and Use
set to encoded.

SOAP data handler processing

The SOAP data handler performs transformations between SOAP messages and
business objects in the following ways:

* SOAP message to business object processing

— Request-message-to-SOAP-request-business-object data handling occurs at that
stage in event processing when SAP XI clients make calls to collaborations
exposed as SAP XI services.

- Response-message-to-SOAP-response-business-object data handling occurs
during request processing when an SAP XI service returns a SOAP response
message to a collaboration that had invoked it. Alternatively,
fault-message-to-SOAP-business-object data handling may occur at this phase.

For a detailed description of this processing, see [‘SOAP-body-message-to-|
[pusiness-object processing” on page 80| later in this section.

* Business object to SOAP message processing
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— Business-object-to-SOAP-response-message data handling occurs during event
processing when a response business object is returned by the collaboration
that is exposed as an SAP XI service. Alternatively, fault business
object-to-SOAP-fault-message data handling may occur at this phase.

— Business-object-to-SOAP-request-message data handling occurs at that phase
of request processing when a collaboration makes a service call to the
connector to convert a business object to a SOAP request message.

For a detailed description of this processing, see [“Business-object-to-SOAP-|
[message-body processing” on page 82|later in this section.

SOAP-body-message-to-business-object processing

This section provides a step-by-step description of the SOAP-body-message-to-
business-object transformation.

1.
2.
3.

The SOAP data handler receives a SOAP message.
Using Apache SOAP APIs, the data handler parses the SOAP message.

The data handler extracts the components of the SOAP message: envelope,
header, and body.

Header processing For more, see [“SOAP-header-message-to-business-obiject]
[processing” on page 81.|

Body processing The data handler reads the first element of the SOAP body to
determine if it carries a fault or data. If the body content is not a fault, the data
handler does the following;:

a. Performs business object resolution to determine which business object will
be used in the transformation. If you have configured a custom name
handler, the default business object resolution discussed below may not
apply. For more on specifying a pluggable name handler, see
[pluggable name handler” on page 103.|

b. The data handler also resolves the SOAP Config MO (a child of the SOAP
business object that the data handler is creating) that will be used for the
transformation. If an instance of the SOAP Config MO does not exist, the
data handler creates an instance and reads its default values. From the
ConfigMO attribute values, the data handler reads the business object verb.
The data handler instantiates the SOAP business object and sets the verb

accordingly. This is the business object into which the data handler will
attempt to write the SOAP message.

c. The data handler continues parsing the SOAP message one element at a
time. For rpc, the data handler expects the first element to be the parent.

d. The data handler expects that the attributes of the business object (or its
application-specific information: for further information, see [*ASI iﬁ]
[business-object-to-SOAP-message transformations” on page 87) should have
the same name as the child elements. If the attribute is not found in the
business object, the data handler throws an exception. Child elements may
be of simple type or they may be of complex type. Complex elements are
those which have child elements.

e. Simple element If a child element is a simple element, by default, the data
handler expects a business object attribute with the same name (or ASI) as
that of a simple element. The data handler reads the value of the simple
element and sets it in the business object.

f. Complex element If a child element is of complex type, the data handler
expects the business object to have an attribute with the same name (or ASI)
and of type child business object. This attribute may be of single cardinality
or of multiple-cardinality depending on if there will be a complex SOAP
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6.

element or SOAP array. Next the data handler instantiates the child business
object (by default, the type of the attribute gives the name of the child
business object) and reads all the child elements of this complex element,
setting their values in the child business object. The data handler sets this
child business object into the parent business object attribute after verifying
the cardinality of this attribute. If the attribute is cardinality n, the data
handler appends this business object to the container. The complex element
can have either simple or complex child elements. These are also handled in
the same way: if it is simple element, the data handler sets the value in the
child BO; if it is a complex element, the data handler instantiates a child
business object.

Fault processing The data handler reads the name of the first element of the
SOAP body to determine if it is a fault. If the name of the first element is
Fault, the data handler concludes that this is a fault message. Fault business
object resolution occurs to determine into which business object this fault
message should be transformed. The data handler then follows the same
processing as that for body processing. The data handler expects that the
business object specified in the child business object should have the following
attributes:

a. faultcode: Required. String attribute

b. faultstring: Required. String attribute
c. faultactor: Not required String attribute
d. detail: Not required. Child BO

If fault processing fails for any reason, the exception thrown will contain the
text from the faultcode, faultstring and faultactor elements in the SOAP fault
message

Note: According to SOAP specifications for fault messages, faultcode, faultstring,

and faultactor are simple elements whereas detail is a complex element (an
element with child elements). In addition, faultcode, faultstring, faultactor,
and detail belong to the SOAP envelope namespace, whereas detail child
elements may belong to user-defined namespaces.

SOAP-header-message-to-business-object processing

This section describes how the data handler converts the header of a SOAP
message into a business object.

1.

2.

3.

The SOAP data handler processes the body of a SOAP message. Body
processing creates a SOAP business object.

If the SOAP message has a SOAP header element, the SOAP data handler
expects a SOAP header attribute in the business object obtained from body
processing. The SOAPHeader attribute is the child attribute of a business object
and has soap_location=S0APHeader as its application-specific information. If
there is no such attribute, the SOAP data handler throws an error.

The SOAPHeader attribute must be of type SOAP Header Container business
object. The SOAP data handler creates an instance of this attribute in the SOAP
business object obtained in step 1.

For each immediate child of the SOAP-Env:Header element:

a. The data handler expects a child attribute in the SOAP Header Container
Business Object. The name of this attribute must be the same as that of the
header element and conform to the SOAP Header Child business object. If
the data handler cannot find such an attribute, it throws an error.
Additionally, the namespace of this element should be the same as specified
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in the elem_ns application-specific information of this attribute. If it is not
the same, the data handler throws an error.

b. The data handler creates an instance of the SOAP Header Child business
object and places it in the instance of SOAP Header Container business
object created in step 2.

c. If this header element has an actor attribute, the data handler expects an
actor attribute to exist in the child business object created above. If it
cannot find an actor attribute, the data handler throws an error.

Note: If you want to add an actor attribute, see [“Specifying SOAP|
lattributes” on page 90)

d. If this header element has a mustUnderstand attribute, the data handler
expects a mustUnderstand attribute to exist in the child business object
created above. If it cannot find a mustUnderstand attribute, the data handler
throws an error.

Note: If you want to add a mustUnderstand attribute, see [“Specifying SOAP|
lattributes” on page 90

e. For each child element of this header element, the data handler expects an
attribute in the child business object with the same name. These elements
will be processed in same way as the child elements of SOAP-Env:Body
element.

Business-object-to-SOAP-message-body processing

The following is a step-by-step description of the business-object-to

SOAP-body-message transformation. For special cases involving

application-specific-information, see[“ASI in business-object-to-SOAP-message|

ftransformations” on page 87

1. The SOAP data handler looks for a SOAP ConfigMO that corresponds to the
SOAP business object it is transforming.

2. The data handler composes the envelope and header of the SOAP message.

3. The data handler resolves the SOAP ConfigMO. If an instance of the SOAP
ConfigMO does not exist, the data handler will create an instance and read
from the default values. By default, the data handler reads the value of the
BodyName attribute in the SOAP ConfigMO to determine whether it is
processing a fault business object. If it is set to soap:fault the business object is
considered a SOAP fault business object. If it is not a fault business object, the
data handler performs the processing described under composing body below,
else that described under composing fault.

4. Composing body The following steps detail the processing performed by the
data handler to compose the body of the SOAP message from a business object:

* The data handler obtains the BodyName and BodyNS from the SOAP
ConfigMO attributes and then composes the first (parent) element of the
body of the SOAP message. The name of first element is, by default, the
value for the BodyName. In this document, it is also referred to as the body
element. The namespace of the body element is, by default, the value
determined for BodyNS. If the Style attribute of the SOAP ConfigMO is set
to document, this step (creating the first body element) is skipped.

* The data handler then reads the attributes of the business object and
processes them by type. The processing for each type of attribute is described
below.

— Simple attributes If the attribute is of type simple, the data handler
creates a child element from the body element, with the same name as the
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attribute (unless otherwise specified by special application-specific
information). The data handler sets the value of this element to the value
of the attribute in the business object.

— Cardinality 1 child business object attributes

If the attribute is a single cardinality child business object, the data
handler creates a child element of the body element. This is referred to as
a child business object element. The name of the child element created is
the same as that of the attribute (unless otherwise specified by special ASI
properties). The data handler then traverses the attributes of the child
business object, creating the child elements for the attributes in the same
way it processes the attributes of the incoming business object. However,
the child elements are made children not of the body element but of the
child business object element

— Cardinality n child business object attributes If an attribute is a
cardinality n child business object, the data handler creates a SOAP array.
Each attribute is handled the same way that a single cardinality child
business object is handled.

5. Composing fault The following section walks through the process by which
the data handler composes a fault message.
¢ The data handler expects the following attributes in the business object:
— faultcode: Required, String attribute
— faultstring: Required, String attribute
— faultactor: Not required. String attribute
— detail: Not required. Child BO attribute.

If any required attributes are missing, the data handler errors out.

¢ The data handler creates an element for faultcode. It sets the value given by
the faultcode attribute of the business object.

* The data handler creates an element for faultstring. It sets the value given
by the faultstring attribute of the business object.

* The data handler creates the faultactor. It sets the value given by the
faultactor attribute of the business object.

* If the detail attribute is present in the business object, the attribute should
be of child business object type. Otherwise the data handler errors out. It
handles the attributes of each detail business object as highlighted in the
section on Composing body above.

6. CxIgnore processing If the data handler finds out that the value of an attribute
is set to CxIgnore, the data handler does not create an element for this
attribute.

7. CxBlank processing If the data handler determines that the value of an

attribute is set to CxBlank, the data handler creates an element for this attribute
but does not set its value.

Business-object-to-SOAP-message-header processing

This section describes the processing of the SOAP header attribute only. All other
attributes are processed as described in [“Business-object-to-SOAP-message-body|
[processing” on page 82|
1. From the business object, the SOAP data handler obtains the SOAPHeader
attribute. This attribute has soap_location=S0APHeader as its application-specific
information. The SOAP data handler creates a SOAP-Env:Header element if and
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only if the value of this attribute is not null. If a business object contains more
than one SOAPHeader attribute, the first one is processed and the rest are treated
as part of the body.

2. The SOAP data handler expects that the SOAPHeader attribute is a single
cardinality child representing a SOAP Header Container business object. The
data handler processes the child attributes of the SOAP Header Container
business object that are of type SOAP Header Child business object.

3. For each attribute of the SOAP Header Container business object, the data

handler does the following;:

a. Checks the cardinality: if this attribute is NOT a 1 or n cardinality child
object, it is ignored.

b. Checks the value: if the value of this attribute is NULL, it will be ignored.

c. If the attribute is a 1 or n cardinality child object, the SOAP data handler
creates a header element that is the immediate child of the SOAP-Env:Header
element created in step 1. The name of this header element is same as that
of the attribute. The namespace of this element is given by the elem_ns
application-specific information of this attribute.

d. If the attribute is a SOAP Header Child business object, all of the attributes
of this business object are processed. This attribute may have an actor and
a mustUnderstand attribute.

Note: If you want to add a mustUnderstand or actor attribute, see
[“Specifying SOAP attributes” on page 90|
e. If a SOAP Header Child business object has a non-null actor attribute, the
data handler creates an actor attribute in the header element that was
created in step c.

f. If a SOAP Header Child business object has a non-null mustUnderstand
attribute, the data handler will create a mustUnderstand attribute in the
header element created in step c.

g. All other non-null attributes of the SOAP Header Child business object
become child elements of this header element. They are composed in the
same manner as the child elements of the SOAP-Env:Body element.

Header fault processing

The SOAP specification states that errors pertaining to headers must be returned in
headers. These headers are returned in the SOAP fault message. Just as message
headers are specified in the SOAPHeader attribute of request and response business
objects, fault headers are specified in the SOAPHeader attribute of fault business
objects.

Each of the possible headers of request or response business objects may cause an
error. Such errors are reported in the headers of the fault message.

WSDL documents have a SOAP binding header fault element that allows you to
specify the fault header. For more information, see the SOAP and WSDL
specifications listed in Chapter 1.

The application-specific information of headerfault allows you to specify header
faults for each of your headers. You may specify headerfault application-specific
information for each of the attributes of the SOAP Header Container business
object. The list of attributes in the SOAP Header Container business object for the
fault business object is as follows:

headerfault=attrl, attr2, attr3...
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If the WSDL Configuration Wizard finds headerfault application-specific
information in the SOAP Header Child business objects of request or response
objects, the utility creates headerfault elements in the WSDL generated for these
headers. Note that WSDL allows you to specify multiple header faults for each of
your request (input) and response (output) headers. Therefore the value of this
application-specific information is a comma-delimited list of attributes.

Using application-specific information functionality

You can specify object- and attribute-level application
extend and enhance SOAP data handler functionality.

-specific information (ASI) to

Table 35 shows these

attributes, which are discussed in the sections below. All of the entries in the table

are attribute-level ASI unless otherwise noted.

Table 35. SOAP object ASI summary

ASI

Possible values

Description

soap_location

SOAPHeader

Specifies this business object
attribute as the header
attribute

headerfault

String

Identifies the BO attribute
name of the corresponding
SOAP header in the fault BO

elem_name

String

Specifies the name for the
SOAP element corresponding
to this BO attribute

elem_ns

String

Specifies the namespace for
the SOAP element
corresponding to this BO
attribute

type_name

String

Specifies the type for the
SOAP element corresponding
to this BO attribute

type_ns

String

Specifies the type namespace
for the element
corresponding to this BO
attribute

xsdtype

true

Specifies xsd as the
namespace for the element
corresponding to this BO
attribute, overriding older
xsd versions (such as 1999,
2000, etc.) with the latest
version of xsd (for example,
2001).

attr_name

String

Specifies the name for the
SOAP attribute
corresponding to this BO
attribute

attr_ns

String

Specifies the namespace for
the SOAP attribute
corresponding to this BO
attribute
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Table 35. SOAP object ASI summary (continued)

ASI Possible values Description

arrayof String Specifies the name of the n
cardinality child business
object attribute that must be
used as a placeholder for the
simple type array items

dh_mimetype String Specifies the mimeType of
the data handler that will be
used to transform this
attribute of complex type

cw_mo_* String This business object level ASI
specifies the name of a child
config MO that is interpreted
as meta-data, not content, by
the SOAP data handler. Only
cw_mo_soap specifies a child
config MO that is processed
as meta-data; all other
cw_mo_* indicate a different
component and are therefore
excluded from SOAP data
handler processing. All other
cw_mo* is ignored.

CW_mo_soap String This business object level ASI
specifies the name of the
Child Config MO attribute
that should be used when
transforming this business
object

cw_mo_jms String This business-object level ASI
specifies the name of the JMS
Protocol Config MO to use

cw_mo_http String This business-object level ASI
specifies the name of the
HTTP Protocol Config MO to
use

wrapper true Specifies the attribute name
of the wrapper object within
this business object. Wrapper
objects are used for certain
schema indicators, and must
not be serialized

maxoccurs Integer Specifies this business object
attribute’s maximum
occurrence possibility.
Depending on the value of
maxoccurs, the business
object may or may not have
a wrapper.

minoccurs Integer Specifies this business object
attribute’s minimum
occurrence possibility.
Depending on the value of
minoccurs, the object may or
may not have a wrapper.
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Table 35. SOAP object ASI summary (continued)

ASI Possible values Description

all

String Specifies the child attribute
that represents the all
indicator in the schema.

choice String Specifies the child attribute

that represents the choice
indicator in the schema.

ASI in business-object-to-SOAP-message transformations

The SOAP data handler uses a business object’s ASI to determine how to construct
a SOAP message. Unless otherwise stated, all ASI discussed in the sections below
refers to attribute level ASI and all string-based comparisons are performed
without regard to case.

elem_name and elem_ns processing
The examples discussed in this section assume that the attribute name is OrderId
and the SOAP element namespace prefix ns0.

1.

When neither elem_name nor elem_ns are specified, the elem_name defaults to
the attribute name, and the elem_ns defaults to the namespace of the element’s
parent.The ASI is not specified.

<OrderId>1</OrderId>

When the elem_name is specified and the elem_ns is not specified, the
elem_name will be set to the ASI elem_name value, and the elem_ns will be
defaulted to the namespace of the SOAP Body. The ASI is as follows:
elem_name=CustOrderld

<CustOrderId>2</CustOrderId>

When elem_ns is specified and elem_name is not, elem_name defaults to the
attribute name and elem_ns is set to the ASI elem_ns value. The xmlns attribute
is explicitly written if and only if the element namespace is not found
elsewhere in the scope of this element. If the element namespace is found, the
already defined namespace prefix is used. Otherwise (if the element namespace
is no found), a unique prefix for the elem_ns is generated. Consider the
following example, which presumes that a prefix is already defined in scope
(nsl represents a prefix corresponding to a namespace already defined in the
scope of this element). The ASI is as follows:

elem_ns= http://www.w3.0rg/2001/XMLSchema
<nsl:0rderId>3</nsl:0OrderId>

The following example presumes that prefix is not found (ns2 represents a
unique prefix). The ASI is as follows:

elem_ns=CustOrderIdNamespace

<ns2:0rderId xmlins:ns2="CustOrderIdNamespace">3</ns2:0rderld>

When both elem_name and elem_ns are specified, elem_name and elem_ns are
set to the ASI values. The same check that is performed in case 3 above
regarding already defined namespaces applies. Just as in case 3, if the

namespace is not already defined, a unique prefix for the elem_ns is generated.
The ASI is as follows:

elem name=CustOrderId;elem ns=CustOrderIdNamespace
<ns2:CustOrderId xmins:ns2="CustOrderIdNamespace">1</ns2:0rderld>
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type_name and type_ns processing for simple attributes
For the examples in this section, the attribute name is OrderId, the SOAP element
namespace prefix is ns@, and the attribute type is String.

Note: type_name and type_ns processing takes place only when the Config MO
attribute Typelnfo is true.

1. When neither type_name nor type_ns are specified, type_name defaults to the
simple type and the type_ns defaults to the xml schema-defined namespace
(xsd). The ASI is not specified

<OrderlId xsi:type="xsd:string">1</OrderId>

2. When type_name is specified and type_ns is not, type_name is set to the ASI
type_name value and type_ns defaults to the namespace of the element. The
ASI is as follows:
type_name=CustString
<OrderId xsi:type="ns0:CustString">2</0OrderId>

3. When type_ns is specified and type_name is not, the type_ns defaults to the
simple type name and type_name is set to the ASI type_ns value. The prefix is
handled in a way that is comparable to elem_ns creation. A unique prefix for
the type namespace is generated unless the namespace already exists in the
element scope. The ASI is as follows:
type_ns=CustStringNamespace
<OrderId xmIns:ns2="CustStringNamespace" xsi:type=
"ns2:String">3</0rderld>

4. When both type_name and type_ns are specified, they are set to the assigned
ASI values. A unique prefix for the type namespace is generated. The ASI is as
follows:
type_name=CustString;type_ns=CustStringNamespace

<OrderId xmIns:ns2="CustStringNamespace" xsi:type=
"ns2:CustString">1</0OrderId>

type_name and type_ns processing for single cardinality
attributes

For the examples in this section, the attribute name is OrderStaus, the SOAP
element namespace prefix is ns0, and the attribute type is OrderStatus.

Note: type_name and type_ns processing takes place only when the Config MO
attribute Typelnfo is true.

1. When neither type_name nor type_ns are specified, type_name defaults to the
business object name and the type namespace defaults to the namespace of the
element. The ASI is not specified:
<OrderStatus xsi:type="ns0:0rderStatus">1</OrderStatus>

2. When type_name is specified and type_ns is not, the type_name is set to the
assigned ASI value and type_ns defaults to the namespace of the element. The
ASI is as follows:
type_name=CustOrderStatus
<OrderStatus xsi:type="ns0:CustOrderStatus">1</0OrderStatus>

3. When type_ns is specified and type_name is not, type_name defaults to the
business object name and type_ns is set to the assigned type_ns value. A
unique prefix for the type namespace is generated. The ASI is as follows:
type_ns=CustTypeNS

<OrderStatus xsi:type="ns2:SOAP_OrderStatusLine
" xmins:ns2="CustTypeNS">1</OrderStatus>
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4. When both type_name and type_ns are specified, they are set to the assigned
ASI values. A unique prefix for the type namespace is generated. The ASI is as
follows:
type_name=CustOrderStatus;type_ns=CustTypeNS

<OrderStatus
xsi:type="ns2:CustOrderStatus" xmlins:ns2="CustTypeNS">1</OrderStatus>

type_name and type_ns processing for multiple cardinality
attributes

For all the examples given in this section assume the attribute name to be
MultiLines and the SOAP element namespace prefix to be ns0. Assume the
attribute type to be OrderStatus.

Note: type_name and type_ns processing takes place only when the Config MO
attribute Typelnfo is true.

1. When neither type_name nor type_ns are specified, type_name defaults to the
business object name and type_ns defaults to the namespace of the element.
The ASI is as follows:
<Multilines SOAP-ENC:arrayType="nsO:0rderStatus[2]"
xmlns:SOAP-ENC="http://schemas.xmlsoap.org/soap/encoding/"
xsi:type="SOAP-ENC:Array">

2. When type_name is specified and type_ns is not, type_name is set to the
assigned ASI type_name value and type_ns defaults to the namespace of the
element. The ASI is as follows:
type_name=CustOrderStatus
<MuTltilines SOAP-ENC:arrayType="ns0O:CustOrderStatus[2]"
xmlns:SOAP-ENC="http://schemas.xmlsoap.org/soap/encoding/"
xsi:type="SOAP-ENC:Array">

3. When type_ns is specified and type_name is not, type_name defaults to the
business object name, and the type_ns is set to the assigned ASI type_ns value.
A unique prefix for the type namespace is generated. The ASI is as follows:
type_ns=CustTypeNS
<MultilLines SOAP-ENC:arrayType="ns2:0rderStatus[2]"
xmins:SOAP-ENC="http://schemas.xmlsoap.org/soap/encoding/

" xmIns:ns2="CustTypeNS" xsi:type="SOAP-ENC:Array">

4. When both type_name and type_ns are specified, they are set to the assigned
ASI values. A unique prefix for the type namespace is generated. The ASI is as
follows:
type_name=CustOrderStatus;type _ns=CustTypeNS
<MultilLines SOAP-ENC:arrayType="ns2:CustOrderStatus[2

1" xmlins:SOAP-ENC="http://schemas.xmlsoap.org/soap/encoding/"
xmlns:ns2="CustTypeNS" xsi:type="SOAP-ENC:Array">

Note: The item element representing the parent for each Array element has the
same type and namespace as the arrayType.

xsdtype for simple, single, and multiple cardinality types

For simple, single. and multiple cardinality types, set the xsdtype ASI attribute to
true for the type name to adhere to the current XSD for the SOAP message. The
xsdtype property is read only when both the type_name and type_ns properties
are set. Given the type_name and type_ns, the SOAP data handler first attempts to
map the pair to a Java type using the SOAP API Then the data handler attempts
to convert the Java type back to a SOAP element type using the current XSD for
the SOAP Message. For example, if the current XSD is

http://www.w3.0rg/2001/XMLSchema
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and the following ASI:
type_name=timeInstant;type_ns=http://www.w3.0rg/1999/XMLSchema;xsdtype=true

The SOAP message type name is written as:
<OrderDate xsi:type="xsd:dateTime">

because dateTime is the 2001 XSD equivalent of the timeInstant in the 1999 XSD.

xsdtype and simple type arrays

For multiple cardinality objects, you can create a simple type array such as the
following:

<Multilines SOAP-ENC:arrayType="xsd:string[4]"

xmins:SOAP-ENC="http://schemas.xmlsoap.org/soap/encoding/"
xsi:type="SOAP-ENC:Array">

To achieve this, set the type_name property to the desired simple type (for
example, string) and set the type_ns property to the appropriate XSD
specification. Then, set the xsdtype property to true so that the type is converted
to the current XSD type. Finally, the arrayOf property should be set to the name of
the attribute in the container which should hold the simple type value. This is an
example of what the ASI would look like for a string array:

arrayof=size;type_name=string;type_ns=http://www.w3.0rg/2001/XMLSchema;xsdtype=true

ASI effects on fault processing
The faultcode, faultactor, faultstring, and detail elements adhere to the following
rules:
1. Any elem_name, elem_ns, type_name and type_ns ASI in these attributes is
ignored.

2. All children of the detail elements are written exactly as described in body
processing.

ASI effects on header processing

You can use all ASI properties (see[Table 35) at the header child object level and
below.

Specifying SOAP attributes

attr_name processing for simple types

There is an XML schema case in which complexTypes with simpleContent
extensions or restrictions have have both values and attributes. For example,
consider the following SOAP tag:

<size system="us">10</size>

It is based on the following schema:

<complexType name="SizeType">
<simpleContent>
<extension base="int">
<attribute name="system" type="string"/>
</extension>
</simpleContent>
</complexType>
<element name="size" type="ns:SizeType"/>

The business object corresponding to the complex type, with simple content
extension or restriction, must contain one additional attribute besides other
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attributes that correspond to the complex type attributes. The additional attribute
must contain the simple content value (in the example above, 10— the value of
element size). The business object attribute, having the business object
corresponding to such a complex type as its type, will have
elem_value=simpleContentValue as its attribute-level ASIL

shows the corresponding business object.

[Mame Type Key |Card | Application Specific Informstio
H Reqguest SOLP getCuote_M09218329332_Request [ 1 wes_hotype=request
. . elem_value=simpleContent alue;
H =ize SOAP getCuote 09213329332 _SizeType [T e e s
simpleConterty'alue |String Il
system Strimg I aftr_name=system

Figure 27. attr_name business object for simple types

attr_name processing for single and multiple cardinality types
You can specify ASI that translates business object attributes into soap attributes
instead of into soap elements. The data handler supports adding SOAP attributes
to complex single and n-card types only. Consider the following sample:
<CustInfo City="4" State="5" Street="2" Zip="6">

<Name xsi:type="xsd:string">1</Name>

<Street2 xsi:type="xsd:string">3</Street2>
</CustInfo>

Given this business object definition structure (with the attribute level ASI
specified to the right of each attribute in Figure 28), the data handler follows these
processing steps:

[ame Type App Spec Info
B Custinfao Customerinfo

Matne String
Streett String attr_name=Street
Street2 String
City String attr_name=City
State String attr_name==tate
Fip String attr_name=_Zip

Figure 28. attr_name business object

1. When traversing a complex attribute, the data handler first generates a
corresponding tag for this complex business object attribute. In this example,
CustInfo represents the complex business object attribute.

2. The data handler iterates through the children of the complex business object.
Only simple type attributes are considered for attribute creation. If a simple
type has an ASI property named attr_name, the data handler writes this simple
type as an attribute to the SOAP element. In this example, the element
(CustInfo) will have four attributes; Street, City, State and Zip.

3. The rest of the attributes of the business object are written using standard
BODY processing. This means that all relevant ASI will also be evaluated for
the business object attributes that do not have attr_name ASL
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The logic for processing multiple cardinality types is identical to that for
processing single cardinality types. Specifically, each <item> tag corresponds to
each business object instance in the multiple cardinality object, and will be
processed using ASI. For example, given this multiple cardinality business object
definition structure with corresponding ASI:

Matne Type Card App Spec Info
B Custinfao Customerinfo il

Mame String
Streett String attr_name==Street
Street2 String
City String attr_name=City
State String attr_name==tate
Zip tring sttr_name=Zigp

Figure 29. attr_name multiple cardinality business object

If the event sent to the data handler had two instances of this multiple cardinality
object, the SOAP message created may look like this:

<CustInfo>
<item City="Armonk" Street="Main Street">
<Name>IBM</Name>
<Street2>None</Street2>
</item>
<item City="Burlingame" State="Ca" Street="577 Airport Blvd" Zip="94010">
<Name>Burlingame Labs</Name>
<Street2>Suite 600</Street2>
</item>
</CustInfo>

Notice that the item tags are treated as the complex element type. Any attributes in
the BO definition will become SOAP attributes of the corresponding item tag.

arrayof processing for simple type arrays
The arrayof ASI property should only be used in the case of SOAP encoded simple
type arrays. For example, a serialization such as the following:

<CustomerNames SOAP-ENC:arrayType="xsd:string[4]"
xmins:SOAP-ENC="http://schemas.xmlsoap.org/soap/encoding/"
xsi:type="SOAP-ENC:Array">

<item xsi:type="xsd:string">valuel</item>

<item xsi:type="xsd:string">value2</item>

<item xsi:type="xsd:string">value3</item>

<item xsi:type="xsd:string">valued</item>
</CustomerNames>

would require a business object definition such as that shown i :
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SOAP echoStringArray _M

H Reqguest 0562455530 Request 1 ws_botype=request
SOAIE‘ echg‘a-t-ri.ng;ﬂ;rray _N :
= = arrayof=Remiype_name=string;type_ns

B CustomerNames  [0552463530_N1183926546 n =Fitty vy w3 orgi2001 HMLSchema

e Eier 3 0rgi2001 (ML Schema

Figure 30. arrayof business object

(The business object is shown from the Request level for clarity. )

Note: Although not shown, the SOAP Config MO’s Typelnfo property must be set
to true in this example to derive the above SOAP serialization from the
business object structure.

Also, the arrayof property can be used to create array items with a name other

than item. Using the example above, the <item> tags can be replaced with <name>

tags if both the BO attribute name and the "arrayof” asi property value is name.

This would be the serialization:

<CustomerNames SOAP-ENC:arrayType="xsd:string[4]"

xmIns:SOAP-ENC="http://schemas.xmlsoap.org/soap/encoding/"

xsi:type="SOAP-ENC:Array">

<item xsi:type="xsd:string">valuel</name>

<item xsi:type="xsd:string">value2</name>

<item xsi:type="xsd:string">value3</name>

<item xsi:type="xsd:string">valued</name>

</CustomerNames>

attr_name and attr_ns processing

You may need to provide a namespace that corresponds to the SOAP attribute
created. You do this by specifying the attr_ns ASI property for a simple type. The
data handler processes the attr_ns property if and only if attr_name exists in the
same attribute’s ASI. The following rules are followed with attr_name and attr_ns:

1. When neither attr_name nor attr_ns exist, the business object attribute is
translated to a SOAP element.

2. When only attr_name is set, the SOAP attribute’s namespace defaults to the
element’s namespace:
<CustInfo Street="577 Airport"></CustomerInfo>

3. When only attr_ns is set, the property is ignored and the business object
attribute is translated to a SOAP element.

4. When both attr_name and attr_ns exist, the SOAP attribute is created like the
following:

<CustInfo ns2:Street="577 Airport" xmlns:ns2=
"AttrNS"></CustomerInfo>

dh_mimetype: calling a data handler

The SOAP data handler can call another data handler to write business objects into
any format for which a data handler exists. You do this by adding encoded text to
a SOAP message when transferring a SOAP child business object into a SOAP
String.

An RNIF document is one of the formats in which a SOAP element’s value may be
encoded. To make use of this functionality, add an RNIF BO at any level of a
SOAP child business object. To signal the SOAP data handler to call another data
handler when transforming this RNIF business object to a string, add the
dh_mimetype property to the attribute’s ASI. The value of the dh_mimetype ASI
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property must be a legal mimeType specified in the MO_DataHandler_Default
meta-object. The mimeType is used to determine which data handler is called to
process the business object.

shows a SOAP child business object in which CustomerInfo is a complex
child and RNET_Pip3A2PriceAndAvailabilityQuery is an RNIF business object:

Mame Type App Spec Info |
B Custamerinfa Custamerinfo
[arme String
CustiD String
elem_name=FMFexample;dh_mimetype=application/x_ros
M RhIFhd=g RMET _Pip3A2PricedndlyailabiltyGuery |ettanet_sgerttype_name=bazebdBinarytype_ns=http
sy w30 20070 BMLSchems; xsdtype=true

Figure 31. RNIF business object with dh_mimetype

The SOAP message created from this business object may look like this:

<CustomerInfo>

<Name>IBM Corporation</Name>

<CustID>95626</CustID>

<RNIFexample
xsi:type="xsd:base64Binary">1AWERYER238WIBEYRI238728374871892787ASRIK23423
JKAWERJ234AWERIJHI423488R4HASF1AWERYER238W98EYR9238728374871892787ASRIK234
34JKAWERJ234AWERIJHI423488RAHASF1AWERYER238WI8EYRI238728374871892787ASRIK2
4234JKAWERJ234AWERIJHIA23488RAHASF1AWERYER238W98EYR9238728374871892787ASRJ
234234JKAWERJ234AWERIJHIA23488R4HASFWR234

</RNIFexample>

</CustomerInfo>

Note that the RNIF example element contains an RNIF encoded string that has
been base64 binary encoded as its element value. Also, note that elem_name,
elem_ns, type_name, type_ns, and xsdtype ASI properties remain relevant for this
business object attribute. In this example, the specified elem_name dictates the
name of the SOAP element upon message creation.

Note: If the element value returned by the called data handler is encoded text, the
type_name property must be set to base64Binary, the type_ns must
correspond to an xsd namespace, and xsdtype must be set to true.

xsd:base64Binary: When you set the type_name and type_ns to resolve to
xsd:base64Binary, the SOAP data handler encodes the value from the business
object before setting the value for the corresponding element. Using the Apache
AP], the data handler queries the registry for a base64Binary serializer, serializes
the string returned from the called data handler, and sets the element’s value.

Schema complexType indicators
The following sections discuss the effects of schema complexType Indicators on
business objects. The indicators include:

e maxQOccurs
* minOccurs
e all

* sequence
e choice
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maxOccurs and minOccurs indicators for simple types: The maxOccurs indicator
specifies the maximum number of times an element can occur within a complex
type. The minOccurs indicator specifies the minimum number of times an element
should occur within a complexType.

Consider this Schema:

<xs:element name="Address" type="Address">
<xs:complexType name="Address">
<xs:sequence>
<xs:element name="AddressLine" type="xsd:string" maxOccurs="10"/>
<xs:element name="SuiteNumber" type="xsd:string" minOccurs="3"
maxoccurs="unbounded" />
<xs:element name="City" type="xsd:string"/>
</xs:sequence>
</xs:complexType>
</xs:element>

The example above indicates that the AddressLine element can occur at most ten
times in an Address element, while the SuiteNumber element must occur at least
three times. The business object that corresponds to this schema must have an N
cardinality wrapper object for each maxoccurs/minoccurs indicator that has the
following ASI:

maxOccurs=N;wrapper=true

or

minOccurs=3;wrapper=true;

The wrapper=true ASI indicates that this object is a wrapper, and therefore not
explicitly written to the SOAP message. Instead, there must be one child of simple
type in this wrapper object. At runtime, for SOAP to business object
transformations, the data handler reads the N child objects of the wrapper and
creates a corresponding element for each one. When performing
business-object-to-SOAP-message transformations, the data handler creates child
objects in the N cardinality wrapper for every element it encounters.

The corresponding SOAP business object resembles that shown in

Pog Mame Type Key | Card App Spec Info |
1 H Address Address W |1

1.1 B Addressline Addrezsline_wrap | [ | N maxoccurs=1 0 wrapper=true
1141 Addressline String I

1142 OhjectEverntid String

1.2 B SuiteMumber Suiterumber_wrap | W | M MminocCurE=3 wapper=true
1.21 Suiterumber String Imd

122 ObjectEvertid String

13 City String [

1.4 OhjectEverntid String

2 ObjectEventld String

Figure 32. minOccurs and maxOccurs of simple type ASI in a SOAP business object

The SOAP message that corresponds to the business object shown in is as
follows:
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<Address xsi:type="ns0:Address">
<AddressLine xsi:type="xsd:string">Linel</AddressLine>
<AddressLine xsi:type="xsd:string">Line2</AddressLine>
<SuiteNumber xsi:type="xsd:string">600</SuiteNumber>
<SuiteNumber xsi:type="xsd:string">650</SuiteNumber>
<SuiteNumber xsi:type="xsd:string">700</SuiteNumber>
<City xsi:type="xsd:string">San Francisco</City>

</Address>

Note: The SOAP data handler processes maxOccurs and minOccurs indicators in
the same way, without validating the maximum or minimum occurrences of
elements. The data handler simply provides a container structure to hold
multiple instances of a particular element with the maxOccurs and
minOccurs indicators. This applies to simple and complex types.

maxOccurs and minOccurs indicators for complex types: The <maxOccurs>
indicator specifies the maximum number of times an element can occur within a
complex type. The <minOccurs> indicator specifies the minimum number of times
an element should occur within a complexType. Consider the maxOccurs indicator
in the following schema:
<xs:element name="Address" type="Address">
<xs:complexType name="Address">
<xs:sequence>
<xs:element name="AddressInfo" type="AddressInfo" maxOccurs="3"/>
<xs:element name="City" type="xsd:string"/>
</xs:sequence>
</xs:complexType>
</xs:element>

<xs:complexType name="AddressInfo">
<xs:sequence>
<xs:element name="StreetLine" type="xsd:string"/>
</xs:sequence>
</xs:complexType>
</xs:element>

The example above indicates that the AddressInfo complex type element can occur
at most three times in an Address element. The corresponding business object for
this schema will not have a wrapper object, since the complexType AddressInfo
itself can be of N cardinality. The following ASI will be placed at the N cardinality
attribute: maxoccurs=3

shows the corresponding SOAP business object.

Pos Marme Type Wey | Card | App Spec Info
1 B Address Address F |1

14 B Addressinfo Addreszinfo = M M&X0CCUrs=23
114 Streetline Strirg I~

1.1.2 ObjectEventld String

1.2 City String [

1.3 ObjectEventld String

2 OhjectEventid Strimg

Figure 33. minOccurs and maxQOccurs of complex type ASI in a SOAP business object

The SOAP message that corresponds to the business object shown in is as
follows:
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<Address xsi:type="ns0:Address">
<AddressInfo xsi:type="ns0:AddressInfo">
<StreetlLine xsi:type="xsd:string">100 Market St.</ StreetLine>
<StreetlLine xsi:type="xsd:string">Apt 15</ StreetLine>
</AddressInfo>
<City xsi:type="xsd:string">San Francisco</City>
</Address>

all indicator: The all indicator specifies by default that the child elements for this
complexType can appear in any order and that each child element must occur zero
or one times. Consider the following Schema:
<complexType name="Item">
<all>
<element name="quantity" type="xsd:int"/>
<element name="product" type="xsd:string"/>
</all>
</complexType>

The example above indicates that the elements quantity and product, can occur in
any order in the SOAP message. The quantity element may occur first and the
product element second, or vice versa.

shows the business object that corresponds to this schema fragment.

Fos Mame Type Card | App Spec Info

1 B ttem ttetn 1 sli=tem_wrapper
141 B tem_wrapper tem_wrapper il wrapper=true
1441 cuantity String

142 procuct String

113 ChjectEventld String

1.2 OhbjectEvertld String

2 OhbjectEventid String

Figure 34. all indicator ASI in a SOAP business object

The corresponding SOAP message fragment is as follows:

<Item xsi:type="ns0O:Item">
<quantity xsi:type="xsd:string">12</quantity>
<product xsi:type="xsd:string">2</product>
</Item>

Handling array content with ‘all” content model: The SOAP data handler processes
complex-type array content with the “all” content model as described in this
section. In the example, ArrayOfSOAPStruct contains SOAPStruct, which has the “all’
content model.

<complexType name="SOAPStruct">
<all>
<element name="varString" type="string" />
<element name="varInt" type="int" />
<element name="varFloat" type="float" />
</all>
</complexType>
<complexType name ="ArrayOfSOAPStruct'">
<complexContent>
<restriction base='SOAP-ENC:Array'>
<attribute ref='SOAP-ENC:arrayType'
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wsdl:arrayType="typens:SOAPStruct[]'/>
</restriction>
</complexContent>
</complexType>

The SOAP data handler must generate the following SOAP data on serialization:

<?xml version='1.0' encoding='UTF-8'?>
<SOAP-ENV:Envelope
xmIns:SOAP-ENV = "http://schemas.xmlsoap.org/soap/envelope/"
xmins:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmIns:SOAP-ENC="http://schemas.xmlsoap.org/soap/encoding/"
xmins:xsd="http://www.w3.0rg/2001/XMLSchema">
<SOAP-ENV:Body>
<ns0:echoStructArray xmlins:ns@="http://soapinterop.org/">
<inputStructArray SOAP-ENC:arrayType="ns1:SOAPStruct[2]"
xmins:nsl="http://soapinterop.org/xsd" xsi:type="SOAP-ENC:Array">
<item>
<nsl:varFloat xsi:type="xsd:string">1.1</nsl:varFloat>
<nsl:varInt xsi:type="xsd:string">1</nsl:varInt>
<nsl:varString xsi:type="xsd:string">hi</nsl:varString>
<item>
<item>
<nsl:varString xsi:type="xsd:string">hello</nsl:varString>
<nsl:varInt xsi:type="xsd:string">1</nsl:varlnt>
<nsl:varFloat xsi:type="xsd:string">1.1</nsl:varFloat>
</item>
</inputStructArray>
</nsB@:echoStructArray>
</SOAP-ENV:Body>
</SOAP-ENV:Envelope>

In this example, echoStructArray is the name of the operation, and
inputStructArray is the parameter name with type Array0fSOAPStruct.

sequence indicator: The sequence indicator specifies that child elements must
appear in the order specified in the complexType.
<complexType name="Item">
<sequence>
<element name="quantity" type="int"/>
<element name="product" type="string"/>
</sequence>
</complexType>

The SOAP data handler does not require special ASI or wrapper objects for this
indicator. By default, the data handler reads and writes SOAP elements in the
order specified in the business object.

choice indicator: The choice indicator specifies that one and only one of the
elements in a complexType can appear in the SOAP message. Consider the
following schema:
<complexType name="Item">
<choice>
<element name="quantity" type="int"/>
<element name="product" type="string"/>
</choice>
</complexType>

The SOAP data handler does not require special ASI or wrapper objects for this
indicator. When converting a business object to a SOAP message, the data handler
defers to your choice of which elements should appear in the SOAP message.
When converting a SOAP message to a business object, the data handler reads the
existing element and populates the attribute to which it corresponds.
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ASl in

maxOccurs indicator on sequence, choice, group and all: Model Groups
(sequence, choice, group, and all) have minOccurs and maxOccurs attributes. The
default value for minOccurs and maxOccurs is one. For the all group, the
maxQOccurs can take a value of one only. The SAP XI ODA and SOAP data handler
support all possible values for maxOccurs on sequence, choice and group.

SOAP-to-business object transformations

The SOAP data handler uses a business object’s ASI to read and validate an
incoming SOAP message. The following rules apply to ASI validation by the SOAP
data handler:

* Header and body processing are the same.

* The SOAP ConfigMO property, TypeCheck, must be set to strict and Typelnfo
set to true for the data handler to perform the validation described in the
sections below.

* type_name and type_ns validation are performed concurrently since type
validation is generally dependent on both properties.

Note: Unless otherwise stated, all ASI discussed in the following sections is
attribute-level ASI

elem_name validation
The following rules apply to validation for simple, cardinality 1 and cardinality n
attributes:

1. When encountering an element while parsing a SOAP message, the data
handler first searches all of the ASI at the business object level, attempting to
match the element’s name against the elem_name value.

2. If a match is not found, the data handler attempts to match the element’s
name against each of the attribute names at that business object level.

3. If neither search succeeds, the data handler fails.

elem_ns validation
The following cases apply to validation for simple, cardinality 1 and cardinality n
attributes:

1. When neither elem_ns ASI nor xmlIns from the SOAP message for this element
exist, the element is properly validated.

2. When elem_ns ASI does not exist and the corresponding element from the
SOAP message does have an xmlns specified, the data handler defaults the
elem_ns to the last elem_ns read from the business object that was in the scope.
The data handler compares this value with the xmlns value from the SOAP
message. If there is no match, validation fails.

3. When elem_ns ASI does exist and the corresponding element from the SOAP
message does not have xmlns specified, the data handler verifies that the
elem_ns specified in ASI matches one of the namespaces in the current scope of
the SOAP message. If there is no match, validation fails.

type_name and type_ns validation
The sections below discuss type_name and type_ns validation.

Simple attributes: The following rules apply to type_name and type_ns
validation when xsdType is true:

* Both type_name and type_ns are specified Using the type_name and type_ns
pair, the data handler creates a corresponding java Class object. Using the
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incoming SOAP message typename and typenamespace, another java Class
object is queried. It the two java Class objects match, validation succeeds.
Otherwise, validation fails.

* Neither type_name nor type_ns are specified The data handler maps the simple
business object attribute to a java Class object. Using the incoming SOAP
message typename and typenamespace, another java Class object is queried. If
the two java Class objects match, validation succeeds. Otherwise, validation fails.

* type_name only is specified Simple Type Validation fails. Both type_name and
type_ns or neither should be specified when xsdType is true.

* type_ns only is specified Simple Type Validation fails. Both type_name and
type_ns or neither should be specified when xsdType is true

The following rules apply to type_name and type_ns validation when xsdType is
false:

* Both type_name and type_ns are specified The data handler performs a direct
comparison between the SOAP message typename and typenamespace pair and
the type_name and type_ns values specified in ASIL If the pairs are exactly alike,
validation succeeds. Otherwise, validation fails.

* Neither type_name nor type_ns are specified The data handler maps the simple
business object attribute to a java Class object. Using the incoming SOAP
message typename and typenamespace, another java Class object is queried. If
the two java Class objects match, validation succeeds. Otherwise, validation fails.

* type_name only is specified The type_ns value defaults to the element
namespace found in the business object ASI. Using this default type_ns and the
type_name specified in ASI, the data handler performs a direct comparison
between these values and the SOAP message typename and typenamespace. If
the pairs are exactly alike, validation succeeds. Otherwise, validation fails.

* type_ns only is specified The type_name value defaults to the business object
attribute type. Using this default type_name and the type_ns specified in ASI,
the data handler performs a direct comparison between these values and the
SOAP message typename and typenamespace. If the pairs are exactly alike,
validation succeeds. Otherwise, validation fails.

Complex attributes (cardinality 1 and n): The following rules apply to
type_name and type_ns validation when xsdType is true:

* Both type_name and type_ns are specified xsdType is ignored. The data
handler processes as if xsdType is false.

* Neither type_name nor type_ns are specified xsdType is ignored. The data
handler processes as if xsdType is false.

* type_name only is specified xsdType is ignored. The data handler processes as
if xsdType is false.

* type_ns only is specified xsdType is ignored. The data handler processes as if
xsdType is false.

The following rules apply to type_name and type_ns validation when xsdType is
false:

* Both type_name and type_ns are specified The data handler performs a direct
comparison between the SOAP message typename and typenamespace pair and
the type_name and type_ns values specified in ASI. If the pairs are exactly alike,
validation succeeds. Otherwise, validation fails.

* Neither type_name nor type_ns are specified The type_name value defaults to
the business attribute type. The type_ns value defaults to the element namespace
found in the business object ASI. Using this default behavior, the data handler
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performs a direct comparison between these values and the SOAP message
typename and typenamespace pair. If the pairs are exactly alike, validation
succeeds. Otherwise, validation fails.

* type_name only is specified The type_ns value defaults to the element
namespace found in the business object ASI. Using this default type_ns and the
type_name specified in ASI, the data handler performs a direct comparison
between these values and the SOAP message typename and typenamespace. If
the pairs are exactly alike, validation succeeds. Otherwise, validation fails.

* type_ns only is specified The type_name value defaults to the business object
attribute type. Using this default type_name and the type_ns specified in ASI,
the data handler performs a direct comparison between these values and the
SOAP message typename and typenamespace. If the pairs are exactly alike,
validation succeeds. Otherwise, validation fails.

attr_name and attr_ns validation
While reading SOAP message into a business object, each SOAP element is
searched for SOAP attributes. If found, these attributes are compared to the
attr_name property values from the corresponding BO. For example, consider this
SOAP message:
<CustInfo City="4" State="5" Street="2" Zip="6">

<Name xsi:type="xsd:string">1</Name>

<Street2 xsi:type="xsd:string">3</Street2>
</CustInfo>

Now consider the business object definition structure (with the attribute level ASI
specified to the right of each attribute) shown i

Marme Type App Spec Info |

B Custinfo Customerinfo

Mame String

Streett String attr_name="5Street

Strest? tring

City String attr_name=City

State Ztring attr_name="5State

Zig String attr_name=_Zip

Figure 35. attr_name and attr_ns validation

The data handler would follow these processing steps:
1. Read the element name CustInfo.
2. Resolve the business object attribute that corresponds to this element name.

3. Read the attributes of the SOAP element and attempt to match them against
the ASI of the child attributes. In this case, the SOAP message Street matches
the business object attribute Streetl, City matches the business object attribute
City and so on.

4. The child elements for CustInfo are read and processed in the same manner as
the rest of the body.

Note: attr_ns is not validated.
The data handler loops through the SOAP attributes for a given element. For each

attribute encountered, the data handler searches the business object for a
corresponding attribute. If found, the business object attribute is populated with
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the value of the SOAP attribute. If a corresponding business object attribute is not
found, the data handler continues to the next SOAP attribute.

Calling a data handler from within the SOAP data handler

The SOAP data handler can read an encoded element value from a SOAP message
into a business object using another data handler. For example, an RNIF document
may be one of the formats in which a SOAP element value is encoded. To make
use of this functionality, an RNIF business object can be added at any level of a
SOAP Child business object. To signify to the SOAP data handler that another data
handler must be used when transforming this RNIF encoded String to an RNIF
business object, you must add the dh_mimetype property to the attribute’s ASIL. The
value of the dh_mimetype ASI should be a legal mimeType specified in the
MO_DataHandler_Default business object. The mimeType is used to determine
which data handler to use on the String. For example, given the following SOAP
message where RNIFExample is the SOAP element that contains an RNIF encoded
String:

<CustInfo>

<Name>IBM Corporation</Name>

<CustID>95626</CustID>

<RNIFexample xsi:type="xsd:base64Binary">
1AWERYER238W98EYR9238728374871892787ASRIK234234JKANWER
J234AWERTJHIA23488RAHASF1AWERYER238WI8EYR923872837487
1892787ASRJIK234234JKAWERI234AWERTJHI423488RAHASF1AWER
YER238W98EYR9238728374871892787ASRIK234234JKAWERJIZ234A
WERTJHI423488R4HASF1AWERYER238WI8EYRI2387283748718927
87ASRJIK234234IKAWERJI234ANERTJHI423488RAHASFWR234

</RNIFexample>
</CustomerInfo>

The SOAP business object would look like that shown in

Mame Type App Spec Info
B Custinfao Cuztomerinfo

Matmne String
Streett String sttr_name==treet
Street2 =tring
City String attr_name=City
State String attr_name==tate
Fip String attr_name=_Zip

Figure 36. RNIFExample business object

Note that the RNIFExample element contains an RNIF encoded String as its
element value. Also, note that elem_name, elem_ns, type_name, type_ns and
xsdtype ASI properties still remain relevant for this business object attribute.

Note: If the element value returned by the called data handler is encoded text, the
type_name property must be set to base64Binary, the type_ns must
correspond to an xsd namespace, and xsdtype must be set to true.

Default business object resolution

For SOAP to business object transformations, the SOAP data handler and SAP XI
connector adhere to a special contract of exchanging information to resolve
business object names. The connector provides the SOAP data handler with a list
of business object names mapped to BodyName and BodyNamespace pairs. In
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addition, if there is a defaultfault business object set in the TLO, this information is
passed to the data handler. Given this information, the SOAP data handler
processes using the following steps:

1. The data handler receives a SOAP message

2. The data handler determines if this is a SOAP request, response or fault
message.

a. If a SOAP request or response message, the data handler reads the
BodyName and BodyNamespace from the first child element of the
SOAP-ENV:Body element.

b. If a SOAP fault message, the data handler reads the BodyName and
BodyNamespace from the first child element of the detail element in the
fault message. If there is no detail element in the fault message, the data
handler uses the defaultfault business object for this transformation

3. If a defaultfault business object has not already been chosen, the data handler
attempts to match the BodyName and BodyNamespace found in step 2 to the
pairs found in the list provided by the connector. If a match is made, business
object resolution is successful. If no match is made, the data handler fails with
a meaningful error message.

Specifying a pluggable name handler

With default business object resolution, you can specify a pluggable name handler
to determine the business object to be used in SOAP-message-to-business-object
transformations. You do this by changing an
MO_DataHandler_DefaultSOAPConfig attribute.

The MO_DataHandler_DefaultSOAPConfig has, among others, two attributes of
type string that designate:

e ClassName The class name for the SOAP data handler base class. You do not
change this attribute value when specifying a pluggable name handler.

¢ SOAPNameHandler The SOAPNameHandler attribute dictates which name
handler is called. You can specify a value for a pluggable name handler. The
value of this property should be a class name. The SOAPNameHandler class is
an abstract class with the following signature:

public abstract String getBOName(Envelope msgEnv, SOAPProperty prop)

If the SOAPNameHandler attribute has a value, the SOAP data handler calls the
specified name handler. If the value does not exist, or if the specified name handler
fails to get a business object name, the SOAP data handler is called by default to
perform default business object resolution.

The SOAP DataHandler uses the SOAPNameHandler property specified in the MO
to instantiate the custom-name-handler class. It then calls the getBOName to
resolve the business object name. The SOAP DataHanlder passes the
SOAPProperty object it received from the connector to the custom-name-handler
implementation class.

This SOAPProperty object contains a structured list of potential candidate BOs for
resolution. Contained in the list are BodyName, BodyNamespace and BOName
triplets. These triplets are based on the SOAP Config MO configuration
information. The Default Name Handler uses this object to resolve the BO. A
custom name handler developer may use this object at their discretion.
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Using the SOAPProperty object

You use the SOAPPropertyUtils class to extract the business object name from the
SOAPProperty. To do so, use the following method:

[ **
* Retrieve the business object name based on the body name and the body
namespace

*
*-
* @param soapProp top level SOAPProperty object that is passed by the
* connector
* @param name body name from the SOAP message
* @param uri body namespace from the SOAP message
* @return business object name from the SOAPProperty object with the body
* name and body namespace.
*
/
java.lang.String findBOName (SOAPProperty soapProp, String name, String uri);

Sample NameHandler

The following is a sample NameHandler:package

com.ibm.adapters.datahandlers.soap.namehandlers;

// DOM and Parsers

import javax.xml.parsers.DocumentBuilder;

import org.w3c.dom.Document;

import org.w3c.dom.Element;

import org.xml.sax.InputSource;

// Apache Xerces and SOAP

import org.apache.soap.Envelope;

import org.apache.soap.Header;

import org.apache.soap.Body;

import org.apache.soap.Constants;

import org.apache.soap.util.xml.DOMUtils;

import org.apache.soap.util.xml.XMLParserUtils;

import org.apache.soap.util.xml.QName;

import org.apache.soap.encoding.soapenc.SoapEncUtils;

import org.apache.soap.encoding.soapenc.Base64;

/1 java

import java.util.Vector;

// SOAP data handler

import com.ibm.adapters.datahandlers.soap.*;

import com.ibm.adapters.datahandlers.soap.exceptions.x*;

public class MyCustomNameHandler extends SOAPNameHandler {
private static final String BOPREFIX = "MyCustomBOPrefix";
private static final char UNDERSCORE = '_';
private static final char EMPTY_STRING = "";

public String getBOName(Envelope msgEnv, SOAPProperty prop)
throws SOAPNameHandlerException
{
// Initialize a String Buffer
StringBuffer boName = new StringBuffer();
// Determine the "MyCustomBOPrefix" SOAP data handler
// MO property. If it exists, and is populated append
// this prefix to the front of the BOName.
String pref = dh.getOption(BOPREFIX);
if (pref != null) {
boName.append (pref.equals(EMPTY_STRING)
? EMPTY_STRING : pref + UNDERSCORE);

// Begin parsing the SOAP msg envelope.
Element bodyEl, requestEl;
Body msgBody = msgEnv.getBody();
Vector bodyEntries = msgBody.getBodyEntries();
if((bodyEntries == null) || (bodyEntries.size() <= 0))
throw new SOAPNameHandlerException("No Body Entries exist
for this SOAP message. Cannot determine BOName to use.");
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// Grab the first <SOAP-ENV:Body> Element
bodyEl = (Element) bodyEntries.elementAt(0);
// Grab the first Child Element of the <SOAP-ENV:Body>
// Element
requestEl = (Element) DOMUtils.getFirstChildETement(bodyEl);
// Read the name and namespace of this first child
String name = bodyEl.getLocalName();
String uri = bodyEl.getNamespaceURI();
if (uri == null)
uri = Constants.NS_URI_SOAP_ENV;
// Use the SOAPPropertyUtils findBOName() method to search
// the SOAPProperty object for this messages first element
// name and namespace. If no match is found, a
// SOAPDataHandlerException will be thrown. If a match is
// found, and it's not an empty string, append to the boname.
String returnedBOName = SOAPPropertyUtils.findBOName(prop, name, uri);
if (returnedBOName != null &&
IreturnedBOName.equals (EMPTY_STRING))
boName.append(returnedBOName) ;
return boName.toString()
1

}

Limitations

The sections below discuss data handler limitations.

SOAP style and use guidelines

SOAP messages are created using a style and use defined by the SAP XI service.
The SOAP data handler provides the levels of support shown in [Table 36

Table 36. Style and use guidelines

Data handler
Style Use Parts defined using |support
document literal element full
document literal type limited (see below)
document encoded element none
document encoded type limited (see below)
rpc literal element none
rpc literal type full
rpc encoded element none
rpc encoded type full

Part and part element order

When the SOAP data handler is transforming a SOAP message into a business
object and the SOAP message follows either the document/literal/type or
document/encoded/type formats, the message parts must be in the order
described in the WSDL. For example, consider the following WSDL:

<operation name="GetQuote"

style="document" ...>
<input>
<soap:body parts="Partl Part2 Part3 Part4" use="literal">
</input>

</operation>

<definitions
xmins:stns="(SchemaTNS)"
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xmins:wtns="(Wsd1TNS)"
targetNamespace="(Wsd1TNS) ">

<schema targetNamespace="(SchemaTNS)"
elementFormDefault="qualified">
<element name="SimpleElement" type="xsd:int"/>
<element name="CompositElement" type="stns:CompositeType"/>
<complexType name="CompositeType">
<all>
<element name='elem a' type="xsd:int"/>
<element name='elem b' type="xsd:string"/>
</all>
</complexType>
</schema>

<message...>

<part name='Partl' type="stns:CompositeType"/>

<part name='Part2' type="xsd:int"/>

<part name='Part3' element="stns:SimpleElement"/>
<part name='Part4' element="stns:CompositeElement"/>
</message>

0

</definitions>

The SOAP message must adhere to the order defined by the parts. In the SOAP
example below, notice that Partl elements precede Part2, Part3, and Part4 elements.
This order must be maintained for proper BO resolution.
<soapenv:body... xmlns:mns="(MessageNS)"
xmIns:stns="(SchemaTNS) ">
<stns:elem_a>123</stns:elem_a>
<stns:elem b>hello</stns:elem b>
<soapenc:int>123</soapenc:int>123</soapenc:int>123</soapenc:int>
<stns:SimpleElement>123</stns:SimpleETlement>
<stns:CompositeElement>
<stns:elem a>123</stns:elem a>
<stns:elem _b>hello</stns:elem _b>
</stns:CompositeElement>
</soapenv:body>

When the SOAP message follows either the document/literal/type or
document/encoded/type formats, part elements must be in order, too. In Partl of
the example above, the elem_a tag must precede the elem_b tag. This limitation is
dictated by the data handler’s business object resolution process. Since default
business object resolution for document style makes use of the first element’s body
name and namespace, these must be the same element in all SOAP messages of
this particular request, response, or fault so that the same business object is
resolved in each case.

Note: When the SOAP message follows either the document/literal /type or
document/encoded/type formats, elements must not be optional.

XML limitations
The following XML structures, features, and notation are not supported:

* Multi-dimensional arrays

* Partially transmitted arrays
* Sparse arrays

* Mixed content

* Sequence, group, and choice model group components with maxOccurs greater
than one
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Chapter 6. Enabling collaborations for request processing

« |"Request processing collaboration checklist”]

This chapter describes the steps you must follow to enable collaborations for
request processing. Collaborations use the connector to invoke SAP XI services.

Request processing collaboration checklist

Using Business Object Designer to generate business objects is part of the process
of developing collaborations. You must perform the following tasks, described in

sections below, to generate business objects that a collaboration can use to invoke
SAP XI services:

1. Identify the WSDL document either from a URL, UDDI or a file system. You
use third-party tools for this task—the SAP XI connector provides no tools for
this task.

2. Use the SAP XI Integration Developer WSDL tool to generate a WSDL
document.

3. Use the BIA_XIWSDLUIHil tool to convert the SAP XI document to a
standards-compliant WSDL document.

4. Open Business Object Designer and launch the SAP XI ODA. For further
information, see [‘Starting the SAP XI ODA” on page 121}

5. Configure the ODA.
6. Confirm your selections.

7. Generate a top-level business object that includes Request and (for synchronous
requests) Response and Fault business objects as well as SOAP Config MOs,
Protocol Config MOs, header container and child objects and
application-specific information appropriate to each object and attribute. The
WSDL ODA automates this process.

After you generate business objects, you must perform tasks to enable a
collaboration to invoke an SAP XI service using the connector and the SOAP data
handler. For steps on developing a collaboration, including creating a collaboration
template and object and binding its ports, see IBM WebSphere InterChange Server
Collaboration Development Guide. For further information on creating maps between
generic business objects and the application-specific business objects generated by
the SAP XI ODA, see IBM WebSphere InterChange Server Map Development Guide.
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Chapter 7. Exposmg collaborations as web services

“Procedure checklist”|

+ [“Identifying or Developing Business Objects” on page 110

+ |“Choosing or developing a collaboration template” on page 110

» [“Binding the port of a new collaboration object” on page 110|
* |”"WSDL Configuration Wizard” on page 112
* [“WSDL Configuration Wizard processing of business objects in TLO format” on|
page 114

* [“Processing requirements and exceptions” on page 117]

This chapter describes the design-time procedure of exposing a collaboration as an
SAP XI service. This enables the connector to process events when a web service
client invokes a collaboration.

Integrated design tools simplify the task of exposing a collaboration as an SAP XI
service. After configuring the collaboration and business objects for SAP XI
services, you use the WSDL Configuration Wizard. The wizard creates a WSDL
document and XML schema that represent the collaboration as an SAP XI service.
The WSDL outputs not only describe the collaboration but form the basis for its
invocation by an SAP XI client.

Procedure checklist

You must perform the following tasks, described in the sections below, to expose a
collaboration as an SAP XI service:

1. Identify or, as needed, develop the business objects for use as request and
optionally (for synchronous event processing) response and fault SOAP
messages. There are two ways to generate these objects: 1) manually, using
Business Object Designer, or 2) if a WSDL interface file exists for your SAP XI
service, you can use the SAP XI ODA to generate the Request and other
(Response or Fault) business objects. If you are following the second approach:
a. Specify the name of the collaboration in the Collaboration WSDL ODA
configuration property. This value dictates the ws_collab ASI in the TLO.

b. Specify either a WSDL_URL or UDDI_InquiryAP
I_URL WSDL ODA configuration property for the WSDL interface file (you
can also specify a directory path to this file, if it resides on your network or
locally).

For further information, see [“Starting the SAP XI ODA” on page 121 |

2. Develop a collaboration template or choose an existing one to use the business
objects.

3. Create the collaboration object and its ports for the SAP XI service.

You first must ensure that the collaboration object properly populates business
objects. For more information and a step-by-step procedure for creating a
collaboration object, see the Implementation Guide for WebSphere InterChange
Server.

Note: The collaboration object must have its maps configured for the

appropriate transformations. Maps convert the business object received
in the SOAP request message to the business object used by the
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collaboration. Maps also convert the business object returned by the
collaboration to the business object that is embedded in the SOAP
response message. For more information about mapping and mapping
procedures, see the Map Development Guide.
4. Use the WSDL Configuration Wizard to create the WSDL document. The utility
also configures the web services connector.

Note: The WSDL Configuration Wizard creates implementation, interface, and
one or more schema files. This document refers to these outputs
collectively as the WSDL document.

5. Publish the WSDL document as required.

Note: The connector provides neither tools nor support for publishing WSDL
documents.

Identifying or Developing Business Objects

You use Business Object Designer to create business objects and Connector
Configurator to configure the connector to support them.

For more information on Business Object Designer, see the Business Object Designer.
For detailed information on web services business objects, see (Chapter 3, “Business|
fobject requirements,” on page 17

Choosing or developing a collaboration template

The collaboration template you choose or develop must have one or more
scenarios to expose as an SAP XI service. For further information on collaboration
templates, see Collaboration Development Guide.

Binding the port of a new collaboration object

After you have configured the port of a collaboration template for a business object
type you must create the collaboration object and bind its port to an instance of an
SAP XI connector.

To create a new collaboration object and bind its port to an instance of the SAP XI
connector:

1. Right click the Collaboration Objects folder and select Create New
Collaboration Object. This displays the Create New Collaboration window,

which displays the list of templates (as shown in [Figure 37).
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Create New Collaboration

Create Mew Collaboration
Specify hove to bind ports to connectors and collaborstion okjects.

Find: | x| -]
Template name | Description
CLIEMT_ASYMNCH_Order _Collab_Template Cliert Callaboration to invoke Order Weh Service asynch..
CLIEMT _SYNMCH_OrderStatus_Collab_Template Cliert Caollaboration to invoke OrderStatus Wweb Service ..
SERVICE_ASYNCH_Order _Collab_Template Order caollahoration will be exposed as YWieh Service far ...
SERWICE_SYMNCH_Order Status_Collab_Template Order Status collaboration will be exposed as Weh Servi...
WiebServiceConnTemplste

Selected Collskaration templste: | CLIEMT_S%MCH_OrdetStatus_Collak_Template

Collaborstion object name: I OrderStatusSynch[_Collab

= Back I Mext = I Eimizh Cancel

Figure 37. Create New Collaboration window

2. Select a collaboration template from the Template Name and enter a name for
the collaboration object in Collaboration object name field. This displays the

Bind Ports window as shown in

Select collaboration template

Bind ports
Specify howe to bind ports to connectors and collaboration objects.

| Port | Business object Definition Type BinchAith
1 From CLIEMT_SYMCH_TLO_CrderStatus  Weh Service Mo ;l
2 To CLIEMT _SYMCH_TLO _COrderStatus  |Connector Mone

Figure 38. Bind Ports window

3. Select a port, click the Type arrow to display the pull down menu for the port
and choose WebSerivce (as shown in [Figure 38)

All instances of the web services connector have a ConnectorType
application-specific property. By default, this property is set to WebService. The
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Bind Collaborations Port window in System Manager uses the value of the
ConnectorType property to determine which connectors are web service
connectors.

4. Click the BindWith arrow to display a list of connector instances. System
Manager displays instances of connectors whose ConnectorType properties
have values set to WebService. Choose an instance of the SAP XI connector.

5. Click Finish.

You are now ready to run the WSDL Configuration Wizard.

WSDL Configuration Wizard

After you have created the collaboration object and bound its triggering port to an
instance of an SAP XI connector, you are ready to use the WSDL Configuration
Wizard. Using binding, port name, operation and other data you specified for the
collaboration, business object definition, and connector, the utility produces the a
WSDL implementation file (*.imp1.wsd1), a WSDL interface file (*.wsd1), and an
xml schema file (*.xsd). These files are a composite of the collaboration exposed as
an SAP XI service, and the utility allows you to specify whether to generate these
as separate files or as one file. The utility supports SOAP over HTTP and HTTPS
protocols. Configuration information for the protocol listener framework is
retrieved from the connector-specific property ProtocolListenerFramework. This
property also makes the list of listeners available.

Running the wizard
To run the WSDL Configuration Wizard:

1. Right-click a collaboration object that you have configured for web services and
choose Expose as a web service in the popup menu. The WSDL Configuration
Wizard displays as shown in |Ei§ure 39
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Figure 39. WSDL Configuration Wizard

As shown in the columns are as follows:

* Port (Connector) The triggering port on the collaboration object that is
bound to an SAP XI connector. The wizard gets this information from the
collaboration object.

* Operation If the business object is a TLO, the wizard gets this information
from the Request business object’s SOAP Config Mo BodyName attribute. If
the business object is a non-TLO, then the wizard combines the business
object name and the port name.

* Business Object Used to create the schema. The wizard gets this information
from the connector’s supported business objects for this triggering port.

2. Enter the following as needed:

* Service Name By default, the name you used to describe the collaboration
object

* Directory Name Where the adapter for SAP XI and collaboration templates
and objects reside

* Target NameSpace The URL for the collaboration being exposed as an SAP
XI service.

¢ Collaboration Ports The information in these fields are as specified in the
Bind Ports window of the collaboration object configuration procedure.

* Collaboration Mode for Non-TLO This does not apply if you are using
TLOs. Otherwise, if you using a non-TLO object as input, you must specify
synchronous or asynchronous.
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* Schema and WSDL Specify whether you want these outputs in a single file
or in separate files.

3. Click Finish. The utility generates outputs based on the inputs and
specifications you entered, all of which are summarized in the next section.

WSDL Configuration Wizard processing of business objects in
TLO format

The configuration wizard creates a WSDL operation for each triggering port of a
collaboration object that is bound to an SAP XI connector. The creation of the
operation is based on the business objects that are associated with the invocation of
this collaboration.

The configuration wizard determines that a business object is in the TLO format by
reading the object-level ASI ws_eventtlo. If the ASI property is set to true, the
business object is a TLO. Using the TLO, the following WSDL properties are found:

* Operation Name and BodyNS When the wizard finds business objects in TLO
format, it creates an operation name using the BodyName property of the SOAP
Config MO within the SOAP Request business object of the TLO. Similarly, the
wizard determines the message namespace to be the BodyNS property in the
same SOAP Config MO

* Execution Mode By inspecting the ws_mode property from the business object
level ASI of the TLO, the wizard determines that the mode is either synchronous
or asynchronous, and creates a REQUEST_RESPONSE or ONE_WAY WSDL,
respectively.

To create WSDL operations based on TLOs, a collaboration can be configured in
two ways, with and without maps.

TLOs with maps: A collaboration is generally configured to accept Generic
Business Object (GBO) requests. That is, the collaboration template triggering ports
subscribe to GBOs. To use TLOs in this case, the collaboration must be bound to an
SAP XI connector, and the connector must support the transformation of the GBO

to TLOs via maps. shows this scenario.

7 =D

GBO TLO |:>

Collaboration SAP XI
connector

Figure 40. TLO with map

When the collaboration and connector are configured in this way, the wizard
determines that the TLO business object will be used to create the operations
described in the WSDL document. This determination is made by inspecting the
connector-supported business objects and associated maps. It is important for the
run-time processing of the SAP XI connector that the configured maps always
transform the collaboration’s GBO to one and only one TLO. Also, it is important
that the source and destination business objects of the inbound map translate to
the destination and source business objects of the outbound map, respectively.

TLOs without maps: The wizard also supports processing TLOs without maps. In
this case, the collaboration template’s triggering ports subscribe to TLOs directly.
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Because the SAP XI connector supports the TLOs, maps are not required.
illustrates this scenario.

TLO |:>

Collaboration SAP XI
connector

Figure 41. TLO without map

When the collaboration and connector have been configured in this way, the
wizard uses the TLO business object found in the collaboration to create the
operations described in the WSDL document. The wizard determines that no maps
are configured for this port.

WSDL Configuration Wizard processing of business objects in
non-TLO format

Support for non-TLO business objects allows you to use pre-existing collaborations
and maps for exposing as SAP XI services. For this reason the wizard also
supports creating WSDL operations using business objects that are not in TLO
format.

Similar to the TLO process, the wizard determines that a business object is in
non-TLO format by reading the object-level ASI ws_eventtlo. If the ASI property
does not exist or exists but is set to something other than true, this business object
is a non-TLO. A non-TLO is any business object that does not adhere to the web
services TLO structure. Using the non-TLO, the wizard discovers the following
properties:

* Operation Name and BodyNS When the wizard finds business objects in
non-TLO format, it creates an operation name using a combination of the
collaboration name, the business object name, and the port name. The Body
Namespace for the WSDL operation is configured using the Target Namespace
entry in the WSDL Configuration Wizard.

*  WSCollaborations The wizard creates a hierarchy of properties in the SAP XI
connector that includes a BO Name, a SOAP Body Name, a SOAP Body
Namespace, and a Mode for each WSDL operation in a port of a collaboration
that is exposed as an SAP XI service. shows a sample
WSCollaborations property:
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A

Figure 42. WSCollaborations

* Execution Mode The Execution mode for the WSDL operation is configured
using the Collab Mode for Non-TLO selection button in the WSDL
Configuration Wizard.

To create WSDL operations based on non-TLOs, a collaboration can be configured
in two ways, with and without maps.

Non-TLOs with maps: Collaborations are generally configured to accept Generic
Business Object (GBO) requests. At the same time, there may be pre-existing maps
that transform the GBO from the collaboration to a non-TLO business object.

Figure 43| shows this scenario.

GBO non-TLO |:>

Collaboration SAP XI
connector

Figure 43. Non-TLO with map

In this case, the wizard uses the non-TLO business object to create WSDL
operations described in the WSDL document. It is important for the run-time
processing of the SAP XI connector that the configured maps always transform the
collaboration’s GBO to one and only one non-TLO. Also, it is important that the
source and destination business objects of the inbound map translate exactly to the
destination and source business objects of the outbound map respectively.

Non-TLOs without maps: In highly specialized cases, collaborations may be
configured to accept requests from business objects other than GBOs. In this case,
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the non-TLO is a direct business object for the collaboration, and no maps exist.

Figure 44{shows this scenario.

non-TLO |:>

Collaboration SAP XI
connector

Figure 44. Non-TLO without map

In this case, the wizard determines that no maps are configured for this port, so it
uses the non-TLO business object to create WSDL operations described in the
WSDL document.

Processing requirements and exceptions

The sections below discuss requirements of the WSDL Configuration Wizard that
apply to all types of objects (TLOs and non-TLOs) unless otherwise explicitly
mentioned. For further information on business object requirements for SAP XI
TLOs, see [Chapter 3, “Business object requirements,” on page 17.|

Note: Among the business object ASI that the WSDL tool reads, only the following
can have internationalized characters:

* elem_name
* elem_ns

* attr_name
e attr_ns

* BodyName
* BodyNS

* type_name

* type_ns

Support for Use property in SOAP Config MO: The WSDL Configuration
Wizard supports the Use property in SOAP Config MOs, but throws an error if the
Use value in a SOAP Request BO and the corresponding SOAP Response BO are
different. You can set the Use value to literal or encoded to generate a WSDL
document. For more information on the Use property and its values, see
[Use impact on SOAP messages” on page 77|

Support for Style in SOAP Config MO: Only rpc style is supported for exposing
collaborations as SAP XI services. If the Style is specified as document in the SOAP
Config MO, the wizard will throw an error.

Fault processing: The details attribute inside a SOAP Fault business object can
have one child attribute only. Otherwise, the utility generates an error.

The utility accepts Fault business objects. If it encounters multiple Fault business
objects, the utility processes the header container of the first or default fault
business object. Processing is as follows:

¢ No Namespace is specified for the soap:fault element inside the binding section.

* Fault is always specified using the document style and use literal.
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* Message parts are specified using the element attribute.

Header fault processing: A header fault is processed as soap:headerfault, a child
element of soap:header inside the WSDL document binding section. The header
fault is processed using the headerfault ASI specified in the header child business
object as follows:

* No Namespace is specified for the soap:headerfault element.
* A header fault is always specified using the document style and use literal.

* Message parts are specified using the element attribute instead of the type
attribute.

Header Processing: Multiple header attributes are specified as SOAP header child
business objects inside a SOAP header container business object. A Header
container business object is identified by its ASI: soap_Tocation=S0APHeader.
During utility processing, a soap:header element is created inside binding section
for each of the attributes inside the header container business object and the
following rules apply:

* The header is always specified using document style and use literal.

* Message parts are specified using the element attribute instead of the type
attribute.

* If no elem_ns is specified, headers are written to the Body Namespace.

Note: The header container business object can be a child of SOAP Request,
Response or Fault business objects. The namespace attribute is not specified
for the soap:header element.

elem_ns ASI processing: The utility ignores elem_ns ASI at the message part
level. Instead, elem_ns is used in second- and lower-level attributes. Second- level
business object attributes can be defined in a separate namespace if elem_ns is
specified.

HTTP protocol processing: A sample port section from a WSDL document is
shown below:

<service name="StockQuoteWebService">

<port name="StockQuoteWebServicePort" binding="intf:StockQuoteBinding">
<soap:address location="http://lTocalhost:8080/wbia/webservices/stockquoteservice"/>
</port>

</service>

The WSDL Configuration Wizard uses the value of host name and the port from
the context path. If the context path contains only the relative path without the
host name and port, then the value of host name and port property located under
the Listener HTTP configuration property will be used to specify the location
attribute in soap:address xml element.
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Chapter 8. Usmg the SAP Xl ODA
* [“Running the BIA_XIWSDLUEil tool” on page 120
* |“Starting the SAP XI ODA” on page 121
* |“Running the SAP XI ODA” on page 121
¢ [“Configuring the agent” on page 122

+ [“Specifying the WSDL document” on page 124

* [“Confirming selections” on page 124

* [“Generating the objects” on page 125|

* [“Limitations” on page 125

Note: The SAP XI Object Discovery Agent (ODA) is used for generating business
objects for request processing and, when a WSDL Interface file is available,
for event processing.

Collaborations use the connector to invoke SAP XI services. Or you can expose

collaborations as SAP XI services. SAP XI services are described using WSDL (Web

Services Description Language). This chapter describes how to use the SAP XI

Object Discovery Agent (ODA) to generate business objects. The connector and

SOAP data handler use these business objects when collaborations invoke an SAP

XI service and when exposing collaborations as SAP XI services.

You use the SAP XI ODA to generate business objects for two purposes:

1. The SAP XI ODA can take a WSDL implementation file and generate business
objects for a collaboration to invoke an external web service.

2. The SAP XI ODA can take a WSDL interface file and generate business objects
for a collaboration that is exposed as an SAP XI service.

The procedure for generating business objects using the SAP XI ODA is as follows:
1. Use the native SAP XI Integration Developer-Design tool to generate a WSDL.

Note: This step is described in SAP documentation. Please refer to it. For a
brief description of the steps, see also|Appendix C, “Quick Steps,” on|

2. Use the BIA_XIWSDLUHil tool that is installed with the SAP XI adapter to
convert the native SAP-generated WSDL. The output is a standards-compliant
WSDL document that you can use with the SAP XI ODA. For information, see
[“Running the BIA_XIWSDLUil tool” on page 120.|

3. Use the SAP XI ODA to generate TLOs suitable for deployment with the SAP
XI adapter. For further information, see [“Starting the SAP XI ODA” on pagd
-121.

You can launch the SAP XI ODA when you use the Business Object Designer. The
SAP XI ODA reads a WSDL document that has been converted by the
BIA_XIWSDLUil tool and creates the business objects required by the connector
and SOAP data handler. The SAP XI ODA simplifies the job of business object
development.

Note: The SAP XI ODA handles SOAP/HTTP bindings in a WSDL.
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Running the BIA_XIWSDLUtil tool

The BIA_XIWSDLUtil is a command-line tool that converts SAP XI generated
WSDL files to standards-compliant WSDL files. The outputs are WSDL files that
the SAP XI ODA can use to generate TLOs for use with the adapter.

Note: Before proceeding with this step, you must first use SAP XI tools to generate

WSDL files. For further information, see the SAP XI documentation. In
addition, the WBI Adaper Frame work and SAP XI adapter must be
installed.

To start the BIA_XIWSDLUtil tool:

1.
2.

Open a command prompt window or shell.

Navigate to the directory containing the SAP XI adapter. The directories may be
as follows (see|“Installed file structure” on page 11):

* Windows C:\WebSphereAdapters\Connectors\SAPXI

* UNIX /home/WebSphereAdapters/Connectors/SAPXI
Make sure that the following files are in this directory:

e BIA_XIWSDLUtil.bat (.sh for UNIX) are in this directory.
e SAPXIHeaders.xsd

» SAPXIRFCHeaders.xsd

e SAPXISystemError.xsd

Copy the WSDL file (for example, SalesOrder_GetList.wsdl) that you
generated using the SAP XI Integration Developer - Design tool to this folder.

Identify the URL on which the SAP XI connector is listening for the requests
(for example, http://sapxi:4444/myservice/ws).

Choose an output file name (for example, SalesOrder_GetList_out.wsd1). You
may want to include the SAP interface function name to clearly associate it
with the actual SAP BAPI/IDOC call.

At the command line prompt, enter the following:

BIA_XIWSDLUti1 <input_filename> <SAPXI_URL> <output_filename>

where:

* <input_filename> is the name of the WSDL file that you generated using the
SAP XI Integration Developer-Design tool.

e <SAPXI_URL> is the URL on which the SAP XI connector is listening for the
requests

* <output_filename> is the name you have chosen for the WSDL file that is
ready for use with the SAP XI ODA.
For example:

BIA XIWSDLUti1 SalesOrder GetList.wsdl http://sapxi:4444/myservice/ws
SalesOrder_GetList_out.wsdl

The program returns to the command prompt after successfully creating the
new WSDL file.

Copy the output file to the SAP XI ODA directory, which may be WBIAdapters
Home/ODA/SAPXI.
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Starting the SAP Xl ODA

You can start the SAP XI ODA using one of the following scripts:
* Windows
— start_SAPXIODA bat

Note: You can also start the SAP XI ODA using the shortcut that the Installer
automatically creates for Windows environments.

e UNIX
— start SAPXIODA .sh

You select, configure, and run the SAP XI ODA using Business Object Designer.
Business Object Designer locates each ODA by the name specified in the
AGENTNAME variable of each script or batch file.

Running the SAP XI ODA

An Object Discovery Agent (ODA) simplifies the work of building business objects
for request processing. Business Object Designer provides a graphical interface to
all available ODAs, and helps you find the agent you need. The SAP XI ODA is
named, by default, SAPXIODA. The name as it appears in the WSDL Wizard
depends on the value of the AGENTNAME variable in the start_SAPXIODA.bat or
start_SAPXIODA.sh file. For more on ODAs and business object definitions and
how to configure, start and use ODAs, see the IBM WebSphere Business Object
Development Guide. You are encouraged to consult that document as needed while
following the procedures below.

After starting the Object Discovery Agent, follow these steps to launch the SAP XI
ODA:

1. Open Business Object Designer.

2. From the File menu, select the New Using ODA... submenu. Business Object

Designer displays the Select Agent dialog box in the Business Object Wizard.
illustrates this window.

3. Click the Find Agents button to display all running agents and select the WSDL
ODA.
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Business Object Wizard - Step 1 of 6 - Select Agen - |Elli|

Press "Find Agents" to locate ODAs Located agents:
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< Back I Mext » I Cancel

Figure 45. Select Agent window

If Business Object Designer does not locate your SAP XI ODA, check the setup
of the ODA.

4. Select the SAP XI ODA in the Located Agents pane list and click Next.

This displays the Configure Agent wizard window, which shows the
configuration properties you need to specify.

Configuring the agent

shows the Configure Agent window of the SAP XI ODA Business Object
Wizard.
lists the properties you must configure for the SAP XI ODA.

Business Dbject Wizard - Step 2 of 6 - Configure Agenk - | Ellll
~ Profile:
Current profile:
Save | Hew | BRemove
Property Value Type Desgcription

1 WSDL_LRL CHUBMNebSpherelCEWD | String WSDL location URL or Absolute file path

2 UDDI_Inguiry &P1_L String DD Inguiry AP1URL

3 WiehServiceProvid String Matne of the Weh Service Provider

4 WebService String Mame of the Web Service inWSDL file

El MimeType =mlizoap String The mime type for the DataHandler to invo

[ BOPrefix SOAP_ String Default prefix for the gensrated business

7 BOverh Create String Default business ohject verb

& | Collaboration String Collaboration to invoke for synchronous In
] GeneratelinigueB String Whether natnes of the BOs, correspondin
10 |Sospersion String S0P Yersion for which the BOs will be

11 | TraceFileMames CHBMIehSpherelCSVD | String Mame of the trace file

12 | Tracelevel 5 Integer Trace level for the agert

13 |Messagefile SAPRIODAAyent txt String Name of the error and message file, relst

4| | i

¢ Back I Mext > I Cancel |

Figure 46. Configure Agent window

Note: The first time you use the SAP XI ODA, you must specify values for each
configuration properties. After doing so, you can save the property values in
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a profile by clicking the Save button. The next time you use the SAP XI
ODA, you can select the saved profile from the “Select profile” box.

Table 37. WSDL ODA configuration properties

Property

Type

Required

Default

Description

WSDL_URL

String

Yes, when not
specifying a
UDDI

None

The URL of the SAP XI
document. This value can
also be set to the absolute
path to a local WSDL file.
You can specify the URL
in a native language.

UDDI_InquiryAP
I_URL

String

Yes for UDDI

None

The URL of the UDDI
inquiry APL

WebServiceProvider

String

Yes for UDDI

None

The name of the target
web service provider.
This is normally the
Business name as
published on the UDDI
registry. This entry is case
sensitive and requires
English characters only.

WebService

String

Yes for UDDI

The name of the SAP XI
service. This entry is case
sensitive and requires
English characters only.

MimeType

String

xml/soap

The mime type of the
data handler that the
connector invokes. This is
set in the business object
TLO as the default value
and must be in English
characters only.

BOPrefix

String

SOAP_

This is appended to the
front of every business
object created. User
configurable (English
characters only) up to
eight characters.

BOVerb

String

Yes

Create

The verb set in the SOAP
Config MO of the
Request, and, optionally,
Response, and Fault
business objects.

Collaboration

String

No

None

This value dictates the
ws_collab ASI in the TLO
and is mandatory when
generating objects for
event processing.

GenerateUniqueBOs

Sring

No

true

If this property is true,
the business object names
will be unique among all
web services. If this
property is false, you can
reuse the business objects
among operations with
the same part types.
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Table 37. WSDL ODA configuration properties (continued)

Property Type Required Default Description

SOAPVersion String No 1.1 Determines the SOAP

standard used to generate
BOs. Possible values are
1.1 and 1.2.

The next section describes how to specify the WSDL document in the Configure
Agent window.

Specifying the WSDL document

SAP XI business objects are generated from WSDL documents (that have been
processed by the BIA_XIWSDLUil tool). This section shows you how to select and
specify the source of a WSDL document in the Configure Agent window of the
ODA.

The WSDL document resides on the local file system. You specify where the WSDL
document resides and the SAP XI ODA retrieves it.

To specify the WSDL document:

1.

Enter the location of the WSDL file that you generated using the
BIA_XIWSDLUil tool as the value in the configuration property WSDL_URL.
Although this document is on the local file system, you can use URL syntax
(for example: file://C:/test/wsdl) or an absolute path (for example:
C:\test\wsdl). You must ensure that the ODA has access to this document and
its dependenciesdirectory and filename for the WSDL file The ODA then
retrieves the list of SAP XI services from the WSDL document.

Click Next.

The ODA queries the URL for the web service provider and retrieves the list of
services defined in the WSDL at this URL location and then displays the list.

Note: The WSDL ODA displays the ports that have SOAP/JMS or
SOAP/HTTP bindings only and excludes other types of bindings.

Select one and only one of the operations from the list for the port (the
selectable operations are highlighted). You cannot select the service or port
nodes, which are for display purposes only. Note that WSDL operations may be
of several types: ONE_WAY, REQUEST_RESPONSE, SOLICIT_RESPONSE, and
NOTIFICATION. The WSDL ODA supports and displays only
REQUEST_RESPONSE and ONE_WAY operations.

4. Click Next and go to [“Confirming selections.”]

Confirming selections

After selecting an SAP XI operation source, the SAP XI ODA Business Object
Wizard displays a confirmation screen:

1.

Confirm your selections.

2. Click Next and go to ['Generating the objects” on page 125
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Generating the objects

After you confirm your WSDL document sources, the SAP XI ODA generates the
business objects and meta-objects for the web service you wish to invoke or for the
collaboration you want to expose as an SAP XI service.

Note: The SAP XI ODA cannot automatically select a key attribute for the top-level
business object. For business objects at all other levels, the SAP XI ODA sets
the first attribute as the key. Accordingly, when you save SAP XI
ODA-generated objects in Business Object Designer, an error message
informs you that the top-level object is missing a key attribute. Assign a key
attribute that reflects your business data and business object requirements,
then re-save the objects. Use caution when selecting the key attribute; it is
used in event sequencing and may lead to performance issues if not selected
carefully.

1. Check Save business objects to a file, or check Open the business objects in
separate windows. The latter choice launches the Business Object Designer and
opens the business objects in that application.

2. Check Shutdown ODA and click Finish.

Business Object Wizard - Step 6 of 6 - Save busi — |E||i|

Buziness object definitions were successfully created. Y'ou can save them to a
praject, a fils or bath,

[ iSave a copy of the business object definitions to a separate fil

[~ Dpen the new business object definitions in separate windows

[ Shutdown ODA SARXIODA

< Back I Finizh I Cancel

Figure 47. Save window

For request processing, the call to the web service must have a request and, if
synchronous, a response and fault messages. For event processing, the
collaboration exposed must have a request and, if synchronous, a response and
fault messages. The SAP XI ODA generates business objects for each of these
including the application-specific information (ASI) at every level as well as SOAP
data handler, and protocol Config MOs. The SOAP bindings in WSDL document
determine the structure of SOAP message. For more on business object structure,
see [Chapter 3, “Business object requirements,” on page 17

Limitations

describes SAP XI ODA support for various combinations of attributes
style, use, and part definitions using type and element.
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Table 38. SAP XI ODA limitations

Style/Use/Parts defined using Description
rpc/encoded/type Supported
rpc/encoded/element Supported
rpc/literal /type Supported
rpc/literal /element Supported
doc/encoded/type Not supported
doc/encoded/element Not supported
doc/literal/type Supported
doc/literal/element Supported

The SAP XI ODA can retrieve WSDL files that are completely self-contained (in one
file) or are separated into an implementation file containing the service element, an
interface file containing all the other WSDL elements including types, messages,
portTypes, and bindings, and one or more files for the schemas. The SAP XI ODA
is not able to successfully retrieve WSDL files that have more than one interface
file, for example, with messages and portTypes in one file and bindings in another
file.

Schema in the WSDL document must be self-contained in terms of namespace
prefixes. You cannot use a namespace prefix that is defined in the
<definitions>/<types> element of the WSDL document in the <schema> element
that is a child of the <types> element. You need to re-define the namespace prefix
on the <schema> element if it is to be used in the sub-elements of the <schema>
element. The following is an example of a schema that is not self-contained:
<definitions xmins="http://schemas.xmlsoap.org/wsd1/" xmlns:NS="NS">
<types>
<schema xmins="http://www.w3.0rg/1999/XMLSchema">
<element name="NSElem" type="NS:NSType"/>
</schema>
</types>
</definitions>

Namespace prefix NS is defined on the <definitions> element and is used without
re-definition on the <schema> element. Hence the SAP XI ODA will throw an error.
To work around this limitation, re-define the namespace prefix NS on the <schema>
element as shown below:

<definitions xmins="http://schemas.xmlsoap.org/wsd1/" xmins:NS="NS">
<types>
<schema xmlns="http://www.w3.0rg/1999/XMLSchema" xmlns:NS="NS">
<element name="NSElem" type="NS:NSType"/>
</schema>
</types>
</definitions>
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Chapter 9. Troubleshooting

The chapter describes problems that you may encounter when starting up or

running the connector.

Start-up problems

Problem

Algorithm Not Supported/Algorithm "SSL’ not available

Error loading keystore:Keystore file path:"<path>"
incorrectly specified:KeyStore not found

KeyManagementError: KeyStore is tampered with,
KeyManagement error

Error loading certificates from keystore

Error creating the server socket, terminating: error

KeyManagementError:UnrecoverableKeyException, Keys
could not be recovered

Potential solution / explanation

This error occurs when the SSL version specified in the
connector configurator is not supported by your JSSE
provider. Solution: check JSSE provider’s documentation
for the supported SSL versions. For IBM JSSE make sure
your java.security file in the ProductDir/lib/security
directory has the following entry

security.provider.<number>=com.ibm. jsse.
IBMJSSEProvider

where <number> is the preference order for loading the
security provider.

This error occurs if you specify an incorrect path for the
keystore and/or truststore files. Solution: check the
keystore file path specified in the SSL->KeyStore property
in the Connector configurator. Also, if you are using
truststore, check the truststore file path specified in
SSL->TrustStore property in the Connector configurator.
This error occurs if your keystore and/or truststore have
been tampered with or otherwise corrupted. This error
may also occur if you have specified an incorrect value
for the password. Solution: ensure that the keystore has
not been tampered. Try recreating the keystore. Also
make sure you have entered a correct password in the
SSL->KeyStorePassword and SSL->TrustStorePassword
connector properties.

This error occurs if your certificates and/or keystore,
truststore have been tampered with. This error may also
occur if you have specified an incorrect value for the
password. Solution: check to see if the certificate, keystore
or truststore have been tampered with. Also, ensure that
you have specified a correct password in the
SSL->KeyStorePassword and SSL->TruststorePassword
connector properties.

This error occurs if the SOAP/HTTP or SOAP/HTTPS
protocol listener cannot bind to the port specified in
connector properties. Solution: check the ports specified
for all of the SOAP/HTTP and SOAP/HTTPS protocol
listeners. If the same port is specified for more than one
listener, only one of the listeners can start up.
Additionally, check if you have any other service running
on that port. If so, then you may want to choose a
different port for the protocol listeners.

This error occurs if the keystore or truststore cannot be
used. Solution: create a new keystore.
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Problem
SSL Handshake Exception: Unknown CA

You notice excessive JSSE logging in your log file.

You have specified a protocol listener but the listener is
not getting initialized; you see the following warning
message in the connector:

Skipping Protocol Listener Property Set
"SOME_LISTENER_NAME" with protocol property "":
unable to determine the protocol Tistener

class.]

You have specified a protocol handler, but it is not
getting initialized; you see following warning
message in the connector.

Unable to determine the type of the
handler; skipping initializing of current
handler. Handler property details:
Name: <Handler Name>;
Value:

Name: Protocol; Value:

Name: ResponseWaitTimeout; Value:

Name: ReplyToQueue; Value: .]
java.lang.NoClassDefFoundError:
Javax/jms/JMSException...
Fail to Tookup, queue: "InProgressQueue"
for specified queue name: "<queue name>"
queue using JNDI "<queue name>""
javax.naming.NameNotFoundException:
<queue name>

Error in initializing, JNDI Context is not initialized, user
can not use JMS protocol

Error in getting initial context

Potential solution / explanation

This occurs if you do not have a CA certificate in your
truststore. Solution: check whether the CA’s certificate, as
well as its self-signed certificates, reside in the truststore.
Also, ensure that the DN of the certificate has the host
name (preferably the IP address).

If you do not want to see all of the underlying JSSE
details on your console, set the value of SSL->SSLDebug
property in the connector configurator to false.

The connector was unable to extract a valid value for the
Protocol property of the protocol listener. Valid values are
soap/http, soap/https, or soap/jms. Solution: this is not
an error condition. However, if you want the connector to
use this listener, specify a valid Protocol property value.

The connector was unable to extract a valid value for the
Protocol property of the handler. Valid values are
soap/http, soap/https, or soap/jms. Solution: This is not
an error condition. However, if you want connector to
use this handler, specify a valid Protocol property value.

The connector cannot find jms.jar Solution: make sure
that jms.jar is in the connector classpath.

If you are using SOAP/JMS web services with the
connector, then this problem occurs when you do not
create queues. This error may also occur, if you have set
JNDI->LookupQueuesUsing]NDI to true and the
connector is not able to look up the queues using JNDI.
Solution: create the queues required by the connector. If
JNDI->LookupQueuesUsing]NDI is set to true, make sure
queues required by the connector can be looked up using
JNDL

If you have configured the connector to use a SOAP/JMS
protocol listener or SOAP/JMS protocol handler, you
must specify JNDI properties. Solution: make sure that
you have specified required JNDI connector-specific
properties. Refer to your JNDI provider documentation to
determine the libraries and jar files required to connect to
your JNDI provider. Make sure all of the required jar files
are in the classpath of the connector. Also, make sure all
of the required libraries are in the path of the connector.
If you have configured the connector to use a SOAP/JMS
protocol listener or a SOAP/JMS protocol handler, you
must specify JNDI properties. This error may also occur if
you have not specified JNDI properties correctly. Solution:
check the JNDI properties. Make sure your JNDI is
configured properly. Refer to your JNDI provider
documentation to determine the libraries and jar files
required to connect to your JNDI provider. Make sure all
of the required jar files are in the classpath of the
connector. Also, make sure all of the required libraries are
in the path of the connector.
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Run-time errors

Problem

Error parsing HTTP response:Reached end of stream
while reading HTTP response header

Error in the url mentioned , unable to extract host
and port details ,destination is wrong <destination
URL>

Failure in sending event business object <BO Name> with

verb <Verb> to the broker. Received execution status "-1"

and error message:

MapException: Unable to find the map to map

business objects <BO Name> for the connector
controller WebServicesConnector

Failed to transform a soap request into a request business
object. Soap Fault:

Failure in generating request object -
no verb could be set on the request bo

Potential solution / explanation

This error occurs when the connector invokes a
SOAP/HTTP web service. It occurs because your target
web service sent an incorrect HTTP response. Solution:
make sure your target SOAP/HTTP web service end
point address is correct.

This error occurs when the connector invokes an
SOAP/HTTP Web Service. It occurs because you have
specified an incorrect end point address for the
SOAP/HTTP web service. Solution: make sure you have
specified the correct end point address for the web
service.

This error occurs when the integration broker fails to
process the event because the collaboration to which the
connector is sending the event synchronously either does
not exist or does not accept the business object verb.
Solution: if you are using a web services TLO for event
notification, examine the ws_collab object-level ASI of the
TLO. (The name of the TLO is given in the error
message.) Check the value of the ws_collab ASI. Make
sure this collaboration exists and is running. If ws_mode
BO level ASI is set to synch, ws_collab ASI is required.
Check the value of ws_verb object-level ASI. Make sure
the collaboration specified by the ws_collab ASI can be
triggered by the verb specified in the ws_verb ASI. If you
are using a non-TLO for event notification, examine the
WSCollaborations connector property. Find the
collaboration that will be invoked synchronously by this
business object. Make sure this collaboration exists and is
running.

This error occurs during event notification when the
connector is unable to determine the verb of the business
object that the connector is attempting to send to the
integration broker. Solution: if you are using a web
services TLO for event notification, make sure you have
specified ws_verb object-level ASI for this TLO. Specify
the verb as the value of this ASI. If you are using a
non-TLO for event notification, the SOAP message sent
by your web service client must contain the verb element.
The SOAP data handler sets the verb of the business
object using the value of the verb element in the SOAP
message.If the web service client does not send the verb
in the SOAP message, the SOAP data handler cannot set
the verb on the business object. In this case, the connector
cannot deliver the business object to the integration
broker. If you suspect that your web service clients may
not include a verb element in the SOAP message, you
may provide a DefaultVerb verb-level ASI for this
business object. If you do so, the connector sets this verb
on the business object before sending it to the integration
broker.
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Appendix A. Standard configuration properties for connectors

This appendix describes the standard configuration properties for the connector
component of WebSphere Business Integration adapters. The information covers
connectors running on the following integration brokers:

* WebSphere InterChange Server (ICS)

* WebSphere MQ Integrator, WebSphere MQ Integrator Broker, and WebSphere
Business Integration Message Broker, collectively referred to as the WebSphere
Message Brokers (WMQI).

* WebSphere Application Server (WAS)

Not every connector makes use of all these standard properties. When you select
an integration broker from Connector Configurator, you will see a list of the
standard properties that you need to configure for your adapter running with that
broker.

For information about properties specific to the connector, see the relevant adapter
user guide.

Note: In this document, backslashes (\) are used as the convention for directory
paths. For UNIX installations, substitute slashes (/) for backslashes and
follow the conventions for each operating system.

New and deleted properties

These standard properties have been added in this release.

New properties
* XMLNameSpaceFormat

Deleted properties
* RestartCount

Configuring standard connector properties

Adapter connectors have two types of configuration properties:
+ Standard configuration properties
* Connector-specific configuration properties

This section describes the standard configuration properties. For information on
configuration properties specific to a connector, see its adapter user guide.

Using Connector Configurator

You configure connector properties from Connector Configurator, which you access
from System Manager. For more information on using Connector Configurator,
refer to the sections on Connector Configurator in this guide.

Note: Connector Configurator and System Manager run only on the Windows

system. If you are running the connector on a UNIX system, you must have
a Windows machine with these tools installed. To set connector properties
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for a connector that runs on UNIX, you must start up System Manager on
the Windows machine, connect to the UNIX integration broker, and bring up
Connector Configurator for the connector.

Setting and updating property values
The default length of a property field is 255 characters.

The connector uses the following order to determine a property’s value (where the
highest number overrides other values):

1. Default

2. Repository (only if WebSphere InterChange Server is the integration broker)
3. Local configuration file

4. Command line

A connector obtains its configuration values at startup. If you change the value of
one or more connector properties during a run-time session, the property’s Update
Method determines how the change takes effect. There are four different update
methods for standard connector properties:
* Dynamic
The change takes effect immediately after it is saved in System Manager. If the
connector is working in stand-alone mode (independently of System Manager),
for example with one of the WebSphere message brokers, you can only change
properties through the configuration file. In this case, a dynamic update is not
possible.

* Agent restart (ICS only)
The change takes effect only after you stop and restart the application-specific
component.

* Component restart
The change takes effect only after the connector is stopped and then restarted in
System Manager. You do not need to stop and restart the application-specific
component or the integration broker.

* Server restart
The change takes effect only after you stop and restart the application-specific
component and the integration broker.

To determine how a specific property is updated, refer to the Update Method
column in the Connector Configurator window, or see the Update Method column
in [Table 39 on page 133| below.

Summary of standard properties

[Table 39 on page 133 provides a quick reference to the standard connector
configuration properties. Not all the connectors make use of all these properties,
and property settings may differ from integration broker to integration broker, as
standard property dependencies are based on RepositoryDirectory.

You must set the values of some of these properties before running the connector.
See the following section for an explanation of each property.

Note: In the "Notes"column in [Table 39 on page 133} the phrase "Repository
directory is REMOTE" indicates that the broker is the InterChange Server.
When the broker is WMQI or WAS, the repository directory is set to LOCAL
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Table 39. Summary of standard configuration properties

Update
Property name Possible values Default value method Notes
|AdminInQueud| Valid JMS queue name CONNECTORNAME /ADMININQUEUE | Component | Delivery
restart Transport is
JMS
[AdminOutQueue] Valid JMS queue name | CONNECTORNAME/ADMINOUTQUEUE | Component | Delivery
restart Transport is
JMS
|AgentConnections| 1-4 1 Component | Delivery
restart Transport is
MQ or IDL:
Repository
directory
is
<REMOTE>
(broker is
1CS)
|AgentTraceLevell 0-5 0 Dynamic
|ApplicationName| Application name Value specified for the Component
connector application name restart
|BrokerType ICS, WMQI, WAS Component
restart
|CharacterEncoding]| ascii7, asciis8, SJIS, ascii7 Component
Cp949, GBK, Big5h, restart
Cp297, Cp273, Cp280,
Cp284, Cp037, Cp437
Note: This is a subset
of supported
values.
|ConcurrentEventTriggered Flows| 1 to 32,767 1 Component | Repository
restart directory
is
<REMOTE>
(broker is
1CS)
|ContainerManagedEvents| No value or JMS No value Component | Delivery
restart Transport is
JMS
[ControllerStoreAndForwardMode| | true or false true Dynamic Repository
directory
is
<REMOTE>
(broker is
1CS)
[ControllerTraceLevel| 0-5 0 Dynamic Repository
directory
is
<REMOTE>
(broker is
1CS)
[DeliveryQueus CONNECTORNAME /DELIVERYQUEUE Component | JMS transport
restart only
|DeliveryTransport] MQ, IDL, or JMS JMS Component | If
restart Repository
directory
is local, then
value is
JMS only
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Table 39. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
|IDuplicateEventElimination| true or false false Component |JMS transport
restart only: Container
Managed Events
must be
<NONE>
CONNECTORNAME / FAULTQUEUE Component | JMS
restart transport
only
hms.FactoryClassNameI CxCommon.Messaging.jms | CxCommon.Messaging. Component |JMS transport
.IBMMQSeriesFactory or | jms.IBMMQSeriesFactory restart only
CxCommon.Messaging
.jms.SonicMQFactory
or any Java class name
[ims.MessageBrokerName| If FactoryClassName is crossworlds.queue.manager Component |JMS transport
IBM, use restart only
crossworlds.queue.
manager.
If FactoryClassName
is Sonic, use
localhost:2506.
|jms.NumConcurrentRequestsl Positive integer 10 Component |JMS transport
restart only
Any valid password Component |JMS transport
restart only
Any valid name Component |JMS transport
restart only
Heap size in megabytes 128m Component | Repository
restart directory
is
<REMOTE>
(broker is
1CS)
lvmMaxNativeStackSize| Size of stack in kilobytes | 128k Component | Repository
restart directory
is
<REMOTE>
(broker is
1CS)
Heap size in megabytes Im Component | Repository
restart directory
is
<REMOTE>
(broker is
1CS)
|ListenerConcurrency| 1- 100 1 Component | Delivery
restart Transport must
be MQ
Locale en_US, ja_JP, ko KR, en_US Component
zh_CN, zh_TW, fr_FR, restart

de_DE,

it_IT, es_ES, pt_BR
Note: This is a
subset of the
supported

locales.
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Table 39. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
|ILog AtInterchangeEnd| true or false false Component | Repository
restart Directory must
be <REMOTE>
(broker is
1Cs)
IMaxEventCapacity| 1-2147483647 2147483647 Dynamic Repository
Directory must
be <REMOTE>
(broker is
1Cs)
[MessageFileName| Path or filename CONNECTORNAMEConnector.txt Component
restart
[MonitorQueue] Any valid queue name CONNECTORNAME /MONITORQUEUE Component | JMS transport
restart only:
DuplicateEvent
Elimination
must be true
[OADAutoRestartAgent| true or false false Dynamic Repository
Directory must
be <REMOTE>
(broker is
1Cs)
|OADMaxNumRetry| A positive number 1000 Dynamic Repository
Directory must
be <REMOTE>
(broker is
1Cs)
|OADRetryTimelnterval| A positive number in 10 Dynamic Repository
minutes Directory must
be <REMOTE>
(broker is
1Cs)
IPollEnd Time] HH :MM HH: MM Component
restart
[PollFrequency]| A positive integer in 10000 Dynamic
milliseconds
no (to disable polling)
key (to poll only when
the letter p is entered in
the connector’s
Command Prompt
window)
[PollQuantity| 1-500 1 Agent JMS transport
restart only:
Container
Managed
Events is
specified
[PollStartTime| HH:MM(HH is 0-23, MM is | HH:MM Component
0-59) restart
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Table 39. Summary of standard configuration properties (continued)

Update
Property name Possible values Default value method Notes
IRepositoryDirectory]| Location of metadata Agent For ICS: set to
repository restart <REMOTE>
For WebSphere
MQ message
brokers and
WAS: set to
C:\crossworlds\
repository
g Queue Valid JMS queue name CONNECTORNAME /REQUESTQUEUE Component | Delivery
restart Transport is
JMS
IResEonseQueug Valid JMS queue name CONNECTORNAME /RESPONSEQUEUE Component | Delivery
restart Transport is
JMS:
required only
if Repository
directory is
<REMOTE>
0-99 3 Dynamic
|RestartRetryIntervall A sensible positive 1 Dynamic
value in minutes:
1 - 2147483547
[RHF2MessageDomain| mrm, xml mrm Component | Only if Delivery
restart Transport is JMS
and WireFormat
is CwXML.
[SourceQueue| Valid WebSphere MQ CONNECTORNAME / SOURCEQUEUE Agent Only if
name restart Delivery
Transport is
JMS and
Container
Managed
Events is
specified
|SynchronousRequestQueue| CONNECTORNAME/ Component | Delivery
SYNCHRONOUSREQUESTQUEUE restart Transport is
JMS
|ISynchronousRequestTimeout| 0 - any number (millisecs) | 0 Component | Delivery
restart Transport is
JMS
|SynchronousResponseQueud CONNECTORNAME/ Component | Delivery
SYNCHRONOUSRESPONSEQUEUE restart Transport is
JMS
CwXML, CwBO CwXML Agent CwXML if
restart Repository
Directory is
not <REMOTE>:
CwBO if
Repository
Directory is
<REMOTE>
rVVsifSVnchronousRequestTimeoutl 0 - any number 0 Component | WAS only
(millisecs) restart
IXMLNameSpaceFormat| short, long short Agent WebSphere MQ
restart message
brokers and
WAS only
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Standard configuration properties

This section lists and defines each of the standard connector configuration
properties.

AdmininQueue

The queue that is used by the integration broker to send administrative messages
to the connector.

The default value is CONNECTORNAME /ADMININQUEUE.

AdminOutQueue

The queue that is used by the connector to send administrative messages to the
integration broker.

The default value is CONNECTORNAME/ADMINOUTQUEUE.

AgentConnections
Applicable only if RepositoryDirectory is <REMOTE>.

The AgentConnections property controls the number of ORB (Object Request
Broker) connections opened by orb.init[].

The default value of this property is set to 1. You can change it as required.

AgentTraceLevel

Level of trace messages for the application-specific component. The default is 0.
The connector delivers all trace messages applicable at the tracing level set or
lower.

ApplicationName

Name that uniquely identifies the connector’s application. This name is used by
the system administrator to monitor the WebSphere business integration system
environment. This property must have a value before you can run the connector.

BrokerType

Identifies the integration broker type that you are using. The options are ICS,
WebSphere message brokers (WMQI, WMQIB or WBIMB) or WAS.

CharacterEncoding

Specifies the character code set used to map from a character (such as a letter of
the alphabet, a numeric representation, or a punctuation mark) to a numeric value.

Note: Java-based connectors do not use this property. A C++ connector currently
uses the value ascii7 for this property.

By default, a subset of supported character encodings only is displayed in the
drop-down list. To add other supported values to the drop-down list, you must
manually modify the \Data\Std\stdConnProps.xml file in the product directory. For
more information, see the sections on Connector Configurator in this guide.
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ConcurrentEventTriggeredFlows
Applicable only if RepositoryDirectory is <REMOTE>.

Determines how many business objects can be concurrently processed by the
connector for event delivery. Set the value of this attribute to the number of
business objects you want concurrently mapped and delivered. For example, set
the value of this property to 5 to cause five business objects to be concurrently
processed. The default value is 1.

Setting this property to a value greater than 1 allows a connector for a source
application to map multiple event business objects at the same time and deliver
them to multiple collaboration instances simultaneously. This speeds delivery of
business objects to the integration broker, particularly if the business objects use
complex maps. Increasing the arrival rate of business objects to collaborations can
improve overall performance in the system.

To implement concurrent processing for an entire flow (from a source application
to a destination application), you must:

* Configure the collaboration to use multiple threads by setting its Maximum number
of concurrent events property high enough to use multiple threads.

* Ensure that the destination application’s application-specific component can
process requests concurrently. That is, it must be multi-threaded, or be able to
use connector agent parallelism and be configured for multiple processes. Set the
Parallel Process Degree configuration property to a value greater than 1.

The ConcurrentEventTriggeredFlows property has no effect on connector polling,
which is single-threaded and performed serially.

ContainerManagedEvents

This property allows a JMS-enabled connector with a JMS event store to provide
guaranteed event delivery, in which an event is removed from the source queue
and placed on the destination queue as a single JMS transaction.

There is no default value.

When ContainerManagedEvents is set to JMS, you must configure the following
properties to enable guaranteed event delivery:

* PollQuantity = 1 to 500
* SourceQueue = /SOURCEQUEUE

You must also configure a data handler with the MimeType, DHClass (data
handler class), and DataHandlerConfigMOName (the meta-object name, which is
optional) properties. To set those values, use the Data Handler tab in Connector
Configurator.

Thes properties are adapter-specific, but example values are:
* MimeType = text\xml

* DHClass = com.crossworlds.DataHandlers.text.xml

* DataHandlerConfigMOName = MO_DataHandler_Default

The fields for these values in the Data Handler tab will be displayed only if you
have set ContainerManagedEvents to JMS.
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Note: When ContainerManagedEvents is set to JMS, the connector does not call its
pol1ForEvents() method, thereby disabling that method’s functionality.

This property only appears if the DeliveryTransport property is set to the value
JMS.

ControllerStoreAndForwardMode
Applicable only if RepositoryDirectory is <REMOTE>.

Sets the behavior of the connector controller after it detects that the destination
application-specific component is unavailable.

If this property is set to true and the destination application-specific component is
unavailable when an event reaches ICS, the connector controller blocks the request
to the application-specific component. When the application-specific component
becomes operational, the controller forwards the request to it.

However, if the destination application’s application-specific component becomes
unavailable after the connector controller forwards a service call request to it, the
connector controller fails the request.

If this property is set to false, the connector controller begins failing all service
call requests as soon as it detects that the destination application-specific
component is unavailable.

The default is true.

ControllerTraceLevel
Applicable only if RepositoryDirectory is <REMOTE>.

Level of trace messages for the connector controller. The default is 0.

DeliveryQueue
Applicable only if DeliveryTransport is JMS.

The queue that is used by the connector to send business objects to the integration
broker.

The default value is CONNECTORNAME/DELIVERYQUEUE.

DeliveryTransport

Specifies the transport mechanism for the delivery of events. Possible values are MQ
for WebSphere MQ, IDL for CORBA IIOP, or JMS for Java Messaging Service.

» If the RepositoryDirectory is remote, the value of the DeliveryTransport
property can be MQ, IDL, or JMS, and the default is IDL.

* If the RepositoryDirectory is a local directory, the value may only be JMS.

The connector sends service call requests and administrative messages over
CORBA 1IIOP if the value configured for the DeliveryTransport property is MQ or
IDL.

WebSphere MQ and IDL

Use WebSphere MQ rather than IDL for event delivery transport, unless you must
have only one product. WebSphere MQ offers the following advantages over IDL:
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* Asynchronous communication:
WebSphere MQ allows the application-specific component to poll and
persistently store events even when the server is not available.

* Server side performance:
WebSphere MQ provides faster performance on the server side. In optimized
mode, WebSphere MQ stores only the pointer to an event in the repository
database, while the actual event remains in the WebSphere MQ queue. This
saves having to write potentially large events to the repository database.

* Agent side performance:
WebSphere MQ provides faster performance on the application-specific
component side. Using WebSphere MQ, the connector’s polling thread picks up
an event, places it in the connector’s queue, then picks up the next event. This is
faster than IDL, which requires the connector’s polling thread to pick up an
event, go over the network into the server process, store the event persistently in
the repository database, then pick up the next event.

JMS

Enables communication between the connector and client connector framework
using Java Messaging Service (JMS).

If you select JMS as the delivery transport, additional JMS properties such as

Jjms .MessageBrokerName, jms.FactoryClassName, jms.Password, and jms.UserName,
appear in Connector Configurator. The first two of these properties are required for
this transport.

Important: There may be a memory limitation if you use the JMS transport
mechanism for a connector in the following environment:

s AIX5.0
* WebSphere MQ 5.3.0.1
* When ICS is the integration broker

In this environment, you may experience difficulty starting both the connector
controller (on the server side) and the connector (on the client side) due to memory
use within the WebSphere MQ client. If your installation uses less than 768M of
process heap size, IBM recommends that you set:

e The LDR_CNTRL environment variable in the CWSharedEnv.sh script.

This script resides in the \bin directory below the product directory. With a text
editor, add the following line as the first line in the CWSharedEnv.sh script:

export LDR_CNTRL=MAXDATA=0x30000000

This line restricts heap memory usage to a maximum of 768 MB (3 segments *
256 MB). If the process memory grows more than this limit, page swapping can
occur, which can adversely affect the performance of your system.

e The IPCCBaseAddress property to a value of 11 or 12. For more information on
this property, see the System Installation Guide for UNIX.

DuplicateEventElimination

When you set this property to true, a JMS-enabled connector can ensure that
duplicate events are not delivered to the delivery queue. To use this feature, the
connector must have a unique event identifier set as the business object’s
ObjectEventld attribute in the application-specific code. This is done during
connector development.

This property can also be set to false.

140 Adapter for SAP XI User Guide



Note: When DuplicateEventElimination is set to true, you must also configure
the MonitorQueue property to enable guaranteed event delivery.

FaultQueue

If the connector experiences an error while processing a message then the
connector moves the message to the queue specified in this property, along with a
status indicator and a description of the problem.

The default value is CONNECTORNAME/FAULTQUEUE.

JvmMaxHeapSize

The maximum heap size for the agent (in megabytes). This property is applicable
only if the RepositoryDirectory value is <REMOTE>.

The default value is 128m.

JvmMaxNativeStackSize

The maximum native stack size for the agent (in kilobytes). This property is
applicable only if the RepositoryDirectory value is <REMOTE>.

The default value is 128k.

JvmMinHeapSize

The minimum heap size for the agent (in megabytes). This property is applicable
only if the RepositoryDirectory value is <REMOTE>.

The default value is 1m.

jms.FactoryClassName

Specifies the class name to instantiate for a JMS provider. You must set this
connector property when you choose JMS as your delivery transport mechanism
(DeliveryTransport).

The default is CxCommon.Messaging.jms.IBMMQSeriesFactory.

jms.MessageBrokerName

Specifies the broker name to use for the JMS provider. You must set this connector
property when you choose JMS as your delivery transport mechanism
(DeliveryTransport).

The default is crossworlds.queue.manager. Use the default when connecting to a
local message broker.

When you connect to a remote message broker, this property takes the following
(mandatory) values:

QueueMgrName:<Channel>:<HostName>:<PortNumber>,

where the variables are:

QueueMgrName: The name of the queue manager.

Channel: The channel used by the client.

HostName: The name of the machine where the queue manager is to reside.
PortNumber: The port number to be used by the queue manager for listening.
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For example:
jms .MessageBrokerName = WBIMB.Queue.Manager:CHANNEL1:RemoteMachine:1456

jms.NumConcurrentRequests

Specifies the maximum number of concurrent service call requests that can be sent
to a connector at the same time. Once that maximum is reached, new service calls
block and wait for another request to complete before proceeding.

The default value is 10.

jms.Password
Specifies the password for the JMS provider. A value for this property is optional.

There is no default.

jms.UserName

Specifies the user name for the JMS provider. A value for this property is optional.

There is no default.

ListenerConcurrency

This property supports multi-threading in MQ Listener when ICS is the integration
broker. It enables batch writing of multiple events to the database, thus improving
system performance. The default value is 1.

This property applies only to connectors using MQ transport. The
DeliveryTransport property must be set to MQ.

Locale

Specifies the language code, country or territory, and, optionally, the associated
character code set. The value of this property determines such cultural conventions
as collation and sort order of data, date and time formats, and the symbols used in
monetary specifications.

A locale name has the following format:
U1 _TT.codeset

where:

Il a two-character language code (usually in lower
case)

T a two-letter country or territory code (usually in
upper case)

codeset the name of the associated character code set; this

portion of the name is often optional.

By default, only a subset of supported locales appears in the drop-down list. To
add other supported values to the drop-down list, you must manually modify the
\Data\Std\stdConnProps.xml file in the product directory. For more information,
refer to the sections on Connector Configurator in this guide.
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The default value is en_US. If the connector has not been globalized, the only valid
value for this property is en_US. To determine whether a specific connector has
been globalized, see the connector version list on these websites:

http:/ /www.ibm.com/software/websphere/wbiadapters/infocenter, or
http:/ /www.ibm.com /websphere/integration/wicserver/infocenter

LogAtinterchangeEnd
Applicable only if RespositoryDirectory is <REMOTE>.

Specifies whether to log errors to the integration broker’s log destination. Logging
to the broker’s log destination also turns on e-mail notification, which generates
e-mail messages for the MESSAGE_RECIPIENT specified in the InterchangeSystem.cfg
file when errors or fatal errors occur.

For example, when a connector loses its connection to its application, if
LogAtInterChangeEnd is set to true, an e-mail message is sent to the specified
message recipient. The default is false.

MaxEventCapacity

The maximum number of events in the controller buffer. This property is used by
flow control and is applicable only if the value of the RepositoryDirectory
property is <REMOTE>.

The value can be a positive integer between 1 and 2147483647. The default value is
2147483647.

MessageFileName

The name of the connector message file. The standard location for the message file
is \connectors\messages in the product directory. Specify the message filename in
an absolute path if the message file is not located in the standard location.

If a connector message file does not exist, the connector uses
InterchangeSystem.txt as the message file. This file is located in the product
directory.

Note: To determine whether a specific connector has its own message file, see the
individual adapter user guide.

MonitorQueue

The logical queue that the connector uses to monitor duplicate events. It is used
only if the DeliveryTransport property value is JMS and
DupTicateEventETimination is set to TRUE.

The default value is CONNECTORNAME/MONITORQUEUE

OADAutoRestartAgent
Valid only when the RepositoryDirectory is <REMOTE>.

Specifies whether the connector uses the automatic and remote restart feature. This
feature uses the MQ-triggered Object Activation Daemon (OAD) to restart the
connector after an abnormal shutdown, or to start a remote connector from System
Monitor.
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This property must be set to true to enable the automatic and remote restart
feature. For information on how to configure the MQ-triggered OAD feature. see
the Installation Guide for Windows or for UNIX.

The default value is false.

OADMaxNumRetry
Valid only when the RepositoryDirectory is <REMOTE>.

Specifies the maximum number of times that the MQ-triggered OAD automatically
attempts to restart the connector after an abnormal shutdown. The
OADAutoRestartAgent property must be set to true for this property to take effect.

The default value is 1000.

OADRetryTimelnterval
Valid only when the RepositoryDirectory is <REMOTE>.

Specifies the number of minutes in the retry-time interval for the MQ-triggered
OAD. If the connector agent does not restart within this retry-time interval, the
connector controller asks the OAD to restart the connector agent again. The OAD
repeats this retry process as many times as specified by the OADMaxNumRetry
property. The OADAutoRestartAgent property must be set to true for this property
to take effect.

The default is 10.

PollEndTime

Time to stop polling the event queue. The format is HH:MM, where HH represents
0-23 hours, and MM represents 0-59 seconds.

You must provide a valid value for this property. The default value is HH:MM, but
must be changed.

PollFrequency

This is the interval between the end of the last poll and the start of the next poll.
Pol1Frequency specifies the amount of time (in milliseconds) between the end of

one polling action, and the start of the next polling action. This is not the interval
between polling actions. Rather, the logic is as follows:

* Poll to obtain the number of objects specified by the value of Pol1Quantity.

* Process these objects. For some adapters, this may be partly done on separate
threads, which execute asynchronously to the next polling action.

* Delay for the interval specified by Pol1Frequency.
* Repeat the cycle.

Set Pol1Frequency to one of the following values:
* The number of milliseconds between polling actions (an integer).

* The word key, which causes the connector to poll only when you type the letter
p in the connector’s Command Prompt window. Enter the word in lowercase.

* The word no, which causes the connector not to poll. Enter the word in
lowercase.
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The default is 10000.

Important: Some connectors have restrictions on the use of this property. Where
they exist, these restrictions are documented in the chapter on
installing and configuring the adapter.

PollQuantity

Designates the number of items from the application that the connector should poll
for. If the adapter has a connector-specific property for setting the poll quantity, the
value set in the connector-specific property will override the standard property
value.

FIX

An email message is also considerd an event. The connector behaves as follows
when it is polled for email.

Polled once - connector goes to pick 1. the body of the message as it is also
considered an attachment also. Since no DH was specified for this mime type, it it
will ignore the body. 2. conector process first PO attachment. DH is avaiable for
this mime type so it sends the business object to the Visual Test Connector. If the 3.
accept in VIC again no BO should come thru Polled second time 1. conector
process second PO attachment. DH is avaiable for this mime type so it sends teh
BO to VTC2. accept in VTC again now the third PO attachment should come
through. This is the correct behaviour.

PollStartTime

The time to start polling the event queue. The format is HH: MV, where HH represents
0-23 hours, and MM represents 0-59 seconds.

You must provide a valid value for this property. The default value is HH:MM, but
must be changed.

RequestQueue

The queue that is used by the integration broker to send business objects to the
connector.

The default value is CONNECTOR/REQUESTQUEUE.

RepositoryDirectory

The location of the repository from which the connector reads the XML schema
documents that store the meta-data for business object definitions.

When the integration broker is ICS, this value must be set to <REMOTE> because
the connector obtains this information from the InterChange Server repository.

When the integration broker is a WebSphere message broker or WAS, this value
must be set to <local directory>.

ResponseQueue

Applicable only if DeliveryTransport is JMS and required only if
RepositoryDirectory is <REMOTE>.
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Designates the JMS response queue, which delivers a response message from the
connector framework to the integration broker. When the integration broker is ICS,
the server sends the request and waits for a response message in the JMS response
queue.

RestartRetryCount

Specifies the number of times the connector attempts to restart itself. When used
for a parallel connector, specifies the number of times the master connector
application-specific component attempts to restart the slave connector
application-specific component.

The default is 3.

RestartRetrylnterval

Specifies the interval in minutes at which the connector attempts to restart itself.
When used for a parallel connector, specifies the interval at which the master
connector application-specific component attempts to restart the slave connector
application-specific component. Possible values ranges from 1 to 2147483647.

The default is 1.

RHF2MessageDomain
WebSphere message brokers and WAS only.

This property allows you to configure the value of the field domain name in the
JMS header. When data is sent to WMQI over JMS transport, the adapter
framework writes JMS header information, with a domain name and a fixed value
of mrm. A connfigurable domain name enables users to track how the WMQI broker
processes the message data.

A sample header would look like this:

<mcd><Msd>mrm</Msd><Set>3</Set><Type>
Retek_POPhyDesc</Type><Fmt>CwXML</Fmt></mcd>

The default value is mrm, but it may also be set to xm1. This property only appears
when DeliveryTransport is set to JMSand WireFormat is set to CwXML.

SourceQueue

Applicable only if DeliveryTransport is JMS and ContainerManagedEvents is
specified.

Designates the JMS source queue for the connector framework in support of
guaranteed event delivery for JMS-enabled connectors that use a JMS event store.
For further information, see [“ContainerManagedEvents” on page 138)

The default value is CONNECTOR/SOURCEQUEUE.

SynchronousRequestQueue
Applicable only if DeTiveryTransport is JMS.

Delivers request messages that require a synchronous response from the connector

framework to the broker. This queue is necessary only if the connector uses
synchronous execution. With synchronous execution, the connector framework
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sends a message to the SynchronousRequestQueue and waits for a response back
from the broker on the SynchronousResponseQueue. The response message sent to
the connector bears a correlation ID that matches the ID of the original message.

The default is CONNECTORNAME/SYNCHRONOUSREQUESTQUEUE

SynchronousResponseQueue
Applicable only if DeliveryTransport is JMS.

Delivers response messages sent in reply to a synchronous request from the broker
to the connector framework. This queue is necessary only if the connector uses
synchronous execution.

The default is CONNECTORNAME/SYNCHRONOUSRESPONSEQUEUE

SynchronousRequestTimeout
Applicable only if DeliveryTransport is JMS.

Specifies the time in minutes that the connector waits for a response to a
synchronous request. If the response is not received within the specified time, then
the connector moves the original synchronous request message into the fault queue
along with an error message.

The default value is 0.

WireFormat

Message format on the transport.
* If the RepositoryDirectory is a local directory, the setting is CwXML.
e If the value of RepositoryDirectory is <REMOTE>, the setting isCwBO.

WsifSynchronousRequestTimeout
WAS integration broker only.
Specifies the time in minutes that the connector waits for a response to a
synchronous request. If the response is not received within the specified, time then
the connector moves the original synchronous request message into the fault queue

along with an error message.

The default value is 0.

XMLNameSpaceFormat
WebSphere message brokers and WAS integration broker only.

A strong property that allows the user to specify short and long name spaces in
the XML format of business object definitions.

The default value is short.
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Appendix B. Connector Configurator

This appendix describes how to use Connector Configurator to set configuration
property values for your adapter.

You use Connector Configurator to:
* Create a connector-specific property template for configuring your connector
* Create a configuration file

* Set properties in a configuration file

Note:
In this document, backslashes (\) are used as the convention for directory
paths. For UNIX installations, substitute slashes (/) for backslashes and
follow the conventions for each operating system.

The topics covered in this appendix are:

+ |[“Overview of Connector Configurator” on page 149

* |“Starting Connector Configurator” on page 150|

+ |“Creating a connector-specific property template” on page 151

* |“Creating a new configuration file” on page 153

* [“Setting the configuration file properties” on page 156|

+ |[“Using Connector Configurator in a globalized environment” on page 162|

Overview of Connector Configurator

Connector Configurator allows you to configure the connector component of your
adapter for use with these integration brokers:

* WebSphere InterChange Server (ICS)

* WebSphere MQ Integrator, WebSphere MQ Integrator Broker, and WebSphere
Business Integration Message Broker, collectively referred to as the WebSphere
Message Brokers (WMQI)

* WebSphere Application Server (WAS)

You use Connector Configurator to:
* Create a connector-specific property template for configuring your connector.

¢ Create a connector configuration file; you must create one configuration file for
each connector you install.

* Set properties in a configuration file.
You may need to modify the default values that are set for properties in the
connector templates. You must also designate supported business object
definitions and, with ICS, maps for use with collaborations as well as specify
messaging, logging and tracing, and data handler parameters, as required.

The mode in which you run Connector Configurator, and the configuration file
type you use, may differ according to which integration broker you are running.
For example, if WMQI is your broker, you run Connector Configurator directly,
and not from within System Manager (see [“Running Configurator in stand-alone]

imode” on page 150)).
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Connector configuration properties include both standard configuration properties
(the properties that all connectors have) and connector-specific properties
(properties that are needed by the connector for a specific application or
technology).

Because standard properties are used by all connectors, you do not need to define
those properties from scratch; Connector Configurator incorporates them into your
configuration file as soon as you create the file. However, you do need to set the
value of each standard property in Connector Configurator.

The range of standard properties may not be the same for all brokers and all
configurations. Some properties are available only if other properties are given a
specific value. The Standard Properties window in Connector Configurator will
show the properties available for your particular configuration.

For connector-specific properties, however, you need first to define the properties
and then set their values. You do this by creating a connector-specific property
template for your particular adapter. There may already be a template set up in
your system, in which case, you simply use that. If not, follow the steps in
[“Creating a new template” on page 151 to set up a new one.

Note: Connector Configurator runs only in a Windows environment. If you are
running the connector in a UNIX environment, use Connector Configurator
in Windows to modify the configuration file and then copy the file to your
UNIX environment.

Starting Connector Configurator

You can start and run Connector Configurator in either of two modes:
* Independently, in stand-alone mode
* From System Manager

Running Configurator in stand-alone mode

You can run Connector Configurator independently and work with connector
configuration files, irrespective of your broker.

To do so:

* From Start>Programs, click IBM WebSphere InterChange Server>IBM
WebSphere Business Integration Tools>Connector Configurator.

* Select File>New>Connector Configuration.

* When you click the pull-down menu next to System Connectivity Integration
Broker, you can select ICS, WebSphere Message Brokers or WAS, depending on
your broker.

You may choose to run Connector Configurator independently to generate the file,
and then connect to System Manager to save it in a System Manager project (see
[“Completing a configuration file” on page 159)

Running Configurator from System Manager

You can run Connector Configurator from System Manager.

To run Connector Configurator:
1. Open the System Manager.
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2. In the System Manager window, expand the Integration Component Libraries
icon and highlight Connectors.

3. From the System Manager menu bar, click Tools>Connector Configurator. The
Connector Configurator window opens and displays a New Connector dialog
box.

4. When you click the pull-down menu next to System Connectivity Integration
Broker, you can select ICS, WebSphere Message Brokers or WAS, depending on
your broker.

To edit an existing configuration file:

* In the System Manager window, select any of the configuration files listed in the
Connector folder and right-click on it. Connector Configurator opens and
displays the configuration file with the integration broker type and file name at
the top.

* From Connector Configurator, select File>Open. Select the name of the
connector configuration file from a project or from the directory in which it is
stored.

* Click the Standard Properties tab to see which properties are included in this
configuration file.

Creating a connector-specific property template

To create a configuration file for your connector, you need a connector-specific
property template as well as the system-supplied standard properties.

You can create a brand-new template for the connector-specific properties of your
connector, or you can use an existing connector definition as the template.

* To create a new template, see [‘Creating a new template” on page 151}

* To use an existing file, simply modify an existing template and save it under the
new name. You can find existing templates in your
\WebSphereAdapters\bin\Data\App directory.

Creating a new template

This section describes how you create properties in the template, define general
characteristics and values for those properties, and specify any dependencies
between the properties. Then you save the template and use it as the base for
creating a new connector configuration file.

To create a template in Connector Configurator:
1. Click File>New>Connector-Specific Property Template.
2. The Connector-Specific Property Template dialog box appears.

* Enter a name for the new template in the Name field below Input a New
Template Name. You will see this name again when you open the dialog box
for creating a new configuration file from a template.

* To see the connector-specific property definitions in any template, select that
template’s name in the Template Name display. A list of the property
definitions contained in that template appears in the Template Preview
display.

3. You can use an existing template whose property definitions are similar to
those required by your connector as a starting point for your template. If you
do not see any template that displays the connector-specific properties used by
your connector, you will need to create one.
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 If you are planning to modify an existing template, select the name of the
template from the list in the Template Name table below Select the Existing
Template to Modify: Find Template.

 This table displays the names of all currently available templates. You can
also search for a template.

Specifying general characteristics

When you click Next to select a template, the Properties - Connector-Specific
Property Template dialog box appears. The dialog box has tabs for General
characteristics of the defined properties and for Value restrictions. The General
display has the following fields:

* General:
Property Type
Updated Method
Description

* Flags
Standard flags

e Custom Flag
Flag

After you have made selections for the general characteristics of the property, click
the Value tab.

Specifying values

The Value tab enables you to set the maximum length, the maximum multiple
values, a default value, or a value range for the property. It also allows editable
values. To do so:

1. Click the Value tab. The display panel for Value replaces the display panel for
General.

2. Select the name of the property in the Edit properties display.
3. In the fields for Max Length and Max Multiple Values, enter your values.

To create a new property value:
1. Select the property in the Edit properties list and right-click on it.
2. From the dialog box, select Add.

3. Enter the name of the new property value and click OK. The value appears in
the Value panel on the right.

The Value panel displays a table with three columns:

The Value column shows the value that you entered in the Property Value dialog
box, and any previous values that you created.

The Default Value column allows you to designate any of the values as the
default.

The Value Range shows the range that you entered in the Property Value dialog
box.

After a value has been created and appears in the grid, it can be edited from
within the table display.

To make a change in an existing value in the table, select an entire row by clicking
on the row number. Then right-click in the Value field and click Edit Value.
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Setting dependencies
When you have made your changes to the General and Value tabs, click Next. The
Dependencies - Connector-Specific Property Template dialog box appears.

A dependent property is a property that is included in the template and used in
the configuration file only if the value of another property meets a specific
condition. For example, Pol1Quantity appears in the template only if JMS is the
transport mechanism and DuplicateEventETimination is set to True.

To designate a property as dependent and to set the condition upon which it
depends, do this:

1. In the Available Properties display, select the property that will be made
dependent.

2. In the Select Property field, use the drop-down menu to select the property
that will hold the conditional value.

3. In the Condition Operator field, select one of the following:
== (equal to)
!= (not equal to)
> (greater than)
< (less than)
>= (greater than or equal to)
<=(less than or equal to)

4. In the Conditional Value field, enter the value that is required in order for the
dependent property to be included in the template.

5. With the dependent property highlighted in the Available Properties display,
click an arrow to move it to the Dependent Property display.

6. Click Finish. Connector Configurator stores the information you have entered
as an XML document, under \data\app in the\bin directory where you have
installed Connector Configurator.

Creating a new configuration file

When you create a new configuration file, you must name it and select an
integration broker.

* In the System Manager window, right-click on the Connectors folder and select
Create New Connector. Connector Configurator opens and displays the New
Connector dialog box.

* In stand-alone mode: from Connector Configurator, select File>New>Connector
Configuration. In the New Connector window, enter the name of the new
connector.

You also need to select an integration broker. The broker you select determines the
properties that will appear in the configuration file. To select a broker:

¢ In the Integration Broker field, select ICS, WebSphere Message Brokers or WAS
connectivity.

* drop-downte the remaining fields in the New Connector window, as described
later in this chapter.

Creating a configuration file from a connector-specific
template

Once a connector-specific template has been created, you can use it to create a
configuration file:

Appendix B. Connector Configurator 153



1. Click File>New>Connector Configuration.
2. The New Connector dialog box appears, with the following fields:
* Name

Enter the name of the connector. Names are case-sensitive. The name you
enter must be unique, and must be consistent with the file name for a
connector that is installed on the system.

Important: Connector Configurator does not check the spelling of the name
that you enter. You must ensure that the name is correct.

e System Connectivity
Click ICS or WebSphere Message Brokers or WAS.
* Select Connector-Specific Property Template

Type the name of the template that has been designed for your connector.
The available templates are shown in the Template Name display. When you
select a name in the Template Name display, the Property Template Preview
display shows the connector-specific properties that have been defined in
that template.

Select the template you want to use and click OK.

3. A configuration screen appears for the connector that you are configuring. The
title bar shows the integration broker and connector name. You can fill in all
the field values to drop-downte the definition now, or you can save the file and
complete the fields later.

4. To save the file, click File>Save>To File or File>Save>To Project. To save to a
project, System Manager must be running.
If you save as a file, the Save File Connector dialog box appears. Choose *.cfg
as the file type, verify in the File Name field that the name is spelled correctly
and has the correct case, navigate to the directory where you want to locate the
file, and click Save. The status display in the message panel of Connector
Configurator indicates that the configuration file was successfully created.

Important: The directory path and name that you establish here must match
the connector configuration file path and name that you supply in
the startup file for the connector.

5. To complete the connector definition, enter values in the fields for each of the
tabs of the Connector Configurator window, as described later in this chapter.

Using an existing file

You may have an existing file available in one or more of the following formats:

* A connector definition file.
This is a text file that lists properties and applicable default values for a specific
connector. Some connectors include such a file in a \repository directory in
their delivery package (the file typically has the extension .txt; for example,
CN_XML.txt for the XML connector).

* An ICS repository file.
Definitions used in a previous ICS implementation of the connector may be
available to you in a repository file that was used in the configuration of that
connector. Such a file typically has the extension .1in or .out.

* A previous configuration file for the connector.
Such a file typically has the extension *.cfg.
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Although any of these file sources may contain most or all of the connector-specific
properties for your connector, the connector configuration file will not be complete
until you have opened the file and set properties, as described later in this chapter.

To use an existing file to configure a connector, you must open the file in
Connector Configurator, revise the configuration, and then resave the file.

Follow these steps to open a *.txt, *.cfg, or *.in file from a directory:
1. In Connector Configurator, click File>Open>From File.

2. In the Open File Connector dialog box, select one of the following file types to
see the available files:

* Configuration (x.cfg)
* ICS Repository (*.1in, *.out)

Choose this option if a repository file was used to configure the connector in
an ICS environment. A repository file may include multiple connector
definitions, all of which will appear when you open the file.

o All files (*.*)
Choose this option if a *.txt file was delivered in the adapter package for
the connector, or if a definition file is available under another extension.

3. In the directory display, navigate to the appropriate connector definition file,
select it, and click Open.

Follow these steps to open a connector configuration from a System Manager

project:

1. Start System Manager. A configuration can be opened from or saved to System
Manager only if System Manager has been started.

2. Start Connector Configurator.

3. Click File>Open>From Project.

Completing a configuration file

When you open a configuration file or a connector from a project, the Connector
Configurator window displays the configuration screen, with the current attributes
and values.

The title of the configuration screen displays the integration broker and connector
name as specified in the file. Make sure you have the correct broker. If not, change
the broker value before you configure the connector. To do so:

1. Under the Standard Properties tab, select the value field for the BrokerType
property. In the drop-down menu, select the value ICS, WMQI, or WAS.

2. The Standard Properties tab will display the properties associated with the
selected broker. You can save the file now or complete the remaining
configuration fields, as described in [“Specifying supported business object]
[definitions” on page 15§.

3. When you have finished your configuration, click File>Save>To Project or
File>Save>To File.

If you are saving to file, select *.cfg as the extension, select the correct location
for the file and click Save.

If multiple connector configurations are open, click Save All to File to save all
of the configurations to file, or click Save All to Project to save all connector
configurations to a System Manager project.
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Before it saves the file, Connector Configurator checks that values have been
set for all required standard properties. If a required standard property is
missing a value, Connector Configurator displays a message that the validation
failed. You must supply a value for the property in order to save the
configuration file.

Setting the configuration file properties

When you create and name a new connector configuration file, or when you open
an existing connector configuration file, Connector Configurator displays a
configuration screen with tabs for the categories of required configuration values.

Connector Configurator requires values for properties in these categories for
connectors running on all brokers:

 Standard Properties

* Connector-specific Properties
* Supported Business Objects
* Trace/Log File values

» Data Handler (applicable for connectors that use JMS messaging with
guaranteed event delivery)

Note: For connectors that use JMS messaging, an additional category may display,
for configuration of data handlers that convert the data to business objects.

For connectors running on ICS, values for these properties are also required:
* Associated Maps

* Resources

* Messaging (where applicable)

Important: Connector Configurator accepts property values in either English or
non-English character sets. However, the names of both standard and
connector-specific properties, and the names of supported business
objects, must use the English character set only.

Standard properties differ from connector-specific properties as follows:

* Standard properties of a connector are shared by both the application-specific
component of a connector and its broker component. All connectors have the
same set of standard properties. These properties are described in Appendix A of
each adapter guide. You can change some but not all of these values.

* Application-specific properties apply only to the application-specific component
of a connector, that is, the component that interacts directly with the application.
Each connector has application-specific properties that are unique to its
application. Some of these properties provide default values and some do not;
you can modify some of the default values. The installation and configuration
chapters of each adapter guide describe the application-specific properties and
the recommended values.

The fields for Standard Properties and Connector-Specific Properties are
color-coded to show which are configurable:

* A field with a grey background indicates a standard property. You can change
the value but cannot change the name or remove the property.
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A field with a white background indicates an application-specific property. These
properties vary according to the specific needs of the application or connector.
You can change the value and delete these properties.

* Value fields are configurable.

* The Update Method field is displayed for each property. It indicates whether a
component or agent restart is necessary to activate changed values. You cannot
configure this setting.

Setting standard connector properties
To change the value of a standard property:
1. Click in the field whose value you want to set.
2. Either enter a value, or select one from the drop-down menu if it appears.
3. After entering all the values for the standard properties, you can do one of the
following:

* To discard the changes, preserve the original values, and exit Connector
Configurator, click File>Exit (or close the window), and click No when
prompted to save changes.

* To enter values for other categories in Connector Configurator, select the tab
for the category. The values you enter for Standard Properties (or any other
category) are retained when you move to the next category. When you close
the window, you are prompted to either save or discard the values that you
entered in all the categories as a whole.

* To save the revised values, click File>Exit (or close the window) and click
Yes when prompted to save changes. Alternatively, click Save>To File from
either the File menu or the toolbar.

Setting application-specific configuration properties
For application-specific configuration properties, you can add or change property
names, configure values, delete a property, and encrypt a property. The default
property length is 255 characters.

1. Right-click in the top left portion of the grid. A pop-up menu bar will appear.
Click Add to add a property. To add a child property, right-click on the parent
row number and click Add child.

2. Enter a value for the property or child property.
3. To encrypt a property, select the Encrypt box.

4. Choose to save or discard changes, as described for [“Setting standard connector|

properties.”

The Update Method displayed for each property indicates whether a component or
agent restart is necessary to activate changed values.

Important: Changing a preset application-specific connector property name may
cause a connector to fail. Certain property names may be needed by
the connector to connect to an application or to run properly.

Encryption for connector properties

Application-specific properties can be encrypted by selecting the Encrypt check
box in the Connector-specific Properties window. To decrypt a value, click to clear
the Encrypt check box, enter the correct value in the Verification dialog box, and
click OK. If the entered value is correct, the value is decrypted and displays.

Appendix B. Connector Configurator 157



The adapter user guide for each connector contains a list and description of each
property and its default value.

If a property has multiple values, the Encrypt check box will appear for the first
value of the property. When you select Encrypt, all values of the property will be
encrypted. To decrypt multiple values of a property, click to clear the Encrypt
check box for the first value of the property, and then enter the new value in the
Verification dialog box. If the input value is a match, all multiple values will
decrypt.

Update method

Refer to the descriptions of update methods found in the Standard configuration

properties for connectors appendix, under [’Setting and updating property values” on
page 132.

Specifying supported business object definitions

Use the Supported Business Objects tab in Connector Configurator to specify the
business objects that the connector will use. You must specify both generic business
objects and application-specific business objects, and you must specify associations
for the maps between the business objects.

Note: Some connectors require that certain business objects be specified as
supported in order to perform event notification or additional configuration
(using meta-objects) with their applications. For more information, see the
Connector Development Guide for C++ or the Connector Development Guide for
Java.

If ICS is your broker

To specify that a business object definition is supported by the connector, or to
change the support settings for an existing business object definition, click the
Supported Business Objects tab and use the following fields.

Business object name: To designate that a business object definition is supported
by the connector, with System Manager running:

1. Click an empty field in the Business Object Name list. A drop-down list
displays, showing all the business object definitions that exist in the System
Manager project.

2. Click on a business object to add it.
3. Set the Agent Support (described below) for the business object.

4. In the File menu of the Connector Configurator window, click Save to Project.
The revised connector definition, including designated support for the added
business object definition, is saved to an ICL (Integration Component Library)
project in System Manager.

To delete a business object from the supported list:

1. To select a business object field, click the number to the left of the business
object.

2. From the Edit menu of the Connector Configurator window, click Delete Row.
The business object is removed from the list display.

3. From the File menu, click Save to Project.

Deleting a business object from the supported list changes the connector definition
and makes the deleted business object unavailable for use in this implementation
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of this connector. It does not affect the connector code, nor does it remove the
business object definition itself from System Manager.

Agent support: If a business object has Agent Support, the system will attempt to
use that business object for delivering data to an application via the connector
agent.

Typically, application-specific business objects for a connector are supported by
that connector’s agent, but generic business objects are not.

To indicate that the business object is supported by the connector agent, check the
Agent Support box. The Connector Configurator window does not validate your
Agent Support selections.

Maximum transaction level: The maximum transaction level for a connector is
the highest transaction level that the connector supports.

For most connectors, Best Effort is the only possible choice.

You must restart the server for changes in transaction level to take effect.

If a WebSphere Message Broker is your broker
If you are working in stand-alone mode (not connected to System Manager), you
must enter the business object name manually.

If you have System Manager running, you can select the empty box under the
Business Object Name column in the Supported Business Objects tab. A combo
box appears with a list of the business object available from the Integration
Component Library project to which the connector belongs. Select the business
object you want from the list.

The Message Set ID is an optional field for WebSphere Business Integration
Message Broker 5.0, and need not be unique if supplied. However, for WebSphere
MQ Integrator and Integrator Broker 2.1, you must supply a unique ID.

If WAS is your broker

When WebSphere Application Server is selected as your broker type, Connector
Configurator does not require message set IDs. The Supported Business Objects
tab shows a Business Object Name column only for supported business objects.

If you are working in stand-alone mode (not connected to System Manager), you
must enter the business object name manually.

If you have System Manager running, you can select the empty box under the
Business Object Name column in the Supported Business Objects tab. A combo box
appears with a list of the business objects available from the Integration
Component Library project to which the connector belongs. Select the business
object you want from this list.

Associated maps (ICS only)

Each connector supports a list of business object definitions and their associated
maps that are currently active in WebSphere InterChange Server. This list appears
when you select the Associated Maps tab.

The list of business objects contains the application-specific business object which
the agent supports and the corresponding generic object that the controller sends
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to the subscribing collaboration. The association of a map determines which map
will be used to transform the application-specific business object to the generic
business object or the generic business object to the application-specific business
object.

If you are using maps that are uniquely defined for specific source and destination
business objects, the maps will already be associated with their appropriate
business objects when you open the display, and you will not need (or be able) to
change them.

If more than one map is available for use by a supported business object, you will
need to explicitly bind the business object with the map that it should use.

The Associated Maps tab displays the following fields:

* Business Object Name
These are the business objects supported by this connector, as designated in the
Supported Business Objects tab. If you designate additional business objects
under the Supported Business Objects tab, they will be reflected in this list after
you save the changes by choosing Save to Project from the File menu of the
Connector Configurator window.

* Associated Maps
The display shows all the maps that have been installed to the system for use
with the supported business objects of the connector. The source business object
for each map is shown to the left of the map name, in the Business Object
Name display.

* Explicit
In some cases, you may need to explicitly bind an associated map.
Explicit binding is required only when more than one map exists for a particular
supported business object. When ICS boots, it tries to automatically bind a map
to each supported business object for each connector. If more than one map
takes as its input the same business object, the server attempts to locate and
bind one map that is the superset of the others.
If there is no map that is the superset of the others, the server will not be able to
bind the business object to a single map, and you will need to set the binding
explicitly.
To explicitly bind a map:
1. In the Explicit column, place a check in the check box for the map you want

to bind.

2. Select the map that you intend to associate with the business object.

3. In the File menu of the Connector Configurator window, click Save to
Project.

4. Deploy the project to ICS.
5. Reboot the server for the changes to take effect.

Resources (ICS)

The Resource tab allows you to set a value that determines whether and to what
extent the connector agent will handle multiple processes concurrently, using
connector agent parallelism.

Not all connectors support this feature. If you are running a connector agent that
was designed in Java to be multi-threaded, you are advised not to use this feature,

since it is usually more efficient to use multiple threads than multiple processes.
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Messaging (ICS)

The messaging properties are available only if you have set MQ as the value of the
DeliveryTransport standard property and ICS as the broker type. These properties
affect how your connector will use queues.

Setting trace/log file values

When you open a connector configuration file or a connector definition file,
Connector Configurator uses the logging and tracing values of that file as default
values. You can change those values in Connector Configurator.

To change the logging and tracing values:
1. Click the Trace/Log Files tab.

2. For either logging or tracing, you can choose to write messages to one or both
of the following:

* To console (STDOUT):
Writes logging or tracing messages to the STDOUT display.

Note: You can only use the STDOUT option from the Trace/Log Files tab for
connectors running on the Windows platform.

* To File:
Writes logging or tracing messages to a file that you specify. To specify the
file, click the directory button (ellipsis), navigate to the preferred location,
provide a file name, and click Save. Logging or tracing message are written
to the file and location that you specify.

Note: Both logging and tracing files are simple text files. You can use the file
extension that you prefer when you set their file names. For tracing
files, however, it is advisable to use the extension .trace rather than
.trc, to avoid confusion with other files that might reside on the
system. For logging files, .1og and .txt are typical file extensions.

Data handlers

The data handlers section is available for configuration only if you have designated
a value of JMS for DeliveryTransport and a value of JMS for
ContainerManagedEvents. Not all adapters make use of data handlers.

See the descriptions under ContainerManagedEvents in Appendix A, Standard
Properties, for values to use for these properties. For additional details, see the
Connector Development Guide for C++ or the Connector Development Guide for Java.

Saving your configuration file

When you have finished configuring your connector, save the connector
configuration file. Connector Configurator saves the file in the broker mode that
you selected during configuration. The title bar of Connector Configurator always
displays the broker mode (ICS, WMQI or WAS) that it is currently using.

The file is saved as an XML document. You can save the XML document in three

ways:

¢ From System Manager, as a file with a *.con extension in an Integration
Component Library, or

¢ In a directory that you specify.
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* In stand-alone mode, as a file with a *.cfg extension in a directory folder. By
default, the file is saved to \WebSphereAdapters\bin\Data\App.

* You can also save it to a WebSphere Application Server project if you have set
one up.

For details about using projects in System Manager, and for further information
about deployment, see the following implementation guides:

* For ICS: Implementation Guide for WebSphere InterChange Server

* For WebSphere Message Brokers: Implementing Adapters with WebSphere Message
Brokers

* For WAS: Implementing Adapters with WebSphere Application Server

Changing a configuration file

You can change the integration broker setting for an existing configuration file.
This enables you to use the file as a template for creating a new configuration file,
which can be used with a different broker.

Note: You will need to change other configuration properties as well as the broker
mode property if you switch integration brokers.

To change your broker selection within an existing configuration file (optional):
* Open the existing configuration file in Connector Configurator.
* Select the Standard Properties tab.
* In the BrokerType field of the Standard Properties tab, select the value that is
appropriate for your broker.
When you change the current value, the available tabs and field selections on

the properties screen will immediately change, to show only those tabs and
fields that pertain to the new broker you have selected.

Completing the configuration

After you have created a configuration file for a connector and modified it, make
sure that the connector can locate the configuration file when the connector starts

up.

To do so, open the startup file used for the connector, and verify that the location
and file name used for the connector configuration file match exactly the name you
have given the file and the directory or path where you have placed it.

Using Connector Configurator in a globalized environment

Connector Configurator is globalized and can handle character conversion between
the configuration file and the integration broker. Connector Configurator uses
native encoding. When it writes to the configuration file, it uses UTF-8 encoding.

Connector Configurator supports non-English characters in:

* All value fields

* Log file and trace file path (specified in the Trace/Log files tab)

The drop list for the CharacterEncoding and Locale standard configuration
properties displays only a subset of supported values. To add other values to the

drop list, you must manually modify the \Data\Std\stdConnProps.xml file in the
product directory.
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For example, to add the locale en_GB to the list of values for the Locale property,

open the stdConnProps.xml file and add the line in boldface type below:

<Property name="Locale"
isRequired="true"

updateMethod="component restart">
<ValidType>String</ValidType>

<ValidValues>

<DefaultValue>en US</DefaultValue>

</ValidValues>
</Property>

<Value>ja_JP</Value>
<Value>ko_KR</Value>
<Value>zh_CN</Value>
<Value>zh_TW</Value>
<Value>fr_FR</Value>
<Value>de DE</Value>
<Value>it_IT</Value>
<Value>es_ES</Value>
<Value>pt_BR</Value>
<Value>en_US</Value>
<Value>en_GB</Value>
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Appendix C. Quick Steps

This appendix lists quick steps for configuring the Adapter for SAP XI for request
processing and event processing.

Request processing

To configure the adapter for SAP XI for request processing, use the following
procedure:

1.

Generate a WSDL file from the SAP XI system by doing the following:

a. Log on to the SAPXI (2.0) system GUI.

Select Repository(Design).

Import the object (for example BAPI_SALESORDER_GETLIST ).

Double-click the imported object (for example, BAPI_SALESORDER_GETLIST).

Select Tools->Export WSDL and save the WSDL file in your local file
system.

Generate business objects using the BIA_XIWSDLUil tool and then the SAP XI
ODA. These are delivered with the WebSphere Business Integration Adapter for
SAP XI. For more information, see |Chapter 6, “Enabling collaborations for|
[request processing,” on page 107

®oouo

Using Connector Configurator, configure the adapter to support the generated
objects.

Configure SAP X]I, if it is not already configured.

a. Define a software component for the WebSphere Business Integration
Adapter for SAP XI in the System Landscape Directory (SLD).

b. Configure the HTTP(S) protocol handlers and listeners using Connector
Configurator.

€. Maintain the directory.

Test request objects from the end application or by using Test Connector if you
are sending test requests.

Event processing

To configure the adapter for SAP XI for event processing, use the following
procedure:

1.

3.

Generate a WSDL file from the SAP XI system by doing the following:

a. Log on to the SAPXI (2.0) system GUIL

Select Repository(Design).

Import the object (for example BAPI_SALESORDER_GETLIST ).

Double-click the imported object (for example, BAPI_SALESORDER_GETLIST).

Select Tools->Export WSDL and save the WSDL file in your local file
system.

Generate business objects using BIA_XIWSDLUHil tool and then the SAP XI
ODA. These are delivered with the WebSphere Business Integration Adapter for
SAP XI. For more information, see[Chapter 6, “Enabling collaborations for]
[request processing,” on page 107 |

® oo o

Configure the WebSphere Business Integration Adapter for SAP XI:
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a. Using Connector Configurator, add support for the generated objects.

b. Define business processes (collaborations) and mapping if necessary.

c. For testing, configure the test connector to imitate end applications.
4. Configure SAP XI:

a. Define a software component for the WebSphere Business Integration
Adapter for SAP XI in the System Landscape Directory (SLD).

b. Configure the HTTP(S) protocol handlers and listeners using Connector
Configurator

€. Maintain the directory.
5. Configure the SAP application to trigger IDoc or other types of messages.
6. Test end-to-end connectivity by triggering events in the SAP application.
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Appendix D. Configuring HTTPS/SSL

“Keystore setup”]

* [“TrustStore setup” on page 168|

* |“Generating a certificate signing request (CSR) for public key certificates” on|

page 168|

If you are planning to use SSL, you must use third-party software to manage your
keystores, certificates, and key generation. The SAP XI connector does not come
with tooling for these tasks. However, you may choose to use keytool, which ships
with IBM JRE, to create self-signed certificates and to manage your keystores.

A key and certificate management utility, keytool enables you to administer your
own public/private key pairs and associated certificates. These are intended for
use in self-authentication (where you authenticate yourself to other users or
services) or data integrity and authentication services that use digital signatures.
The keytool utility also allows you to store the public keys (in the form of
certificates) of peers with whom you communicate.

This appendix describes how to set up keystores using keytool. Note that this
appendix is intended for illustration purposes only; it is not intended as a
substitute for documentation for keytool or related products. Always refer to
source documentation for the tools you use to set up keystores. For further
information on keytool, see:

* http://java.sun.com/j2se/1.3/docs/tooldocs/tools.html#security

Keystore setup

To create KeyStore using keytool, you first must create a key pair in the KeyStore.
For example, if you enter the following command line:

keytool -genkey -alias wsadapter -keystore c:\security\keystore

keytool immediately prompts you for a password. You may enter the password of
your choice (within keytool parameters), but you should specify the password
entered in keytool as the value of the SSL ” KeyStorePassword connector property.
For further information, see ["KeyStorePassword” on page 68

The sample command creates the keystore named keystore in the
c:\security\keystore directory. Accordingly, you would enter
c:\security\keystore as the value of the SSL ” KeyStore connector hierarchical
property. Also from the command line example above, you would enter -alias
wsadapter as the value of the SSL ” KeyStoreAlias connector hierarchical property.
The keytool utility then prompts you for the details of the certificate. The following
illustrates what you may enter for each of the prompts. (Refer to keytool
documentation.)
What is your first and Tast name?

[Unknown]: HostName
What is the name of your organizational unit?

[Unknown] :  wbi
What is the name of your organization?

[Unknown]: IBM
What is the name of your City or Locality?

[Unknown]: Burlingame
What is the name of your State or Province?
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[Unknown]: CA
What is the two-letter country code for this unit?
[Unknown]: US
Is <CN=HostName, OU=wbi, 0=IBM, L=Burlingame,
ST=CA, C=US> correct?
[no]: yes

keytool then prompts you for a password:
Enter key password for <wsadapter> (RETURN if same as keystore password):

Press Return to use the same password. If you want to use a self-signed certificate,
you may want to export the certificate created above. In that case, enter following
on the command line:

keytool -export -alias wsadapter -keystore c:\security\keystore -file wsadapter.cer

keytool now prompts you for the keystore password. Enter the password that you
entered above.

TrustStore setup

You may want to set up TrustStore for the following: If you want the
SOAP/HTTPS protocol listener to authenticate the web service client, set the SSL ”
UseClientAuth connector configuration property to true . In this case, the
SOAP/HTTPS protocol listener expect s TrustStore to contain certificates for all
trusted web service clients. Note that the connector uses the JSSE default
mechanism to trust clients. If you are invoking SOAP/HTTPS SAP XI services, the
SOAP/HTTP-HTTPS protocol handler requires that TrustStore trust the SAP XI
service. This means that TrustStore must contain the certificates of all trusted SAP
XI services. Note that the connector uses the JSSE default mechanism to trust
clients. To import the trusted certificates into the TrustStore, enter a command such
as the following:

keytool -import -alias trustedl -keystore c:\security\truststore -file
c:\security\trustedl.cer

keytool now prompts for the keystore password. If you enter -keystore
c:\security\truststore, make sure that the SSL ” TrustStore hierarchical property
is set to c:\security\truststore. Also you must set the value of the SSL ”
TrustStorePassword hierarchical property to the password you entered previously.

Generating a certificate signing request (CSR) for public key
certificates

If the SSL data exchange is among already trusted partners who trust your identity,
self-signed certificates may be adequate. However, a certificate is more likely to be
trusted by others when it is signed by a certifying authority (CA).

To get a certificate signed by the CA using the keytool utility, you first must
generate a Certificate Signing Request (CSR), then give the CSR to a CA. The CA
then signs the certificate and returns it to you.

You generate a CSR by entering the following command:
keytool -certreq -alias wsadapter -file wsadapter.csr

-keystore c:\security\keystore

In the command, alias is the keystore alias that you created for the private key.
The keytool utility generates the CSR file, which you provide to your CA. Your CA
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then provides you with the signed certificate. You will have to import this
certificate into your keystore. To do so, you would enter the following command:

keytool -import -alias wsadapter -keystore c:\security\keystore -trustcacerts
-file casignedcertificate.cer

Once you import, the self-signed certificate in keystore is replaced by the
CA-signed certificate.
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Notices

IBM may not offer the products, services, or features discussed in this document in
all countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or program(s) described in this publication
at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Burlingame Laboratory Director
IBM Burlingame Laboratory
577 Airport Blvd., Suite 800
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Burlingame, CA 94010
US.A

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement, or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not necessarily tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

This information may contain examples of data and reports used in daily business

operations. To illustrate them as completely as possible, the examples may include

the names of individuals, companies, brands, and products. All of these names are

fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

All statements regarding IBM’s future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

COPYRIGHT LICENSE

This information may contain sample application programs in source language,
which illustrates programming techniques on various operating platforms. You
may copy, modify, and distribute these sample programs in any form without
payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the
operating platform for which the sample programs are written. These examples
have not been thoroughly tested under all conditions. IBM, therefore, cannot
guarantee or imply reliability, serviceability, or function of these programs.

Programming interface information

Programming interface information, if provided, is intended to help you create
application software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program’s tools.
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However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks and service marks

The following terms are trademarks or registered trademarks of International
Business Machines Corporation in the United States or other countries, or both:

IBM

the IBM logo
AIX
CrossWorlds
DB2

DB2 Universal Database
Domino
Lotus

Lotus Notes
MQIntegrator
MQSeries
Tivoli
WebSphere

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

MMX, Pentium, and ProShare are trademarks or registered trademarks of Intel
Corporation in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the
United States, other countries, or both.

Other company, product or service names may be trademarks or service marks of
others.

CoMmitis @

IBM WebSphere Business Integration Adapter Framework,V2.4.0
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